NetSuite Basics
should not be relied upon in making purchasing decisions. The development, release, and timing of any
features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the
exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms
and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle
PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has
been executed by you and Oracle and with which you agree to comply. This document and information
contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle
without prior written consent of Oracle. This document is not part of your license agreement nor can it be
incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website

Oracle customers that have purchased support have access to electronic support through My Oracle
Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code
Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through
help links. All such sample code is provided “as is” and “as available”, for use only with an authorized
NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud
Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service
As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service
in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle
reasonably concludes that a Customer’s use is excessive and/or will cause immediate or ongoing
performance issues for one or more of Oracle’s other customers, Oracle may slow down or throttle
Customer’s excess use until such time that Customer’s use stays within reasonable limits. If Customer’s
particular usage pattern requires a higher limit or threshold, then the Customer should procure a
subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns
with the Customer’s actual usage pattern.

Beta Features
This software and related documentation are provided under a license agreement containing restrictions
on use and disclosure and are protected by intellectual property laws. Except as expressly permitted
in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast,
modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any
means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for
interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-
free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it
on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software,
any programs embedded, installed or activated on delivered hardware, and modifications of such
programs) and Oracle computer documentation or other Oracle data delivered to or accessed by
U.S. Government end users are “commercial computer software” or “commercial computer software
documentation” pursuant to the applicable Federal Acquisition Regulation and agency-specific
supplemental regulations. As such, the use, reproduction, duplication, release, display, disclosure,
modification, preparation of derivative works, and/or adaptation of i) Oracle programs (including any
operating system, integrated software, any programs embedded, installed or activated on delivered hardware, and modifications of such programs), ii) Oracle computer documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the license contained in the applicable contract. The terms governing the U.S. Government's use of Oracle cloud services are defined by the applicable contract for such services. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Epyc, and the AMD logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement between you and Oracle.

This documentation is in pre-General Availability status and is intended for demonstration and preliminary use only. It may not be specific to the hardware on which you are using the software. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to this documentation and will not be responsible for any loss, costs, or damages incurred due to the use of this documentation.

The information contained in this document is for informational sharing purposes only and should be considered in your capacity as a customer advisory board member or pursuant to your pre-General Availability trial agreement only. It is not a commitment to deliver any material, code, or functionality, and should not be relied upon in making purchasing decisions. The development, release, and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has been executed by you and Oracle and with which you agree to comply. This document and information contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your license agreement nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

Send Us Your Feedback

We'd like to hear your feedback on this document.

Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click [here](#) to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
# Table of Contents

NetSuite Basics .................................................................................................................. 1
NetSuite Basics Overview ...................................................................................................... 2
   Supported Browsers for NetSuite ..................................................................................... 2
   Finding Your NetSuite Account ID .................................................................................. 3
Getting Help ............................................................................................................................ 5
   NetSuite Documentation Overview .................................................................................. 6
   ERP Documentation Summary .......................................................................................... 6
   CRM and SFA Documentation Summary .......................................................................... 7
   Commerce Documentation Summary ............................................................................... 8
   SuiteCloud Platform Documentation Summary ............................................................... 8
   SuiteAnalytics Documentation Summary ....................................................................... 9
   SuiteApps Documentation Summary .............................................................................. 10
   Account Administration Documentation Summary ......................................................... 11
   OneWorld Documentation Summary ............................................................................. 12
   Country-Specific Documentation Summary .................................................................. 12
Using the Help Center Window ............................................................................................. 12
Searching for Help .................................................................................................................. 16
Getting Field-Level Help ....................................................................................................... 17
Finding Out What’s New in NetSuite .................................................................................... 17
SuiteAnswers Overview ....................................................................................................... 18
NetSuite Support .................................................................................................................. 20
   Accessing the NetSuite Account Center ....................................................................... 22
   Checking the Status of Support Cases ......................................................................... 23
   NetSuite Issue Resolution ............................................................................................... 23
   Support Phone Menu Routing Options ......................................................................... 25
   NetSuite Support Login ................................................................................................. 25
   NetSuite Support Assistant ............................................................................................ 26
NetSuite Communities (User Groups) .................................................................................. 29
SuiteSuccess .......................................................................................................................... 29
Voting for Enhancements ......................................................................................................... 30
Checking NetSuite System Status ......................................................................................... 31
Finding Your NetSuite Release Version .............................................................................. 33
Navigating NetSuite .............................................................................................................. 35
   Using the Header and Menus ......................................................................................... 35
      Switching Between Roles .......................................................................................... 36
      Using the Navigation Menu ....................................................................................... 37
   Using Dashboards ........................................................................................................... 38
   Using Global Search ....................................................................................................... 40
   Using the Create New Menu ......................................................................................... 41
   Using QuickViews ......................................................................................................... 41
   Using Keyboard Shortcuts ............................................................................................. 43
   Using Popup and Dropdown Lists .................................................................................. 44
   Using Buttons in NetSuite ............................................................................................. 48
Logging in to NetSuite ......................................................................................................... 51
Logging in to the NetSuite UI .............................................................................................. 51
   Your User Credentials .................................................................................................. 52
   Finding Your Settings Portlet .......................................................................................... 52
   Change Email Link ......................................................................................................... 54
   Change Password Link .................................................................................................. 55
   Setting Up Security Questions ....................................................................................... 58
   Update Security Questions Link ..................................................................................... 60
   If You Forget the Answers to Your Security Questions .................................................. 61
   Getting Access When You Forget Your Password .......................................................... 62
Cancelling an Expense Report Attachments Tool Migration .................................................. 222
File Types Recognized in the File Cabinet ......................................................................... 223
Exporting Reports, Searches, and Lists ............................................................................... 225
Limitations on Exports to PDF ......................................................................................... 226
Limitations on CSV Exports of Data with Special Characters .............................................. 227
NetSuite Basics

- NetSuite Basics Overview
- Getting Help
- Navigating NetSuite
- Logging in to NetSuite
- Setting Personal Preferences
- Working with Records, Transactions, and Lists
- Working with Your Calendar and Activities
- Working with Email
- File Cabinet Overview
- Exporting Reports, Searches, and Lists
NetSuite Basics Overview

Welcome to NetSuite!

NetSuite Basics includes information about the tasks that are common to most NetSuite users, regardless of their roles. When you log in to NetSuite, you see a set of tabbed pages. NetSuite calls these tabbed pages a center. Your assigned role determines which center you see.

For more information about working with the NetSuite user interface, see Navigating NetSuite.

For information about logging in and changing your password, see the help topic Logging in to NetSuite.

Instructions for specialized tasks are contained in other parts of the NetSuite documentation. For more information, see NetSuite Documentation Overview.

This overview section of NetSuite Basics includes information about the browsers you can use to work in NetSuite. See Supported Browsers for NetSuite.

Instructions for finding your NetSuite account ID are also included here. See Finding Your NetSuite Account ID.

Other major sections of NetSuite Basics are as follows:

- Getting Help
- Navigating NetSuite
- Logging in to NetSuite
- Setting Personal Preferences
- Working with Records, Transactions, and Lists
- Working with Your Calendar and Activities
- Working with Email
- File Cabinet Overview
- Exporting Reports, Searches, and Lists

Supported Browsers for NetSuite

**Important:** This topic describes browser support for the NetSuite application only, not for NetSuite web stores. For information about web store browser support, see the help topic Supported Browsers for Commerce Web Stores.

**Note:** Some ad blocker plug-ins can prevent you from creating pivot tables or charts in SuiteAnalytics Workbook, regardless of the browser you use to access NetSuite. To avoid errors with SuiteAnalytics Workbook, deactivate these plug-ins. For more information about SuiteAnalytics Workbook, see the help topic SuiteAnalytics Workbook Overview.

Browsers by Platform

NetSuite is supported in the following browsers and operating systems:

<table>
<thead>
<tr>
<th>Browser</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer 11*</td>
<td>Windows 10</td>
</tr>
<tr>
<td></td>
<td>Windows 8.x</td>
</tr>
</tbody>
</table>
Supported Browsers for NetSuite

<table>
<thead>
<tr>
<th>Browser</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>*OpenAir is not supported</td>
<td>Windows 7 with Service Pack 1 (SP1) or higher</td>
</tr>
<tr>
<td>Google Chrome 71 (2)</td>
<td>Windows 10</td>
</tr>
<tr>
<td></td>
<td>Windows 8.x</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.10 or newer</td>
</tr>
<tr>
<td>Microsoft Edge (Anniversary Update and later)</td>
<td>Windows 10 (Anniversary Update)</td>
</tr>
<tr>
<td>Mozilla Firefox 60 (2)</td>
<td>Windows 10</td>
</tr>
<tr>
<td></td>
<td>Windows 8.x</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.6 or newer</td>
</tr>
<tr>
<td>Safari 12</td>
<td>Mac OS X 10.12 or newer</td>
</tr>
<tr>
<td>Safari 13</td>
<td>Mac OS X 10.13.6 or newer</td>
</tr>
</tbody>
</table>

New versions of browsers with rapid development cycles (Google Chrome and Mozilla Firefox) are certified one time each quarter. You should turn on automatic updates for these browsers to receive the latest security updates.

Advance Notice – Microsoft Internet Explorer 11 End of Support

As of 2020.2, the NetSuite application will no longer support Microsoft Internet Explorer 11 or its rendering engine embedded in other browsers (1). Users might not be able to log in to NetSuite using Internet Explorer 11, and support will not be offered for defects specific to this browser or its rendering engine.

If you are using Microsoft Internet Explorer 11, you should switch to another supported browser (see the table above). As of 2020.2, NetSuite will no longer test or address any issues related to Internet Explorer 11.

Users relying on enterprise features of the browser are encouraged to discuss options with their respective vendors.

(1) Please note that Internet Explorer 11’s rendering engine may be embedded in other browsers seamlessly.

Touch Screen Device Support

Most user interface actions are supported on touch screen devices. However, in rare cases you may encounter minor issues.

Finding Your NetSuite Account ID

You do not need to know your NetSuite account ID to use NetSuite. In special cases, however, you may want to know what your account ID is.
You can find your NetSuite account ID at the beginning of the NetSuite URL. For example, if the URL is https://1234567.app.netsuite.com/, your account ID is 1234567.
Getting Help

NetSuite provides a variety of resources to give you help when you need it. From self-service tools like the Help Center and SuiteAnswers to NetSuite's customer training and support, you can always find answers to your questions.

The following resources are available:

Documentation Resources

- **NetSuite Documentation Overview** - a list of NetSuite Help Center resources.
- - a library of Help Center videos that work alongside the Help Center content to make difficult tasks easier.
- - all of the Help Center content provided in PDF format.
- **Developer Documentation** - a summary of the resources NetSuite provides for SuiteCloud and Commerce developers.
- **SuiteAnswers Overview** – a description of the resources offered in SuiteAnswers.
- **Using the Help Center Window** - tips and tricks to help you use the NetSuite Help Center effectively.
- **Searching for Help** - a description of the search tools you can use to find the help you need.
- **Getting Field-Level Help** - an explanation of help provided for each field on NetSuite pages.

New Release Resources

- **What's New** - a list of the resources provided to help you understand what's new in NetSuite and the Help Center.
- **Release Notes** - details provided for what's included in the newest version of NetSuite.
- **Help Center Weekly Updates** - a list of updates to the NetSuite Help Center.

Support Resources

- **NetSuite Support** - a summary of the customer support resources NetSuite provides.
- **NetSuite Communities (User Groups)** - details on the online communities where you can connect with other NetSuite users.
- **Voting for Enhancements** - a description of SuiteIdeas, the voting tool where you can let us know which enhancements you would like to see in future versions of NetSuite.
- **Checking NetSuite System Status** - steps for checking the status of the NetSuite service and more information about potential outages or disruptions to service.

International Resources

- - a list of the documentation resources provided for NetSuite features used in countries around the world.

Additional Resources

- **SuiteSuccess** - learn how SuiteSuccess can make implementing NetSuite fast and effective.
- **SuiteApp.com** - browse and choose SuiteApps that you can install in your NetSuite account.
- **NetSuite Education Services** - a summary of the training and certification resources available.

Watch the following video for a quick introduction to using the Help Center and SuiteAnswers, including the differences between the two resources.
Tips for Help Center and SuiteAnswers

The link to the Tips for Help and SuiteAnswers video is also available on the SuiteAnswers home page, under Additional Resources, on the bottom right corner of the page.

NetSuite Documentation Overview

The NetSuite Help Center is organized into sections corresponding to different NetSuite functions.

Some tasks in NetSuite are common to most users, regardless of the functional area in which they work. These are covered in NetSuite Basics. For an outline, see NetSuite Basics Overview.

The following topics include descriptions of the activities that are included in specific NetSuite product areas and links to the corresponding documentation:

- ERP Documentation Summary
- CRM and SFA Documentation Summary
- Commerce Documentation Summary
- SuiteCloud Platform Documentation Summary

The following topics outline the documentation for activities that are not specific to a product area:

- SuiteAnalytics Documentation Summary
- SuiteApps Documentation Summary
- Account Administration Documentation Summary
- OneWorld Documentation Summary
- Country-Specific Documentation Summary

Many help topics also are available as User Guides in PDF format that you can view and print. These are available in the User Guides section of the Help Center. For more details about using the NetSuite Help Center, see Using the Help Center Window.

In addition to the Help Center, SuiteAnswers provides support knowledge base articles, training videos, and best practices information. For more information, see SuiteAnswers Overview.

ERP Documentation Summary

Enterprise Resource Planning (ERP) in NetSuite encompasses several areas of your business, including accounting, inventory, order management, project management, and employee management. The following help is available for ERP in NetSuite:

<table>
<thead>
<tr>
<th>Accounting</th>
<th>The accounting area includes the following chapters:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- accounting periods</td>
</tr>
<tr>
<td></td>
<td>- bookkeeping</td>
</tr>
<tr>
<td></td>
<td>- banking</td>
</tr>
<tr>
<td></td>
<td>- currencies</td>
</tr>
<tr>
<td></td>
<td>- journal entries</td>
</tr>
<tr>
<td></td>
<td>- managing the chart of accounts in NetSuite</td>
</tr>
<tr>
<td></td>
<td>- financial statements and accounting reports</td>
</tr>
<tr>
<td></td>
<td>- revenue recognition</td>
</tr>
</tbody>
</table>
NetSuite Documentation Overview

- taxes
- fixed assets management
- statistical accounting
- multi-book accounting

For information about accounting topics, see the help topic Accounting. Several accounting-related user guides are also available for download from the help topic.

<table>
<thead>
<tr>
<th>Items and Inventory</th>
<th>For information about setting up inventory management, item records, shipping methods, bar coding, manufacturing, and more, see the Inventory Management Guide, available from the help topic, and the help files located in the and sections.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Order Management</td>
<td>For more about customer order handling, including placing orders, fulfilling orders, and billing, see the help topic Order Management.</td>
</tr>
<tr>
<td>Purchasing and Receiving</td>
<td>For information about purchase order management, including vendor records, bills and payments, requisitions, approval routing, and expenses, see the help topic Vendors, Purchasing, and Receiving.</td>
</tr>
<tr>
<td>Project Management</td>
<td>To learn about using NetSuite to manage your project tasks and resources, see the help files in the section.</td>
</tr>
<tr>
<td>Employee and Payroll Management</td>
<td>For information about managing employees and using NetSuite for payroll, see the help files in the Employee Management section. You can learn about SuitePeople Overview, NetSuite's integrated Human Capital Management (HCM) solution. These topics also include information about time tracking, expense reporting, and purchase requests.</td>
</tr>
</tbody>
</table>

CRM and SFA Documentation Summary

Customer Relationship Management (CRM) and Sales Force Automation (SFA) with NetSuite includes sales, marketing, partners, and support management. The following help is available for CRM and SFA in NetSuite:

<table>
<thead>
<tr>
<th>Customer Service &amp; Support</th>
<th>For information about setting up case management including case types, origins, and more, see the help topic Setting Up Case Management.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For information about working with cases including creating, escalating, tracking time, and more, see the help topic Working With Cases.</td>
</tr>
<tr>
<td></td>
<td>For information about issue management including statuses, severities, reproducibility, and more, see the help topic Issue Management.</td>
</tr>
<tr>
<td></td>
<td>For information about the knowledge base including creating topics, solutions, and more, see the help topic Knowledge Base.</td>
</tr>
<tr>
<td></td>
<td>For information about monitoring support performance including case alerts on support cases, performance metrics, and more, see the help topic Monitoring Support Performance.</td>
</tr>
<tr>
<td></td>
<td>For access to all of the NetSuite user guides, see .</td>
</tr>
<tr>
<td>Sales and Marketing</td>
<td>For information about marketing automation including capturing leads, marketing campaigns, and more, see the help topic Marketing Automation Overview.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>For information about sales force automation including set up, sales forecasting, commission, and more, see the help topic Sales Force Automation Overview.</td>
</tr>
<tr>
<td></td>
<td>For information about managing partners including creating partner records and more, see the help topic Managing Partners. For information about partner commissions and royalties including schedules, plans, and more, see the help topic Partner Commissions &amp; Royalties. For access to a variety of partner reports, see the help topic Partner Reports.</td>
</tr>
<tr>
<td></td>
<td>For access to all of the NetSuite user guides, see .</td>
</tr>
</tbody>
</table>
Commerce Documentation Summary

NetSuite commerce enables you to create and manage web stores, and point of sale applications. The following help is available in the Commerce section:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Store Front</strong></td>
<td>Learn how to implement a web store that includes the full shopping, checkout, and my account experiences. SuiteCommerce lets you create, customize, and configure dynamic and engaging web stores without requiring in-depth development. SuiteCommerce Advanced provides full access to the front-end code, allowing you to fully customize your web store. See the help topic Store Front.</td>
</tr>
<tr>
<td><strong>Site Management Tools</strong></td>
<td>SuiteCommerce Site Management Tools let you manage content, add landing pages, and enhance existing pages on your SuiteCommerce web store. See the help topic Site Management Tools Overview.</td>
</tr>
<tr>
<td><strong>SuiteCommerce InStore</strong></td>
<td>SuiteCommerce InStore (SCIS) is a web-based point-of-sale application available for the U.S. market. It provides a touch-based user interface specifically designed for tablets. See the help topic SuiteCommerce InStore.</td>
</tr>
<tr>
<td><strong>Developer Documentation</strong></td>
<td>Using the developer documentation you can learn how to set up and use all the tools you need to customize and manage your web store. You can learn how to access NetSuite APIs and create extensions to enhance your web store experience. See the help topic Developer Documentation.</td>
</tr>
<tr>
<td><strong>Site Builder Sites</strong></td>
<td>Site Builder is the legacy commerce solution. You can build Standard NetSuite Web Sites, Sites Hosted in NetSuite, External Catalog Sites, or Site Builder Combination Sites. See the help topic Site Builder Overview.</td>
</tr>
<tr>
<td><strong>NetSuite Point of Sale</strong></td>
<td>NetSuite Point of Sale (POS) is the in-store register component of the SuiteCommerce product line. See NetSuite Point of Sale User Guide.</td>
</tr>
</tbody>
</table>

SuiteCloud Platform Documentation Summary

The SuiteCloud platform provides a comprehensive set of tools that you can use to customize and extend NetSuite to fit your business needs. Customizations developed on the platform automatically migrate with every NetSuite upgrade. The following documentation is available for the SuiteCloud platform:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>Learn how SuiteCloud Platform allows you to customize NetSuite to your own needs. Learn about the records reference tools available and review the SuiteCloud platform glossary for new terminology. See the help topic SuiteCloud Platform Introduction.</td>
</tr>
<tr>
<td><strong>Point-and-Click</strong></td>
<td>SuiteBuilder makes customizing NetSuite fields, forms, record types, transaction types, segments, and centers a point-and-click experience. With SuiteBuilder, you can define how information is accessed and entered by each user of your NetSuite account. See Copy to Account.</td>
</tr>
<tr>
<td><strong>Workflow Engine</strong></td>
<td>SuiteFlow provides developers and customers with point-and-click tools to customize and automate business processes, such as lead nurturing, transaction approval, record management, and more. See Copy to Account.</td>
</tr>
<tr>
<td><strong>Custom Coding</strong></td>
<td>Built on industry-standard JavaScript, SuiteScript enables full-featured application-level scripting capabilities throughout NetSuite, supporting sophisticated procedural logic and featuring robust debugging capabilities. Many NetSuite records support SuiteScript. See the help topic SuiteScript.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>SuiteCloud Development Framework (SDF)</strong></td>
<td>A development framework and deployment mechanism that provides developers and partners with IDE tools to customize NetSuite accounts and deploy solutions. See the help topic <a href="#">SuiteCloud Development Framework</a>. SuiteCloud Software Development Kit represents tools allowing customization of accounts through SuiteCloud Development Framework. Available tools are SuiteCloud IDE plug-in and SuiteCloud CLI. See the help topic <a href="#">SuiteCloud SDK</a>.</td>
</tr>
<tr>
<td><strong>Managing SuiteApps</strong></td>
<td>Define and manage your SuiteApp distribution process in a single location. Upload SuiteApp projects to SuiteApp control center and distribute them in the SuiteApp Marketplace, from which users can install and upgrade SuiteApps. See the help topics <a href="#">SuiteApp Control Center</a> and <a href="#">SuiteApp Marketplace</a>.</td>
</tr>
<tr>
<td><strong>Distribution</strong></td>
<td>SuiteBundler supports packaging of NetSuite customizations. Partners and customers can use SuiteBundler to bundle multiple customizations together, manage versions, and deploy solutions. See <a href="#">SuiteBundler</a>.</td>
</tr>
<tr>
<td><strong>Integrations</strong></td>
<td>SuiteTalk SOAP web services enable customers and partners to integrate NetSuite with existing on-premise investments and third party cloud applications. Integrations can use Java, .NET, or any other programming language that supports SOAP-based web services. See the help topic <a href="#">SuiteTalk SOAP Web Services Platform Guide</a>. SuiteTalk SOAP web services records guide contains records all available fields, sublists, and search filter fields for each record. The guide includes links to the SOAP Schema Browser. See the help topic <a href="#">SuiteTalk SOAP Web Services Records Guide</a>. SuiteTalk REST web services provide a REST-based interface for interacting with NetSuite. See the help topic <a href="#">SuiteTalk REST Web Services API Guide</a>. SuiteTalk REST web services records guide contains a list of records accessible through REST web services. The list includes both generally available and beta records. See the help topic <a href="#">SuiteTalk REST Web Services Records Guide</a>. The Import Assistant supports bulk transfers of data from other applications into NetSuite via CSV files. This wizard enables visual mapping of CSV file columns to NetSuite fields. See the help topic <a href="#">CSV Imports</a>.</td>
</tr>
<tr>
<td><strong>Plug-ins</strong></td>
<td>NetSuite develops core plug-ins and releases them to partners or customers. You can create a new core plug-in implementation and test it using the SuiteScript Debugger. See available core plug-ins in <a href="#">Core Plug-ins</a>. NetSuite also allows you to develop, implement and manage your own custom plug-ins. See the help topic <a href="#">Custom Plug-ins</a>.</td>
</tr>
<tr>
<td><strong>Supported Records and Samples</strong></td>
<td>See a comparison of record types supported for SuiteScript, Web Services integration, SuiteAnalytics Connect, and CSV import. See <a href="#">Records Catalog</a>. For information about the record types, fields, and relationships available for a specific NetSuite channel, see the the Records Catalog. The new Records Catalog includes the custom records, forms, and fields in the current user’s account and only includes data based on the features currently enabled in the account. See the help topic <a href="#">Records Catalog</a>. NetSuite offers a collection of sample customization projects created with SuiteCloud platform tools. Explore these samples to determine which SuiteCloud tools suits you best to customize NetSuite for your organization. See the help topic <a href="#">Sample SuiteCloud Platform Customization Projects</a>.</td>
</tr>
</tbody>
</table>

### SuiteAnalytics Documentation Summary

SuiteAnalytics tools include built-in ad hoc reporting, real-time dashboards, and ODBC access across NetSuite and all customizations. These business intelligence tools help you to identify issues, trends, and opportunities, and support instant drill-down to underlying records, for quick action. The following SuiteAnalytics documentation is available:
Dashboards

NetSuite dashboards provide a visual workspace that gives you instant access to the personalized data needed to make decisions and edit records. Dashboard content is displayed in dynamic data display windows called portlets. Some portlets provide direct access to raw data, and others display data that has been synthesized into critical business metrics, such as key performance indicators (KPIs), performance scorecards, trend graphs, and report snapshots. Other portlets enable the display of data from website RSS feeds. See .

Workbook

Create highly customizable datasets and workbooks that leverage the analytics data source. In the dataset, define your workbook source data by selecting record types, fields, and criteria for further analysis in a workbook. In the workbook, visualize and analyze your data using tables, pivot tables, and charts. Visualizations in a workbook can all be based on different datasets. You can author your datasets and workbooks using field data from multiple record types, including custom record types. You can also create and add fields with dynamically calculated values, and easily view data for fields with parent-child relationships. See the help topic Workbook.

Search

NetSuite provides a variety of search tools that you can use to retrieve real-time data from your account. You can search for a single record by keywords, return a set of records that match filters you define, customize the display of search results, export results to other applications, email results to other users, and save search definitions for reuse. See the help topic Search.

Reporting

NetSuite supports reporting capabilities that you can use to retrieve, present, and analyze real-time business results. You can run prebuilt reports as is, or modify them by setting per-user preferences, selecting per-report viewing options, or defining custom reports in the Report Builder or Financial Report Builder. See .

Connect

The SuiteAnalytics Connect Service enables your business to archive, analyze, and report on its data using a third-party tool or custom-built application. NetSuite supports the use of ODBC, JDBC, and ADO.NET drivers to connect with NetSuite from any device running on a Windows, Linux, or OS X operating system. You can use Microsoft® Excel, BIRST, Adaptive, or any other compatible application to work with the Connect Service. See .

SuiteApps Documentation Summary

SuiteApps are applications that extend NetSuite functionality beyond what is available natively in the product. SuiteApps are developed on the SuiteCloud platform, packaged using SuiteBundler, and delivered as a bundle or a collection of bundles. See the following for more information about SuiteApps:

<table>
<thead>
<tr>
<th>NetSuite SuiteApps</th>
<th>Some SuiteApps are built, distributed, and supported by NetSuite. These are usually features that can benefit from more frequent release cycles. For a list of currently supported NetSuite SuiteApps, see the help topic SuiteApps.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Third Party SuiteApps</td>
<td>For information about SuiteApps developed and supported by third parties, see SuiteApp.com. On SuiteApp.com, you can search partner SuiteApps by industry, business need, or keyword. In addition, you can read customer reviews, try out solutions, and find out where to buy these SuiteApps.</td>
</tr>
<tr>
<td>Installing SuiteApps</td>
<td>If you are the administrator of a NetSuite account or you have the SuiteApp Marketplace permission, you can install any public bundle, as well as any bundle that has been shared with your account. See the help topic SuiteApp Installation and Update.</td>
</tr>
<tr>
<td>Building SuiteApps</td>
<td>The SuiteBundler feature supports the creation and distribution of SuiteApps. The Bundle Builder is an assistant that steps you through the process of packaging customizations into bundles. See .</td>
</tr>
<tr>
<td>SuiteCloud Developer Network</td>
<td>If you are interested in creating SuiteApps for distribution and sale, NetSuite recommends that you join the SuiteCloud Developer Network (SDN), the NetSuite third-party developer program. For information about this program, see Developers Overview.</td>
</tr>
</tbody>
</table>
## Account Administration Documentation Summary

NetSuite account administrators need to perform many tasks to set up and maintain the NetSuite application and related customizations. The following documentation is available for these tasks:

<table>
<thead>
<tr>
<th>Account Administration Overview</th>
<th>Guidelines for NetSuite administrators, supported TLS protocols and IP addresses. See the help topic Account Administration Overview.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Setup</td>
<td>Setup of a NetSuite account requires enabling features, setting company preferences, defining classifications for NetSuite records, managing NetSuite roles and permissions, and incorporating approval routing. See the help topic Account Setup. For information about NetSuite OneWorld, see OneWorld Documentation Summary.</td>
</tr>
<tr>
<td>Email for Administrators</td>
<td>Setup of a DomainKeys identified mail, information about blocklists and spamlists, setup of scriptable templates and DMARC-compliant messaging in NetSuite. See the help topic Email for Administrators.</td>
</tr>
<tr>
<td>Authentication</td>
<td>NetSuite supports a variety of authentication methods, including two-factor authentication, token-based authentication, OAuth 2.0, Device ID authentication, Single Sign-on (outbound, SAML, and OpenID Connect), Digital Signing, SSH Keys, and RESTlet authentication. See the help topic Authentication.</td>
</tr>
<tr>
<td>CSV Imports</td>
<td>The Import Assistant supports bulk transfers of data from other applications into NetSuite via CSV files. The wizard enables visual mapping of CSV file columns to NetSuite fields. See the help topic CSV Imports.</td>
</tr>
<tr>
<td>Auditing and Data Management</td>
<td>NetSuite supports tracking changes, internal controls, managing transactions, removing personal information, auditing data changes, and avoiding duplicates. See the help topic Auditing and Data Management.</td>
</tr>
<tr>
<td>System Notes</td>
<td>NetSuite uses System Notes to track any changes made to a record. A system note for a change on a record captures the date when the change was made, who made the change, the role of the user who made the change, the type of change, and the old and new value in the record. See the help topic System Notes Overview.</td>
</tr>
<tr>
<td>Cloud Infrastructure</td>
<td>Best practices for accessing NetSuite through the UI, SuiteTalk web services, SuiteScript, RESTlets, Single Sign-on, SuiteAnalytics Connect, or other NetSuite services. See the help topic Cloud Infrastructure.</td>
</tr>
<tr>
<td>Account Customization</td>
<td>Options for customizing your NetSuite account, such as adding custom fields and forms, creating system integrations, and automating processes. See the help topic SuiteCloud Platform. For information about REST Services, see the help topic REST Services Overview.</td>
</tr>
<tr>
<td>NetSuite Account Types</td>
<td>NetSuite provides customers with various test accounts for developing and testing new applications and customizations. You can use release preview, sandbox, and development accounts without impacting the production account. See the help topic Understanding NetSuite Account Types.</td>
</tr>
<tr>
<td>Globalization</td>
<td>NetSuite supports multi-language features, managing translation collections, and localization context filtering for user event and client scripts. See the help topic Globalization.</td>
</tr>
</tbody>
</table>
OneWorld Documentation Summary

NetSuite OneWorld enables you to manage multiple areas of your multinational, multicompany business including financial statements, customers, e-commerce, services resource planning (SRP), business intelligence, and tax and compliance management. The solution crosses product areas, and the documentation for OneWorld is integrated with the various functional areas.

| Getting Started with OneWorld | This section of the help introduces OneWorld and its features across all NetSuite product areas. Begin here and follow the links to learn how OneWorld affects accounting and ERP, CRM, SRP, and analytics. See the help topic Introduction to NetSuite OneWorld. |

Country-Specific Documentation Summary

NetSuite has localized features for business needs that are specific to some countries. These country-specific features help your company adapt to business practices and comply with business regulations or requirements in the countries that you are operating in.

| Country-Specific Topics | As part of its global offerings, NetSuite provides solutions for a growing number of countries. For many of them, help can be found under the Overview of Country-Specific Features. This section includes an overview of features and SuiteApps for individual countries, recommendations for account setups, and country-specific information related to taxes and payment formats. For countries that currently have no separate country-specific help topic (yet they do have their own specific features supported by NetSuite), see the help topic General International Tax Topics or Setting Up Payment File Formats. |

| Country-Specific Tax Topics | In a global business, taxation is an area with both general international topics and country-specific requirements. For some countries, country-specific tax help topics have already been moved to Overview of Country-Specific Features. For countries that do not have their separate country-specific help topic yet, see the help topic General International Tax Topics. This section contains an introduction to general tax topics and links to those that are country-specific. |

| Country-Specific Payment File Formats | The Electronic Bank Payments SuiteApp provides payment file formats for payments, receivables, and Positive Pay transactions. For some countries, country-specific payment formats help topics have already been moved to Overview of Country-Specific Features. For countries that do not have their separate country-specific help topic yet, see the help topic Setting Up Payment File Formats. |

Using the Help Center Window

The help center includes many features to help you find the information you need to work with NetSuite. To access the help center, click Help on the header. This page opens in a new tab. You must be logged in to NetSuite to open the help center.
Search

To search for help topics for the pages and features of NetSuite, type a keyword or phrase in the Search field of the Help window, and press Enter. Here are some tips:

- Unless you know the exact words or phrases in a help topic, use general keywords or phrases to find a greater number of help topics.
- Search results are ordered by relevance and usage.
- Search results are obtained from the NetSuite Help Center.

You can also search for help topics using the Global Search field in NetSuite. Type help: before keywords, and press Enter to open the Help Center with your search results.

For more information, see Searching for Help.

Language Preference

If your account has the multi-language feature enabled, you can set your preference for the language displayed in the NetSuite Help Center using the dropdown list at the top right corner of the page. This language preference is independent of the language preference you specify for the NetSuite user interface. You can switch back and forth between languages in the Help Center, if desired. The next time you open the Help Center, it opens in the language of the preference last set.

The following languages are available:

- 简体中文 (Chinese Simplified)
- Deutsch (German)
- English
- 日本語 (Japanese)
- Español (Spanish)

Note: You can also set the language of the Help Center using the Set Preferences link. See Setting Personal Preferences, specifically, the entry for Language of the Help Center in the User Profile section.

Home

Click the home icon on the toolbar to return to the Help Center home page. A home icon also appears at the top of each help topic.
SuiteAnswers

Click SuiteAnswers to go to the SuiteAnswers site. This page opens in a new tab. SuiteAnswers is a searchable repository of support solutions, best practices, training videos, and help topics.

Developers

Click Developers to view a list of resources for SuiteCloud and Commerce developers.

Videos

Click Videos to view a list of help videos that demonstrate how to perform specific tasks in NetSuite. When you click a link, you are redirected to the Oracle Learning Library to view the video.

Training

Click Training to go to the SuiteTraining site. This page opens in a new tab. It includes complete information about the courses and certification programs that are offered.

SuiteApps

Click SuiteApps to open a list of current SuiteApps. This page includes a link to SuiteApp.com where you can get information about SuiteApps developed by SDN Partners and other third parties.

User Guides

Click User Guides to open a list of available PDF files. These User Guides provide conceptual details and setup information for specific areas of NetSuite. Click the PDF icon beside the desired User Guide to launch the PDF in a new window.
New Release

Click New Release to open a page with links to Sneak Peeks, Release Notes, and other important information for the newest release of NetSuite.

Table of Contents

Click the arrows at the top of the divider to hide or show the Table of Contents.

Click the Show in Table of Contents icon in the page header to find the current topic in the Table of Contents. Seeing a topic within the organization of the Table of Contents can help you find related topics or begin to understand where you are in a process or a feature.

Print Icon

Click Print icon in the page header to print the current help topic. Or, you can right-click and use the browser's Print function.

Browser Back Button

Use your browser's Back button to revisit topics you have recently viewed in the Help Center. You can also right-click with your mouse and select Back in the menu to view previous topics.

By default in Chrome the browser controls, including the Back button, are hidden when the help window opens. To display the controls in Chrome, right-click the browser title bar and select Show as tab from the context menu.

Submit Feedback for Help and Search

When you view or search for help topics, you can submit feedback about the helpfulness of the topic content or search results.

- At the bottom of search results, select Yes or No to answer whether the search results helped answer your question. Then click Submit Feedback.
- At the bottom of help topics, rank the helpfulness of the topic from Five Stars for the most helpful to One Star for not helpful. Type suggestions and comments in the text box. Then click Submit Feedback.
Help Topic Navigation

Help topics often provide navigation steps to help you locate pages in your NetSuite account. In most cases this navigation provides the tab, heading, and link that are specific to the role you are logged in with.

Consequently, you may see different navigation for the same help topic if you use more than one role.

For example, Krista Barton is a sales rep who is assigned the standard Sales Rep role. When Krista reads a help topic about creating a customer record, she is directed to Customers > Relationships > Customers. If Krista was logged in with the Marketing Assistant role, the help topic would direct her to Leads > Relationships > Customers.

Sometimes, help topics may refer to pages in NetSuite that you do not have access to or to features that have not been enabled in your account. In these cases, the navigation steps are shown as if you were logged in as an account administrator.

For example, Krista is logged in with her Sales Rep role and wants to read about how marketing campaigns work in NetSuite. When reading a help topic on the creation of marketing campaigns, the navigation directs her to Lists > Marketing > Campaigns. This is the navigation she would see if she was logged in as an account administrator.

If you want access to a page in NetSuite you do not currently have permission to view, speak to your account administrator about assigning you a new role, customizing your existing role, or enabling features in your company's NetSuite account.

Searching for Help

When you have questions about NetSuite, you can search the NetSuite Help Center for help.

The header of the NetSuite Help Center Home page has a search area in the center. Your cursor starts in the search area when you open the Help Center.

Type a search term and press the Enter key to get a list of topics that most closely match your search.

If you do not find the topics you expect, or if your search returns too many results, try one of the following:

- If you know the exact phrase, type it inside quotation marks.
- Avoid phrasing your search as a question.
- Look for links to related topics. Most topics include links to other help articles. Often these related topics are found at the bottom of the article.
- Look through the table of contents to find the topic you want.

The search engine for the NetSuite Help Center follows these general rules:

- All words you type in the search area must match 66%.
An exact match within quotation marks appears first in the list of results, but other close matches are also listed.

The search engine looks for the stem of the words you type rather than their inflected forms. You do not have to try both the singular and plural of nouns, for example, or different verb forms.

Additionally, the search engine for the NetSuite Help Center supports search by synonyms and typo correction.

Getting Field-Level Help

For specific information about a field on a NetSuite page, click the label next to the field. A popup window opens and displays text that describes how to use that field.

Finding Out What's New in NetSuite

You can find out what's new in NetSuite in several ways.

- **Release Notes** – Release notes document all changes made in the latest version of NetSuite. This includes new features, preferences, enhancements, and issues that have been resolved.
  
  Release notes help you quickly learn how to use new features and enhancements.
  
  A link to the release notes is included in the New Release topic that opens from the New Release link on the NetSuite Help Center toolbar. Release Notes are under New Release in the table of contents.

- **Sneak Peeks** – Sneak Peeks are provided prior to a new version when there are significant new features. They give you a preview of what to expect of the new features and enhancements.
  
  To use Sneak Peeks, click **New Release** on NetSuite Help Center toolbar. The New Release topic includes a link to the Sneak Peeks.

- **Release Preview Test Plan** – The Release Preview Test Plan provides instructions for using Release Preview and a listing of the features that can be tested.
  
  To access the Release Preview Test Plan, click **New Release** on the NetSuite Help Center toolbar. The New Release topic includes a link to the Release Preview Test Plan. You can also find the Release Preview Test Plan under New Releases in the table of contents.

- **Help Topic Weekly Updates** – Use the Help Topic Weekly Updates topic to find out which help topics and PDF files have been added or updated in each build of the NetSuite Help Center.
To open Help Topic Weekly Updates, go to the NetSuite Help Center home page and click the link. Help Topic Weekly Updates is the last entry in the table of contents. Each build has a topic page and a link on the Help Topic Weekly Updates page. Select a build date to see the changes made in that help build.

The help topic weekly updates topics do not include links to updated or new topics. To find the new or changed information for a help topic or PDF, copy the italicized title of the help topic or PDF from the weekly update list, paste the name into the Search field in the NetSuite Help Center, and press Enter. The updated or new topic or PDF appears near the top of the Search results.

**SuiteAnswers Overview**

SuiteAnswers is the NetSuite self-service support site where you can view announcements, support articles, videos, help topics, and best practice documents for NetSuite. From SuiteAnswers, you can also submit a question or issue via email or contact NetSuite Customer Service by phone.
In the NetSuite Help Center, click **SuiteAnswers** on the toolbar.

In the NetSuite user interface, choose the Support > Go to SuiteAnswers menu option, or: on the Support tab, click the Go to SuiteAnswers button in the SuiteAnswers portlet.

You must be logged in to NetSuite to access SuiteAnswers.

**Note:** You cannot access the SuiteAnswers portlet if you are logged in with an Employee Center, Customer Center, Vendor Center, or Partner Center role. If you are using any of these roles, you must switch to another role to be able to access SuiteAnswers.

**Note:** If you do not see the SuiteAnswers portlet on your Support tab, click Personalize Dashboard in the upper right. In the Add Content portlet, click SuiteAnswers to add the SuiteAnswers portlet to your Support tab.

The following table lists the differences between SuiteAnswers and the NetSuite Help Center:

<table>
<thead>
<tr>
<th>Resource</th>
<th>SuiteAnswers</th>
<th>Help Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>yes *</td>
<td>yes</td>
</tr>
<tr>
<td>Videos</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>NetSuite Knowledge Base</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Help Table of Contents</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>User Guides</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>OpenAir Knowledge Base</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>QuickArrow Knowledge Base</td>
<td>yes</td>
<td>no</td>
</tr>
</tbody>
</table>

* Help topics in SuiteAnswers are updated soon after they are updated in the Help Center.

In the Training Videos, you can browse videos and webinars. To access the Training Videos, click the link at the top of the page.
From SuiteAnswers, you can submit a question or issue via email or contact NetSuite Customer Service by phone.

Critical Announcements

Critical announcements dealing with performance issues or planned maintenances are displayed at the top of the page in SuiteAnswers. Critical announcements are displayed on every page until user closes them by clicking X on the top right of the announcement. The announcement reappears only after the user logs out and logs back in to SuiteAnswers.

Each type of a critical announcement is shown in a different color:

- Maintenance announcements are shown in purple.
- Performance issues are displayed in red.
- General announcements are displayed in orange.

Tips for Help Center and SuiteAnswers

NetSuite Support

Oracle provides a variety of resources you can use to find answers to your questions about NetSuite.

From the Support tab, you can access the following:

- **SuiteAnswers** – In the SuiteAnswers portlet, click Go to SuiteAnswers to open the SuiteAnswers page. You can search on the SuiteAnswers page to find support articles, training videos, help topics, and best practice documents on any subject need help with.
  
  For more information, see SuiteAnswers Overview.
  
  From SuiteAnswers, you can also submit a question or issue via email or contact Customer Service by phone.

- **Support Online** – To submit a question or issue to support professionals, click the Support tab, and click Go to SuiteAnswers. On the right side of the page, click the Contact Support Online button. You can send questions or comments by email 24 hours a day.
You will receive a response by email as soon as possible. Response times vary depending on the level of support you have purchased and the support team's current case load. To improve response times, please provide lots of information (more is better), and if applicable, include steps to reproduce the problem.

Tip: To improve your experience with NetSuite Customer Support, remember to select your preferred time zone in the Timezone field. The Timezone field is located below the Phone field on the Case Submission form. For Authorized Contacts the value of the field defaults to the time zone set in the Authorized Contact record. You can select a different time zone from the list, if you wish to. For Non-Authorized Contacts the Timezone field is blank and you can select a time zone from the list.

- **Support By Phone** – Phone support is available 24/7 to customers with Gold or Platinum level support. Call the number provided by your account manager.
  
  For quicker assistance, please have your account ID ready when you call. To view your account ID, use one of the following methods:
  - Find your NetSuite account ID at the beginning of the NetSuite URL. For example, if the URL is https://1234567.app.netsuite.com/, your account ID is 1234567.
  - If you are an account administrator, in the NetSuite UI, go to Setup > Company > Company Information. The account ID field is located near the bottom of the right column.
  - In the NetSuite UI, Click the Support tab, and click Go to SuiteAnswers. Then click **Contact Support by Phone**.
  - In the NetSuite UI, right-click the page and select View Source. Scroll to the bottom of the page. The second-last line shows your account ID and your login ID.

  To find your account name, look at the top right of the NetSuite UI. The account name and the role name are shown below the name of the logged-in user.

- **NetSuite Account Center** – If your account administrator has provided you a role with access, click the link in the NetSuite Account Center portlet. From the NetSuite Account Center, you can view support cases and issues, and contact Support. You can submit support cases and receive responses in English, Chinese (Simplified), French, German, Japanese, Latin American Spanish, and Portuguese(Brazil). Few employees in a company have access to the NetSuite Account Center. For information, see Accessing the NetSuite Account Center.

- **NetSuite User Group** – You can register for the Oracle NetSuite community at Oracle NetSuite Community Registration FAQ. After you register, you can go directly to the site at https://community.oracle.com/community/netsuite. You also can access the user community by clicking the link in the NetSuite User Group portlet on the Support tab of the NetSuite application.

- **Follow NetSuite** – To follow NetSuite on Facebook, Twitter, YouTube, or the official NetSuite blog, click the links in the Follow NetSuite portlet on the Support tab.

You can find the following options on the Setup tab:

- **NetSuite Support Login** – available at Setup > Company > NetSuite Support Login. On this page, select when you want to enable Support to log in to your account: always, never, or for the duration of your case. For more information, see NetSuite Support Login.

  Note: This setting only allows NetSuite Support to access a backup copy of your account in the QA environment to investigate cases you enter. This setting does not give NetSuite Support permission to access your production, sandbox, or release preview account.

- **Billing Questions** – To submit a question about your bill, go to Setup > Company > Billing Questions. You can submit billing questions 24 hours a day.
Your billing questions are answered by email and are prioritized by the level of support you have purchased.

- **Order Forms** - To order envelopes, check forms and other items, go to Setup > Accounting > Order Forms.

In addition to these resources, Oracle also provides NetSuite Help Center and other documentation. The help documentation is available by clicking Help in the upper right corner of any page in NetSuite.

For more information, see [Using the Help Center Window](#).

Other topics included in this section of NetSuite Basics are as follows:

- Accessing the NetSuite Account Center
- Checking the Status of Support Cases
- NetSuite Issue Resolution
- Support Phone Menu Routing Options
- NetSuite Support Login

### Accessing the NetSuite Account Center

The NetSuite Account Center portlet is located on the Support tab. What you see in the portlet depends on whether you have been assigned either the NetSuite Support Center role or the NetSuite Support Center (Basic) role. Not many employees of any company are assigned to either of these roles, so you should not expect to have access.

**To access the NetSuite Account Center:**

1. Click the **Support** tab to view the NetSuite Account Center portlet.
   
   For most users, the portlet displays a message indicating you do not have permission. If you feel that you should have permission to this portlet and the NetSuite Account Center, contact your account administrator.

2. If the portlet displays a link, click the link to access the NetSuite Account Center.

**Note:** Employees given access might need to log out and log back in again to refresh the portlet to see the NetSuite Account Center link.

Employees with permission access the NetSuite Account Center from the same portlet whether they are assigned the NetSuite Support Center or the NetSuite Support Center (Basic) role. The difference is in the
functions they are able to perform after they enter the center. The NetSuite Account Center displays the following portlets and tabs:

- **On the Customer Center - Home Links portlet** – users with the NetSuite Support Center role may make payments, review statements, transactions, and estimates, review support cases and issues, edit the user profile, and contact Support. Users with the NetSuite Support Center (Basic) role can view support cases and issues and contact Support.

  **Note:** If you do not have permission to view cases (even a case that you may have submitted) contact your NetSuite account administrator. The administrator should be able to check on the status of the case for you.

- **On the Multi Language Support tab** – NetSuite provides online case support in English, Chinese (Simplified), French, German, Japanese, Latin American Spanish, and Portuguese (Brazil). To submit a case in one of these languages, click **Cases** and select the preferred language from the dropdown or click the country logo.

- **On the SuiteIdeas tab** – Click the link to launch the SuiteIdeas site and review and vote for NetSuite product enhancements. For information, see **Voting for Enhancements**.

Exiting the NetSuite Account Center is slightly different than the usual procedure for switching to another role.

**To exit the NetSuite Account Center:**

1. From the Change roles icon, select **View All Roles**.
2. On the Choose Roles page, click the desired role.

  **Note:** In some instances, you will also see the **Return to Previous Role** option in the Change Roles dropdown list. Selecting **View All Roles** is recommended.

**Checking the Status of Support Cases**

If you have a role with permission to do so, you can log in to the NetSuite Account Center to see the status of support cases you have submitted. When you check the status of your support cases, you can learn details about the actions being taken to solve your issue.

You can check the status of support cases by going to the Support tab and clicking the link in the NetSuite Account Center portlet. If you do not see the NetSuite Account Center link in the portlet, contact your account administrator to see if you can be given access. See **Accessing the NetSuite Account Center**.

You can click **Open Cases** in the Quick View portlet for easy access to your open cases, or you can click **See Support Cases** in the Home Links portlet to view a list of cases entered for your company. The Cases list shows a list of the support cases submitted for your company. In the footer of the list, in the Stage field, you can filter the list based on the current status of your cases: Closed, Open, Escalated, or Not Closed. A Quick Sort dropdown list enables you to sort by Incident Date or Last Message Date, or to select a subset of cases: Recently Created, Recently Modified, Recently Closed, Recently Reopened, or Recently Viewed.

For example, if you want to see a list of all the cases currently entered for your company, select -All-. The list refreshes automatically to show you all the cases entered for your company.

**NetSuite Issue Resolution**

**Defects Versus Enhancements**

Any issue that is logged by the Support team is categorized as either a defect or an enhancement.
An issue is categorized as a **defect** when the problem occurs with an existing NetSuite feature that does not work as designed.

An issue is categorized as an **enhancement** when the issue is a request for additional functionality for an existing feature or for a new feature.

## Defect Resolution Process

Oracle NetSuite's process for handling customer-reported defects has the following goals:

- Resolution of customer-reported defects within a targeted timeframe that is appropriate to each defect's urgency.
- Consistent and clear communication to customers throughout the defect resolution process.

As part of this process, an urgency level to each defect, based on the following key inputs:

- **Business Impact** – business categorization that reflects the defect's impact on operations. Defined levels are B1-B4, with B1 representing the biggest impact.
- **Severity** - technical categorization that reflects the defect's effect on functionality or performance. Defined levels are S1-S4, with S1 representing the greatest severity.
- **Other factors** - such as the number of impacted customers, whether the problem is a recently introduced defect, or a sudden change to operational behavior has occurred.

The urgency level of a defect determines the target timeframe for resolution:

<table>
<thead>
<tr>
<th>URGENCY LEVEL</th>
<th>EXPECTED RESOLUTION TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1</td>
<td>today</td>
</tr>
<tr>
<td>U2</td>
<td>1–2 days</td>
</tr>
</tbody>
</table>
| U3            | 50% resolved within 4 days  
                | 80% resolved within 10 days |
| U4            | 50% resolved within 2 E-fix releases  
                | 80% resolved within 3 E-fix releases |
| U5            | 50% resolved within 3 E-fix releases  
                | 80% resolved within 4 E-fix releases |
| U6            | candidate for a future feature release |
| U7            | currently not planned     |

During the resolution process, the Support team communicates the following milestones to impacted customers:

- Assignment of the defect to an engineer
- Assignment of a target date for the release of a fix
- Completion of code review, testing, and authorization to release the fix
- Release of the fix to NetSuite's production environment

The Support team can also provide further assistance as needed. If you want to request additional information or discuss an issue's urgency level, please update your support case for assistance.
Viewing Defects and Enhancements

If you have a role with permission to access the NetSuite Account Center, you can view defects and enhancements associated with your support cases. See Accessing the NetSuite Account Center.

On the NetSuite Account Center page, click See Support Issues in the Customer Center - Home Links portlet to view a list of issues entered for your company. Dropdown lists in the footer enable you to filter displayed issues by their status or release target, or both. A Quick Sort dropdown list enables you to select a subset of issues to display: Recently Created, Recently Modified, or Recently Viewed.

Support Phone Menu Routing Options

When you call Support by telephone or enter an online support case, it is important that you select the correct category for the question or problem you have to ensure that it is routed to the correct support person.

Please review the latest NetSuite Support Phone Menu Routing Options for a detailed map of support case menu routing options. This file also is available by going to the Support tab and clicking the SuiteAnswers portlet. On the right side of the page, click Contact Support by Phone.

NetSuite Support Login

The authorized NetSuite staff may occasionally need to access a copy of your account in an internal QA environment in order to investigate and fix any cases and issues you have reported. To give you better flexibility and control over how and when you allow the authorized NetSuite staff to have such access, we provide both a company and a case level preference.

The NetSuite Support Login preference is a company-wide preference that takes precedence over the case level preference. It provides three different modes of permission to access a copy of your account data.

Important: The NetSuite authorized staff never accesses live accounts. This preference is only ever used to give access to a copy of your account in an internal QA environment. We never access any of your live environments such as Production, Sandbox, and Release Preview.

To set the NetSuite Support Login preference

1. An administrator can go to Setup > Company > NetSuite Support Login.
2. Select from one of the following three options:
   - Always - with this permission, the authorized NetSuite staff will be able to access a copy of your account in an internal QA environment for the sole purpose of troubleshooting reported cases and issues. Such access is granted for any open case during first 90 days. You may be asked for additional approval by re-checking Allow NetSuite Login for this Case after this period to reset the timer.
   - Case Duration - with this permission, the authorized NetSuite staff will be able to access a copy of your account in an internal QA environment for the sole purpose of troubleshooting reported cases and issues. Such access is granted on a case-by-case basis. The Allow NetSuite Login for this Case field must be marked on the case form when it is created or updated to set 90 days access timer. You may be asked for additional approval by re-checking Allow NetSuite Login for this Case after this period to reset the timer.
   - Never - with this permission, the NetSuite staff has no access to copies of your account in internal QA environments.
Allow NetSuite Login for a Case

The Allow NetSuite Login for this Case field works in conjunction with the value set at the NetSuite Support Login preference. This field must be enabled to allow the NetSuite staff to access a copy of your account for investigating your cases and issues.

To enable the Allow NetSuite Login for this Case field, you must be logged in to the NetSuite Account Center, which is only available to employees with either the NetSuite Support Center role or the NetSuite Support Center (Basic) role. The NetSuite Account Center can be accessed through the NetSuite Account Center portlet (located on the Support tab). For more information about accessing the NetSuite Account Center, see Accessing the NetSuite Account Center.

The field can be enabled when creating new cases or when editing existing ones.

The NetSuite Support Login preference takes precedence over the Allow NetSuite Login for this Case field on the NetSuite case form.

If the NetSuite Support Login preference prevents access, even if the Allow NetSuite Login for this Case field is enabled, when creating or updating the case, authorized NetSuite staff cannot access a copy of your data.

Which option should I choose?

Choosing the most appropriate level of access depends on your company's business requirements to limit how, when, and if authorized NetSuite staff access a copy of your account data in an internal QA environment.

Who are NetSuite Authorized staff?

Authorized NetSuite staff are specific members of the Support, QA, and Development teams, who have been granted permission to access a copy of your account data for the sole purpose of troubleshooting and rectifying the case which you have reported or an internal case that was investigated by NetSuite staff.

NetSuite Support Assistant

This topic describes the installation, setup and usage of the NetSuite Support Assistant.

- Installing the NetSuite Support Assistant.
Setting Up the NetSuite Support Assistant.
Using the NetSuite Support Assistant.

Installing and Setting Up the NetSuite Support Assistant

Installing the NetSuite Support Assistant

The following steps to install the bundle can be completed by a NetSuite Administrator.

To install the NetSuite Support Assistant:

1. Log in to the account where you want to install the bundle.
2. Go to Customization > SuiteBundler> Search & Install Bundles.
4. Open the NetSuite Support Assistant bundle and review the Components tab.
5. Click the Install Bundle button to begin the installation process.

For more information on installing SuiteApps, see the help topic SuiteApp Installation and Update.

Setting Up the NetSuite Support Assistant

To add the NetSuite Support Assistant portlet to your dashboard:

1. Click the Personalize Dashboard link in the Settings portlet or the Personalize link in the top right corner of the page. The Personalize Dashboard palette opens at the top of the page.
2. Click the Custom Portlet icon on the Personalize Dashboard palette.
3. Click the Set Up link in the portlet or the portlet menu, select NetSuite Support Assistant portlet from the Source list, and click Save.
Using the NetSuite Support Assistant

The NetSuite support Assistant is able to provide answers from SuiteAnswers based on your queries, and high-level answers related to the specific NetSuite product area.

Use the chat box to type in your queries or questions. To submit, press Enter.

The portlet needs to be refreshed if an administrator has updated the Support Assistant bundle. To refresh the portlet, press the Refresh Portlet button.

Sample Queries

You can ask the Support Assistant about performing tasks in your account. The Support Assistant will then navigate you directly to the relevant page in NetSuite.

- “Show me my customers.”
- “I want to create a saved search.”
- “I want to add a new employee.”

When you ask a question about NetSuite, the Support Assistant will send you links to relevant topics in SuiteAnswers.

- “What is SuiteCommerce?”
How can I create a SuiteBundle?

Frequently Asked Questions

I am getting an “I don’t understand. What do you want to do?” message.
Sometimes the Support Assistant can have trouble understanding your question. Try asking in a slightly different way.

When I click on an article link, I get the alert that “Help is unavailable because your connection has timed out”. How do I resolve this?
This happens due to browser cookies from previous sessions. To solve this, clear your browser cookies by finding this option in the settings or by refreshing the page by pressing CTRL+F5.

NetSuite Communities (User Groups)

Join a NetSuite community to communicate with other customers and Certified Consultants to ask questions and trade tips. As a member of a community, you can start your own discussions or respond to discussions initiated by other members. The communities are monitored by NetSuite Certified Consultants and Support Specialists to ensure that you are receiving the best advice possible.

Membership is available to general access users with current NetSuite accounts. Users with Center roles, such as Customer Center, Partner Center, and Vendor Center, are not eligible for membership. NetSuite communities are not available to users of Test Drive accounts.

To register for the NetSuite Community:

1. See the Oracle NetSuite Community Registration FAQ.
2. Follow the instructions on this page to join the Oracle NetSuite community.

After you register, you can go directly to the Oracle NetSuite community site at https://community.oracle.com/community/netsuite. This site includes a banner at the top that links to tips for getting started with Oracle communities, as well as an introductory video. You also can access the user community by clicking the NetSuite User Group link on the Support tab of the NetSuite application.

Regional user groups provide other NetSuite community resources that are hosted and owned by third parties. You can find these by searching for ‘NetSuite user groups’ in your browser.

SuiteSuccess

Your NetSuite account may be configured using the SuiteSuccess methodology. This methodology uses a value-driven dashboard design model to improve the efficiency and effectiveness of NetSuite users. SuiteSuccess accounts are delivered with pre-defined components based on leading practices, specific to your company’s industry and your users’ roles.

Your SuiteSuccess account includes the following components tailored for your particular industry:

- Business processes delivered through NetSuite SuiteApps
- Center tabs
- Chart of accounts
- Dashboards
- Enabled features necessary for your business
- Forms
SuiteSuccess edition features include:

- KPI scorecards
- Modules
- Pre-defined preferences
- Reports
- Roles
- Saved searches

SuiteSuccess editions are currently available for the following industries:

- Apparel, Footwear, and Accessories
- Financials
- Food and Beverage
- Health and Beauty
- Non-Profit
- Retail and Hospitality
- Software
- Wholesale Distribution

For more information, see [http://www.netsuite.com/portal/services/suitesuccess.shtml](http://www.netsuite.com/portal/services/suitesuccess.shtml) or contact your NetSuite account manager.

**Voting for Enhancements**

When you want a feature or functionality added to NetSuite, visit SuiteIdeas to submit a new enhancement request or vote for an existing idea.

From the Support tab, use the SuiteIdeas portlet to visit SuiteIdeas and search through all existing NetSuite enhancement requests. You can vote for the ideas of your choice, or enter your own new ideas for making NetSuite better.

**To search and vote for enhancements:**

1. Go to the **Support** tab, and click **Go to SuiteIdeas** in the SuiteIdeas portlet.

   **Note:** If you do not see the **Go to SuiteIdeas** button in the SuiteIdeas portlet, ask your account administrator if you can be given access. See [Accessing the NetSuite Account Center](#).

   The SuiteIdeas site opens in a new tab or window, depending on your browser preferences.

2. Click one of the following links within the SuiteIdeas site:
   - **Search** to see if your idea has been requested by others.
   - **Browse** for ideas by categories.
   - View new ideas, the most recently updated ideas, and ideas that have received the most votes.
   - View the ideas you have voted for.
   
   Clicking an idea opens it in a new window.

3. If you find the idea you are looking for, click **Vote for this Idea**.

4. Rate the idea, and click **Submit Vote**.

If you do not find the idea you are searching for, you can enter your own.
To enter a new idea:

2. Enter a description of your idea, and click Search Idea.
3. Review the list of search results to see if your idea has already been entered.
4. If your idea is not in the list or results, click File a New SuiteIdea at the bottom of the page.
5. Enter a title for your idea.
6. Select the product area and feature your idea is related to.
7. Enter a detailed description of your idea.
8. Click Submit Idea.

Each SuiteIdea is reviewed, and after it is approved, it is listed and can be viewed and voted on by other NetSuite users.

**Important:** When you are finished with SuiteIdeas, return to your original NetSuite tab or window. The Support tab changes to the NetSuite Account Center when you go to SuiteIdeas. To exit the NetSuite Account Center and return to your previous NetSuite center, click Return to Previous Role in the upper right corner.

### Checking NetSuite System Status

If you are unable to access the NetSuite user interface (at https://system.netsuite.com), you can check on system status at another site, http://status.netsuite.com. This site is available even if the NetSuite UI is experiencing a service interruption or downtime.

The status page includes the following sections:

- Current Status
- Recent Posts
- Past 7 Days

#### Current Status

![NetSuite Status](image-url)
Legend:

The following table describes the numbered items shown in the Current Status screenshot.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The status page for NetSuite is displayed by default. Click on NetSuite or OpenAir to switch between status pages.</td>
</tr>
<tr>
<td>2</td>
<td>Indicates the user's time zone, important when evaluating items with time and date stamps.</td>
</tr>
<tr>
<td>3</td>
<td>Use the drop-down to switch between English and Japanese. (Only the labels on the page are translated into Japanese.)</td>
</tr>
<tr>
<td>4</td>
<td>Displays the number of application requests processed in the date range shown.</td>
</tr>
<tr>
<td>5</td>
<td>Displays the status for all data centers by default. Click on the data center name to display the status of a specific data center.</td>
</tr>
</tbody>
</table>

**Note:** Selection of a particular data center affects the display in the Recent Posts and Past 7 Days sections. That is, click on a specific data center name to filter the results by data center.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Displays the current status for various areas of the NetSuite application.</td>
</tr>
<tr>
<td></td>
<td>Application UI: the NetSuite user interface</td>
</tr>
<tr>
<td></td>
<td>Shopping: the web stores</td>
</tr>
<tr>
<td></td>
<td>Checkout: web store checkout processing</td>
</tr>
<tr>
<td></td>
<td>Email: email infrastructure</td>
</tr>
<tr>
<td></td>
<td>Asynchronous Services: the backend processes</td>
</tr>
<tr>
<td></td>
<td>SuiteTalk: web services</td>
</tr>
<tr>
<td></td>
<td>SuiteAnalytics Connect: ODBC, JDBC, and ADO.NET</td>
</tr>
</tbody>
</table>

Status Icons

The following table describes status icons and what they indicate. The same icons are used no matter which section of the status page you are viewing.

<table>
<thead>
<tr>
<th>Status Icon</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>![checkmark]</td>
<td>Available</td>
<td>No issues affecting any NetSuite accounts.</td>
</tr>
<tr>
<td>![checkmark]</td>
<td>Partial Availability</td>
<td>Issue affecting only some NetSuite accounts.</td>
</tr>
<tr>
<td>![triangle]</td>
<td>Disruption</td>
<td>System-wide issue for all NetSuite accounts.</td>
</tr>
<tr>
<td>![circle]</td>
<td>Information</td>
<td>Notifications for all NetSuite accounts, for example, scheduled maintenance.</td>
</tr>
</tbody>
</table>

Recent Posts

When status icons are displayed for Partial Availability or Disruption, the reason is described in the Recent posts section of the page. These posts describe downtime incidents or service notifications. Downtime incidents are service interruptions or, in some cases, application defects severe enough to limit NetSuite functionality. Service notifications provide additional details about ongoing events or security concerns that Oracle has deemed important enough to notify users. In both cases, posts are updated with the time the incident was resolved.
Tip: Selecting a specific data center at the top of the screen affects the Recent Posts section. That is, click on a specific data center name (for example, NA East, NA Northwest, or NA West) to filter the results by data center.

### Recent Posts

<table>
<thead>
<tr>
<th>Date</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/25/2018</td>
<td>✔</td>
<td>A service interruption affecting a small number of customers in multiple data centers has been resolved. We take this episode very seriously and are continually working to ensure that events like this are mitigated quickly. 09:40 PM - 06:40 PM (Resolved)</td>
</tr>
<tr>
<td></td>
<td>✔</td>
<td>An incident in our database infrastructure has resulted in an interruption of service for some customer accounts. 05:00 PM - 05:07 PM (Resolved)</td>
</tr>
<tr>
<td></td>
<td>✔</td>
<td>An incident in our database infrastructure has resulted in an interruption of service for some customer accounts. 05:00 PM - 05:07 PM (Resolved)</td>
</tr>
</tbody>
</table>

### Past 7 Days

You can see the history of services for seven days in this section. Click on a Partial Availability or Disruption icon to see the reason the status was reported.

Tip: Selecting a specific data center at the top of the screen affects the Past 7 Days section. That is, click on a specific data center name (for example, NA East, NA Northwest, or NA West) to filter the results by data center.

### Past 7 Days Table

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application UI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SuiteCommerce - Websites</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SuiteCommerce - Checkout</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Email</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Asynchronous Services</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SuiteTalk</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SuiteAnalytics Connect</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Note: At the bottom of the status page, below the copyright notice, is a link to the service level commitment page for NetSuite.

### Finding Your NetSuite Release Version

To find the version of NetSuite your company uses:

1. Log in to NetSuite.
2. On the Home page, scroll down to the bottom of the page.
3. Find the NetSuite version number in the page footer. The version number should look like this:
Navigating NetSuite

This section introduces you to the elements of the NetSuite user interface (UI). It includes topics for common UI elements and tools.

The UI uses progressive disclosure. This means that the pages focus on your content. When you move your pointer over areas of a page, the links, menus, and icons that are appropriate for that area appear. If you do not see a link or button you expect, move your pointer around the area and see what appears.

Best practice is to always use the NetSuite Back button for navigation, rather than your browser Back button. If you use the browser Back button, you may create duplicate entries.

Instructions for common UI elements and tools are included in the following help topics:
- Using the Header and Menus
- Using Dashboards
- Using Global Search
- Using the Create New Menu
- Using Popup and Dropdown Lists
- Using QuickViews
- Using Keyboard Shortcuts
- Using Buttons in NetSuite

If you are using NetSuite on a mobile device, see Navigating NetSuite for Mobile.

Using the Header and Menus

The header area of NetSuite pages is locked. The remainder of each page scrolls, but the header remains accessible at the top. The elements of the header are identified in the following screenshot.

1. **Oracle NetSuite logo** – When you double-click the Oracle NetSuite logo, a popup window opens with details that your administrator can use to help identify the source if you have issues with performance in NetSuite. For more information, see the help topic Helping Users with Performance Issues.

2. **Global search field** – Enter a keyword to search for any type of record. For more information, see Using Global Search.

3. **Create New menu** – Use this dropdown menu to create new records of various types. For more information, see Using the Create New Menu.

4. **Help** – Click Help to open the NetSuite Help Center. The help center usually opens to a topic related to the page you are working with. For more information, see Getting Help.

5. **Feedback** – Click Feedback to rate your experience with NetSuite. Choose your satisfaction level, enter any comments (optional), and click Submit.

6. **User name and role** – Move your pointer over this area to open a dropdown list and change your role or log out of NetSuite. For more information, see Switching Between Roles.
Switching Between Roles

The pages and records you can access in NetSuite depends on your role. You may have multiple roles in NetSuite.

Your name and current role are displayed on the right side of the header with an icon and the Change Role list.

To switch to a different role:

1. Hover over the displayed role to bring up the Change Role list.
2. Select the role you want to use.

**Note:** Sandbox roles are indicated by an SB icon, and Release Preview roles are indicated by an RP icon.

If you are on the NetSuite domain, you can access all account types from the Change Role list or the Choose Role page, including:

- Production
- Sandbox
- Release Preview
- Development

If you would like to see more details about available roles before switching, you can open the Choose Role page. To open this page, click **View All Roles** in the Change Role list. You can also simply click your current role in the upper right corner.
The Choose Role page is also where you can set your default role. If you set a default role, this role is used every time you log in to the NetSuite UI. If you do not set a default role, your last used role will be automatically selected when you log in to the NetSuite UI.

**To set a default role:**

1. Hover over your current role to open the list.
2. Select **View All Roles** to open the Choose Role page.
3. In the **Default Role** column, check the box next to the role you want to make your default role.

Your default role preference is automatically saved.

**Note:** Only one role can be selected as the default role.

### Using the Navigation Menu

At the bottom of the header is a navigation bar. The bar is made up of tabs labeled to represent the information that it links to. The tabs that are available depend on your user role. Here is an example of the navigation menu bar.

Notice the ellipsis at the right end of the menu bar. It appears when the page is too narrow to display the full menu. The ellipsis means that more menus are available. When you hover over the ellipsis, the additional menus drop down so that you can access them without scrolling.

All of the tabs expand automatically to become navigation menus when you move your pointer over them. Navigation menus often have multiple levels. Hover over a menu to display submenus, and click a menu option to select it. For example, hovering over the Transactions tab displays the Transactions menu. In the following screenshot, the pointer has followed the Transactions menu to the Bank submenu and then to Make Deposits and is hovering over Search.
When you select a menu option, the tab remains highlighted to show you the context of the page you are on.

Three of the tabs on the navigation bar use icons instead of words. These are:

- **Recent Records** – NetSuite remembers the records you have viewed recently. Click this icon to open a dropdown menu of recent records. For more information, see Using the Recent Records Menu.

- **Shortcuts** – When you click this icon, you open the shortcuts menu. It contains links to your most frequently used records, transactions, lists, or reports. These shortcuts also appear in the Shortcuts Portlet. Often an administrator has set these up for you. For more information, see the help topic Shortcuts Portlet.

- **Home** – Click this icon to go to your home dashboard page. When you hover over it, its menu includes a link to the Set Preferences page. For more information, see Using Dashboards.

**Note:** Your personal settings and preferences are accessible from the Settings portlet on your Home page dashboard rather than from a menu. For more information, see Settings Portlet.

### Using Dashboards

When you log in, NetSuite opens your home page. Your home page is a dashboard, a collection of real-time data. The specific content of your home page depends on your user role. Here is an example of a portion of a Home page for a fictitious company.
Dashboard content is displayed in a variety of portlets, dynamic data display windows. Some portlets provide direct access to raw data, and others display data that has been synthesized into critical business metrics, such as key performance indicators (KPIs), performance scorecards, trend graphs, and report snapshots. For more information, see the help topic Dashboard Portlets.

**Settings Portlet**

Links to your personal settings, preferences, and login information are included in the Settings portlet on your NetSuite dashboard. By default the Settings portlet is in the lower left of the dashboard as shown in this screenshot of a Home page with all portlets minimized except the Settings portlet.

Your Settings portlet may contain more links than are shown here. Some links are dependent on your role and the features that are enabled in your account. You cannot delete this portlet, but you can move it to a different location on the dashboard.

For more information about the standard links in the Settings portlet, see the following topics:

- Dashboard Personalization
- Setting Personal Preferences
- Change Email Link
- Change Password Link
- Update Security Questions Link
Portlet Controls

Portlet controls are hidden until you move your pointer over the portlet. For example, look at the following screenshot of a Reminders portlet with a pointer in it. The menu icon appears on the right of the title bar. The title of the record that the pointer is over is underlined to show that you can click to view the record. An Edit link or icon also appears to the right of the record name so that you can reopen the record in edit mode.

Portlets with content from current data include a icon on the right of the title bar. Click the icon to refresh the portlet content and ensure includes the latest data.

You can rearrange the portlets on your dashboard to fit your needs. For instructions, see the help topic Arranging Dashboard Portlets.

To minimize a portlet, click its title bar. When you move your pointer over the title bar, it changes to crossed arrows. To maximize the portlet, click again.

Additionally, you can expand some portlets to full-screen view by clicking the double arrow icon . For some of the portlets, the full-screen view displays more columns and rows in the search.

Using Global Search

The NetSuite global search tool enables you to find any type of record from a single keyword query. Global search is often the quickest way to locate data in NetSuite.

The global search box is prominently located near the center of the header. The header is anchored at the top of the page so that it is always accessible. The keyboard shortcut Alt+G moves the cursor into the search field.

Keywords in global search can include letters, numbers, dashes, underscores, and the % wildcard. The colon (:) and the caret (^) indicate a prefix that limits the search to a specific record type. All other characters are considered white space. For details about prefixes, including some examples, see the help topic Global Search Prefixes. For more information about the % wildcard, see the help topic Tips for Effective Global Searches.

Keywords should be between three and 32 characters long. Global search begins the searching as soon as you type three characters. Characters in excess of 32 are ignored.

By default, global search provides a list of suggested matches as you type. You can select a suggested match or press Enter to open a list page with all matching results.

To open a suggested record:

- Click on the record name for view mode.
Using Global Search

- Click **Edit** that appears on the right for edit mode.
- Click **Dash** that appears on the right of a customer record to open the customer dashboard.

When you type keywords and press Enter, the keywords are compared to record name and ID field values. The values of the Vendor Name/ID and UPC Code fields in item records are also compared. The default behavior is as follows:

- When multiple records match, a page opens with a list of results.
- When only a single record matches, the record opens in view mode.

Global search is a powerful tool, and this topic includes only basic information. To learn all the details, see the help topic **Global Search**.

NetSuite offers a variety of tools in addition to global search to help you find the information you need. This includes the ability to save your search for reuse. For information about all of the search tools NetSuite offers, see the help topic **Search Overview**.

Using the Create New Menu

The Create New menu appears in the NetSuite header. The visibility of the menu depends on your role and permissions. For more information, contact your administrator.

This menu includes links to create new instances of different types of records. Each link in the menu represents a type of record related to the record or transaction you are currently viewing. Click a link to create a record of that type.

The options available on a record are limited by the role you are logged in with, but you can change which options are listed in the menu.

**To add or remove links in the Create New menu:**

1. Open the Create New menu, and click **Personalize** to open the Set Up Create New Menu page.
2. Check the **Include** box next to the links you want to show on the Create New menu, and clear the **Include** box for the links you do not want to include.
   - If the link you want is not listed, you can create a shortcut instead. For instructions, see the help topic **Shortcuts Portlet**.
3. Click **Save**.

**To reorder links in the Create New menu:**

Drag a link up or down the list to change the order in which the links are listed. You also can select a link and use the Move to Top or Move to Bottom buttons. Click Save when you are done.

Using QuickViews

You can gain quick access to the most relevant details of a record through record QuickViews. Depending on the record type, the QuickView can also allow you to make changes to a record without actually having to navigate to it.
Note: If you do not have permission to view a record or record type, you cannot view it in QuickView.

Viewing Record Details

Wherever a record is listed in a list, sublist, or on the main body of another record, you can hover your pointer over the link to get a QuickView of the record's key data. In the following figure, for example, hovering the pointer over an customer name in a sales order record opens a QuickView of the customer.

Taking Action on Records

The QuickView for some record types contains buttons that allow you to make changes to the record. In the following figure, for example, a QuickView of an event record in the Events list includes the Accept, Decline, and View buttons. To view the event record, click View.

Customizing QuickViews

The fields that appear for a record QuickView are predetermined. You can add, remove, or rearrange the fields in a QuickView by customizing the entry form. See the help topic Configuring QuickViews for the steps to configure QuickViews for custom forms and custom records.
Using QuickViews

Note: Some item types in NetSuite contain images. To change the image that appears in an item's QuickView, edit the image on the item record rather than on the form customization page where you configure QuickViews.

Using Keyboard Shortcuts

The following are useful keyboard shortcuts you can use in NetSuite.

Note: Some keyboard hot keys and shortcuts function only when using Internet Explorer.

Searching All Data in Your Account

You can press Alt+G to move the cursor directly to the Global Search field.

Entering Data and Completing Forms

Use these shortcuts to complete and edit data on forms and records:

- Press and hold Alt and type a letter to move to a subtab. See Navigating Subtabs.
- In transaction headers, press Enter to save the transaction.
- On a transaction line, press Enter to save the line and go to the next line.
- Press Tab to move the cursor between fields and buttons.
- Use the Spacebar to check or clear a check box.
- In Amount fields, enter numbers to calculate by addition or subtraction.
  For example, enter 10 + 15 to calculate a total amount.
- Press and hold Ctrl and click with your mouse to select multiple choices in a list.

Date Fields

In date fields, use the following keyboard shortcuts to change dates:

- Press Shift+T to enter tomorrow's date.
- Press p to enter the end of the current period (if you use accounting periods).
- Press l (lower case L) to enter the end of the previous period (if you use accounting periods).
- Press t to enter today's date.
- Press y to enter yesterday's date.
- Press m to enter the last day of the month.
- Press the Plus Sign (+) to increase one day.
- Press the Minus Sign (-) to decrease one day.

Note: These keyboard shortcuts are supported only in full date fields that include the month, day, and year.

Multi-Choice buttons

On transactions and records that have buttons with popup lists, you can select the non-default button option. Use the Tab key to navigate to the list button. Then, use the down arrow key to expand the
Using Keyboard Shortcuts

drop-down list. Click Enter to select the desired action. To collapse the list, use the up arrow key to return to the top.

Navigating Subtabs

When using tabbed pages, you can quickly switch between subtabs by using keyboard shortcuts. Each subtab has a single letter underlined in the title. Press and hold Alt and then press the corresponding letter to switch to that subtab. The cursor appears in the first field on the subtab.

Viewing Reports

When viewing reports, you can do the following:

- Press **Page Up** to go to the previous page of a report.
- Press **Page Down** to go to the next page of a report.
- Press **Home** to go to the first page of a report.
- Press **End** to go to the last page of a report.

Filtering Search Results

When working with search results filters, you can use the following keyboard shortcuts:

- Use the **Tab** key to navigate between filters.
- Use the **Down Arrow** key or the **Up Arrow** key to select an option from a filter dropdown list.
- When typing a value into a filter field, use the **Tab** key to apply the value.
  
  Please note that pressing Enter does not apply the filter value.

Using Popup and Dropdown Lists

When you select from a long list of records to populate a NetSuite field, you can use various built-in functions to save time. These functions include autocompletion and popup lists. Many fields also include links to search, edit, and create related records.

Autocompleting Dropdown Lists

Instead of selecting from a dropdown list, you can type the first letters of a value and the field is completed automatically.

Accessing Related Records from Dropdown Lists

Some dropdown lists include buttons to access related records, so you can quickly add, review, or change a record before you select it for a field. These buttons appear when you hover over the dropdown list.

- Click the new **+** button to create a new record in a popup window.
Click the open button to view or edit an existing record. The record opens in view mode in a new tab. Click Edit on the record to change to edit mode.

Using Popup Lists

You can use the Maximum Entries in Dropdowns preference to force popup lists instead of dropdown lists for fields with large numbers of possible values. To set this preference, go to Home > Set Preferences. The Maximum Entries in Dropdowns field is on the General subtab. Enter the maximum number of records you want to appear in a dropdown list. If the possible values in a list exceeds this number, the list automatically becomes a popup list. If the possible values do not exceed this number, a dropdown list appears.

Tip: Enter 0 in the Maximum Entries in Dropdowns field to always use popup lists. To always use dropdown lists, enter a large number that exceeds the number of entries in any of your lists.

Each popup list includes double arrows in place of the single arrow for a dropdown list. Start typing and press the Tab key to open a popup window that contains only records that begin with the letters you typed. For example, in the following screenshot, a user typed “ac” and pressed the Tab key to display a list of customers.

Alternatively, you can click the double arrows to display a popup and choose to open a list or search. The new and open buttons also appear when you click the arrows as shown in the following screenshot.

To clear a value that you have previously entered in the list, select the value and press the Delete key.

Using Popup List Search Links

Most fields with a popup list also have a search link. Click the Search icon, and a search window pops up. Enter criteria for the search, click Submit, and a list of items matching your search criteria appears. Select the item you want, and it is inserted into the field.

For example, to create a sales order for a customer in Alaska, click Search next to the Customer:Project field. When the Customer Search window pops up, type AK in the state field, and click Submit. The popup changes to show only your customers in Alaska. Click the name of the customer you want, and NetSuite inserts it into the Customer:Project field.
On transaction forms, NetSuite searches the full name of the item or the name of the final subitem and autofills the item field with any matching names. For example, typing `bas` would find Summer:Picnic:Basket and Basket:Welcome.

**Note:** After you inactivate a record, it will not show on transactions for selection in popup or dropdown lists. However, if the Search option shows in the popup or dropdown for a field, the search will return inactive records if the Inactive filter is set to Either or Yes. Inactive records in these search results can be added to transactions. To filter inactive records out of search results, be sure to set the Inactive filter to No in the search criteria.

### Popup Multi-Select Lists

On fields that allow you to select multiple values, you can access popup multi-select lists. To quickly enter a single value in this type of field, type the first few letters and press Tab. To enter multiple values, click the double arrow button to display a popup with a complete list of records that you can select and search.

To search for records, enter the first letters of the record name and click **Search**. To add fields to your selection, click the record name in the left column. The item moves to the Current Selections column on the right.

When you have selected all required records, click **Done**.
Note: To change or remove values in a multi-select list, do not edit the list directly. Click the double arrow button to open the popup and make the required changes.

To remove a value from a multi-select list, click the double arrow button beside the field.

Click the X button beside the selection that you want to remove, and then click Done.
Using Popup and Dropdown Lists

Using Popup Auto Suggest

NetSuite provides an auto suggest function for popup lists. As you type 3 letters or more, a list of suggested matching records displays. You can select from this list to quickly populate the field.

If you do not want this list of suggested matches to display, you can disable the auto suggest feature by clearing the Popup Auto Suggest box on the Analytics tab of Home > Set Preferences.

Using Buttons in NetSuite

Each button in NetSuite serves a specific purpose and has the ability to fulfill individual business needs. By using the appropriate button, you can successfully complete the task at hand. The following table describes the function of standard buttons that can be found on most NetSuite pages and shows where the button is located. The table does not include buttons that are specific to a particular feature or record type.

<table>
<thead>
<tr>
<th>Button Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sublist Row Buttons</td>
<td><img src="image" alt="Sublist Row Buttons" /></td>
</tr>
</tbody>
</table>

Sublist row buttons such as Add, Insert, and Delete appear on the left side of the sublist. The buttons that are available and the button names change depending on where you are in NetSuite.
<table>
<thead>
<tr>
<th>Button Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Back Button</strong></td>
<td><img src="image1.png" alt="Back Button Example" /></td>
</tr>
<tr>
<td>The Back button appears when a record is in View mode. Clicking the Back button takes you back to the page where you first initiated a particular action.</td>
<td></td>
</tr>
</tbody>
</table>

| **Cancel Button**                  | ![Cancel Button Example](image2.png) |
| The Cancel button appears below the record title when a record is in either new or edit mode. Clicking the Cancel button aborts whatever action you were performing. |

| **Create New Button**              | ![Create New Button Example](image3.png) |
| The Create New button is an icon with a dropdown menu. You can create new records or perform new tasks. The options on the Create New button vary on a per-record basis, as the options are specific to each record type. To create records unrelated to the current record, use the Create New menu in the NetSuite header. For more information see, Using the Create New Menu. |

| **Edit Button**                    | ![Edit Button Example](image4.png) |
| The Edit button opens the current record or transaction in a format that you can make changes to. When you are finished, submit changes by clicking Save. |

| **Mark All/Unmark All Buttons**    | ![Mark All/Unmark All Buttons Example](image5.png) |
| Mark All places checks in the check boxes next to all items listed on the page where the button appears. Unmark All clears the checks. |

| **New Button**                     | ![New Button Example](image6.png) |
| On records in edit mode, the New button is a plus sign icon that appears to the right of a field when the pointer moves over it. The button opens a window in which you can create a new record. Most lists also have a New button. For example, the New button at the top of the Employees list is called New Employee. |
### Button Description

<table>
<thead>
<tr>
<th>Button Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>On records in edit mode, the open button is a square icon with a diagonal arrow that appears to the right of a field when the pointer moves over it. The button opens the selected record in a new tab for viewing.</td>
<td></td>
</tr>
<tr>
<td><strong>Print Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>If multiple printing options are available, the print icon includes all options in the dropdown menu. If the record allows only a single print action (to print the page, for example), the print icon does not include the dropdown arrow.</td>
<td></td>
</tr>
<tr>
<td><strong>Reset Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>As of 2021.1, NetSuite will no longer support the use of the Reset button on standard form pages. To revert to the original version of the form or record, use the refresh function in your browser.</td>
<td></td>
</tr>
<tr>
<td><strong>Save Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>The Save button sends the transaction or record you are working on to NetSuite for posting or changing. The Save button often includes a dropdown menu for variations of save as shown in the example. NetSuite remembers the option selected and makes it the default.</td>
<td></td>
</tr>
<tr>
<td><strong>Save As Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>The Save As button creates a duplicate of the visible record. A unique name is required. For example, a customer may have multiple locations, Art Gallery I and Art Gallery II. The home office in Gallery I is the main office for both locations. You can create a record for Gallery II by editing the Gallery I record, changing the name to Art Gallery II and clicking Save As.</td>
<td></td>
</tr>
<tr>
<td><strong>Save and New Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>The Save and New button sends the transaction or record to NetSuite for posting, and then a blank page of the same kind opens.</td>
<td></td>
</tr>
<tr>
<td><strong>Save and Next Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>The Save and Next button sends the transaction or record to NetSuite for posting, and then the next existing record of the same type opens for editing.</td>
<td></td>
</tr>
<tr>
<td><strong>Save and Edit Button</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Example" /></td>
</tr>
<tr>
<td>The Save and Edit button saves your edits and remains in edit mode where you can continue editing.</td>
<td></td>
</tr>
</tbody>
</table>
Logging in to NetSuite

Authentication is the process of verifying your identity when you log in to an application. This section contains procedures describing the ways that your identity can be authenticated when you log in to NetSuite.

The most familiar form of authentication occurs when you log in to the NetSuite UI with your email address and your password, which are your user credentials. Depending on the role or roles you are assigned by your account administrator, you might also be required to provide a second factor for authentication, known as two-factor authentication, or 2FA.

See the following sections for more information about how your identity is authenticated when you log in to NetSuite.

- **Logging in to the NetSuite UI**
  This section contains the following topics:
  - Your User Credentials
  - Finding Your Settings Portlet
  - Change Email Link
  - Change Password Link
  - Setting Up Security Questions
  - Update Security Questions Link
  - If You Forget the Answers to Your Security Questions
  - Getting Access When You Forget Your Password
  - My Login Audit Portlet

- **Logging In Using Two-Factor Authentication (2FA)**
  This section contains the following topics:
  - Set up Your Preferences for Two-Factor Authentication (2FA)
    - Complete Your 2FA Setup
    - Supported Authenticator Apps
    - Troubleshoot Authenticator Apps
  - Using 2FA
    - The Logging in Page for 2FA
    - Managing Your Trusted Devices
    - Reset Your 2FA Settings
    - Backup Codes for Two-Factor Authentication (2FA)

**Note:** You log in to NetSuite using a browser. If you are using Internet Explorer as your browser, add NetSuite as a trusted site to ensure you can access NetSuite.

Logging in to the NetSuite UI

This section contains information on the most basic way you can log in to the NetSuite UI, using your email address and password, which are your user credentials. In this section, you will also find directions
for locating the Settings portlet, which contains links for changing your email address, changing your password, updating your security questions, and other tasks. You can also find information on creating strong passwords, answering security questions, and what to do if you forget your password.

**Note:** If you are using Internet Explorer 11, and have difficulty accessing NetSuite, add the website to your security zones as a trusted site. In your Internet Explorer 11 browser, go to Settings > Internet Options > Security > Trusted Sites. Click Sites, and add the wild card https://*.*netsuite.com as a website to the zone. Click OK.

See the following topics for more information:

- Your User Credentials
- Finding Your Settings Portlet
- Change Email Link
- Change Password Link
- Setting Up Security Questions
- Update Security Questions Link
- If You Forget the Answers to Your Security Questions
- Getting Access When You Forget Your Password
- My Login Audit Portlet

### Your User Credentials

The combination of your email address and your password are your user credentials for accessing NetSuite. Your email address is considered, and often referred to, as your username in NetSuite.

If you have access to NetSuite accounts for more than one company, you can either use the same username for all of them, or you can use a different username for each company.

- If you use the same user credentials for all companies, all of your roles in all companies are listed on the Change Role page and the Choose Roles list. Use Choose Roles to switch to a role in another company, or click View All Roles and click the role name on the Change Role page.
- If you use separate user credentials for different companies, you must log out and then log in again to switch to another company.

**Important:** You are uniquely identified in NetSuite by your email address, it is your username. There is a one-to-one relationship between username and password. That is, one username can only have one password, no matter how many accounts or companies you can access with that username.

### Finding Your Settings Portlet

Use the links in the Settings portlet on your Home page to change your password and to perform other setup and configuration tasks in NetSuite.

**To find your Settings portlet:**

1. Click to verify that you are on the Home page, also called the dashboard.
Important: The Settings links you are looking for are not in the list that appears when you hover over the Home icon.

2. The **Settings** portlet can appear anywhere on a customized Home page. By default, the Settings portlet is located on the left side of the page. You might need to scroll down to see it.

3. Click the appropriate link for the task you need to complete.

For more information about these links, see the following topics:

- Change Email Link
Change Email Link

The email address you use to log in to NetSuite is also used for email notifications and other communications from administrators. You can use the Change Email link in the Settings portlet to change your email address.

⚠️ Important: Before you change your email address in NetSuite, verify that this change is OK with your account administrator.

To change your email address:

1. Find the Settings portlet on the Home page. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.

   ![Tip: The Settings portlet can appear anywhere on a customized Home page (or dashboard). By default, it is located on the left side, and you might need to scroll down to see it.]

2. Click Change Email.

3. In the Current Password field, enter the password you currently use to log in.

   You must provide your password when you are changing your email address, to ensure the security of your account.

4. Enter the new email address in the New Email Address field, and re-enter the same address in the Confirm New Email field.

5. Check Just This Account to change your login information for only the account to which you are currently logged in. This option only applies if you have access to multiple NetSuite accounts.

   If you clear this box, you can log in to all of your NetSuite accounts with the updated email address you entered.

6. Click Save.

After you have saved the change to your email address:

- A notification message is sent to your current email address.

- A validation message is sent to your new email address, with a link that you must click to complete the change.

- You must continue to use the current email address to log in to NetSuite, until you have clicked the validation link to confirm the change.

- The new email address is listed in the Pending Email Change field on the Change Email page, until either you have clicked the validation link, or the link has expired.

The times in the notification and validation messages are based on the time zone preference that you have set at Home > Set Preferences.
Important: If you receive a notification message about an email change that you did not initiate, you should alert your account administrator to a possible security issue. If you receive a notification message and you realize that the change is in error, for example you made a typo in the new email address, you can let the validation link expire. You can then enter a change to the correct email address.

Change Password Link

You can change your password using Change Password in the Settings portlet when you are logged in to NetSuite. You must first enter the password you used to log in to your account, and then enter a new password. You must provide your password to ensure the security of your account.

How to Change Your Password

You can also reset your password if you are unable to log in because you forgot your password. For more information, see the help topic Getting Access When You Forget Your Password.

To change your password:

1. Find the Settings portlet on the Home page. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.

   Tip: The Settings portlet can appear anywhere on a customized Home page (or dashboard). By default, it is located on the left side, and you might need to scroll down to see it.

2. Click Change Password.

3. In the Current Password field, enter the password you currently use to log in to NetSuite.
Logging in to the NetSuite UI

4. In the **New Password** field, enter a new password.

5. As you type, the **Password Criteria** fields provide feedback, ensuring that the password you enter meets the criteria shown. For more information, see the help topic **Creating a Strong Password**.

6. Re-enter the new password in the **Confirm New Password** field.

7. Click **Save**.

   The next time you log in to NetSuite, you must use the new password.

Note: You will receive an email notification when the password associated with your email address is changed. This email notification enables you to be more aware and proactive in cases where there is a fraudulent attempt to change your password.

Creating a Strong Password

It is important to choose a password that cannot be compromised. Your password is validated to ensure it meets minimum requirements. The validation is based on a combination of password settings that can be modified by your account administrator and system requirements that cannot be modified.

Note: For information on how to change your password, see the help topic **Change Password Link**.

By default, all NetSuite accounts are set to have a Strong password policy. This policy enforces the following requirements:

- Minimum length of 10 characters
- At least 3 of the following 4 character types—uppercase letters, lowercase letters, numbers, non-alphanumeric ASCII characters
- No non-ASCII characters, which are considered illegal
- Not too easy to guess, such as common names, words, and strings like abcd123456
- Significantly different from your most recent password

The length and character type requirements for your password may vary if your account administrator has changed the password policy or minimum password length. Ask your administrator if you have questions about the password requirements for your company.

The Password Criteria fields provide immediate feedback as you type a password on the Change Password page. This feedback shows you whether your entered password complies with all of the password requirements for your company.
The Password Criteria fields appear on any entity record where it is possible for you or an administrator to enter a password for granting access to your NetSuite account.

### Password Expiration Notifications

Your NetSuite password will expire. The length of time that a password remains valid depends on the password requirements configured by your account administrator. You can view the date and time your password will expire in the My Login Audit portlet on your Home page.

You will receive advance notice of the date that your password will expire. This notice helps to eliminate uncertainty and problems associated with having to change your password at an inconvenient time. The first notice is sent 14 days before your password expiration date. As soon as you update your password, the notices stop. If you do not change your password, the next notice arrives seven days before your password expires. If necessary, you will receive an additional notice each day for the final three days before your password expires.

The password expiration notification includes a link to let you change your password. A table lists the Company ID, Company Name, Days to expiration, and account type helps you to identify the role and the account where your password is expiring.

Tip: After changing your password, refresh the portlet to see the new password expiry date.
You can also use **Change Password** in the Settings portlet to change your password. For more information, see:

- Change Password Link
- Finding Your Settings Portlet

**Note:** Be aware of the following:

- Users can have roles that provide access to more than one NetSuite account. It is possible that some of the accounts to which a user has access have a stricter password requirements than other accounts. On rare occasions, users may attempt to access a role in an account that has stricter password requirements and encounter a password expired error message. For example, users assigned to the NetSuite Support Center or the NetSuite Support Center (Basic) role are actually accessing the Oracle NetSuite account through the NetSuite Account Center portlet. These users are then subject to the Oracle NetSuite password requirements. In this case, users must change their password before they can access the NetSuite Account Center.

- You might be required to comply with Payment Card Industry Data Security Standard (PCI DSS) password requirements. If you have a role with the View Unencrypted Credit Cards permission, you must change your NetSuite password at least every ninety (90) days. If your company policy for NetSuite password expiration is greater than 90 days, the 90 days limit is automatically enforced for anyone with the View Unencrypted Credit Cards permission. In addition, the required length for a password is a minimum of seven (7) characters. Everyone with access to unencrypted credit card numbers must comply with PCI password requirements.

- Roles to which the SAML Single Sign-on permission has been added, and roles that have been designated as Single Sign-on Only, are exempt from password expiration notifications. SAML user credentials are not managed by NetSuite, but by the Identity Provider (IdP).

### Setting Up Security Questions

The first time you log in to NetSuite, you are prompted to answer three security questions. These answers are used to verify your identity if you forget your password, or if you log in from a new browser or a new computer. This process helps to maintain application security by preventing unauthorized use of your NetSuite user credentials.

If you are under time pressure, you can click Remind Me Later to dismiss this prompt and log in to NetSuite immediately. However, the next time you log in to NetSuite, you will be prompted again to set up these questions.

**Note:** You can dismiss this prompt a maximum of 5 times. After that, you will be required to set up security questions to proceed with your login to NetSuite.

See the following sections for more information:

- Set Up Security Questions Link
- Security Questions Details

### Set Up Security Questions Link

If you dismiss the prompt, then decide you would like to set up your security questions, click Update Security Questions in the Settings portlet.
Tip: The Settings portlet can appear anywhere on a customized Home page (or dashboard). By default, it is located on the left side, and you might need to scroll down to see it.

If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet. See also Update Security Questions Link for more information.

Important: Remember your questions and answers! NetSuite does not often prompt you to answer a security question, so it is easy to forget you set them up. However, there are several situations when you will be prompted, and it is important that you know the answers. See the help topic When Security Questions are Asked for more information.

When you save your security questions and answers, a confirmation is displayed. Also, an email is sent to the email address you used to log in, as notification that this setup has occurred.

You have the option of changing your security questions and answers at a later time. See the help topic Update Security Questions Link.

Security questions and answers are shared across all NetSuite accounts associated with the same production account.

Security Questions Details

See the following sections for details about security questions:

- Requirements for Answers to Security Questions
- Exemptions from Setting Up Security Questions
- When Security Questions are Asked

Requirements for Answers to Security Questions

If any of these requirements is not met, you will receive an error when you attempt to save security answers.

- You must answer all three questions.
- Each answer must be unique.
- Each answer must be at least three characters long.
- You cannot use your email address or password as an answer.

Note: Answers are not case-sensitive.

Exemptions from Setting Up Security Questions

If you log in to NetSuite with certain roles, or with certain types of access, you are exempted from the requirement to set up security questions. The following roles are exempted:

- Customer Center
- Web Store Shopper

Note: Users with two-factor authentication (2FA) roles, or roles with IP address restrictions enabled are prompted to set up security questions. However, users with 2FA or IP address restricted roles are only asked to answer security questions if they forget their passwords.

The following types of access are exempted:
When Security Questions are Asked

You will be prompted to answer a security question before you can log in to NetSuite in the following circumstances:

- When you attempt to log in:
  - using a new browser
  - after the browser cache has been cleared
  - with the browser set to private mode (also called incognito browsing)
  - from a new or different computer

**Note:** This additional authentication requirement does not apply to you if you are using two-factor authentication roles, or roles with IP address or device ID restrictions enabled.

- When you forget your NetSuite password, and must reset it.
- If it has been more than 90 days since your last login.

If you answer the security question correctly, your login to NetSuite proceeds and an email is sent to the email address you used to log in, as notification of the successful authentication.

If you provide six consecutive wrong answers to the security question, you are locked out of NetSuite for a period of 30 minutes, and an email is sent to your email address and to your account administrator, as notification of the authentication failure.

Update Security Questions Link

The first time you log in to NetSuite, you are prompted to set up three security questions that are used to verify your identity, as described in Setting Up Security Questions. You have the option of changing these questions and answers.

You are the only one who can update your security questions. If you cannot answer your security questions, see the help topic If You Forget the Answers to Your Security Questions.

**To change security questions and answers:**

1. Find the **Settings** portlet on the Home page. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.

   **Tip:** The **Settings** portlet can appear anywhere on a customized Home page (or dashboard). By default, it is located on the left side, and you might need to scroll down to see it.

2. Click **Update Security Questions**.
3. Enter your current NetSuite password.

4. In the Question 1, Question 2, and Question 3 fields, select questions for which you can remember the answers.

5. In the Answer 1, Answer 2, and Answer 3 fields, enter the answers to each question you selected. You must answer all three questions.
   - Each answer must be unique.
   - Each answer must be at least three characters long.
   - You cannot use your email address or password as an answer.
   - Answers are not case-sensitive.
   - Answers are masked (hidden) by default. Clear the Hide Answers box to see the characters without the mask.

6. Click Save.

If You Forget the Answers to Your Security Questions

Since you are not often prompted to respond to the security questions you set up, you may occasionally forget your questions, or the answers you provided. The easiest way to handle this is when you are logged in to NetSuite. Click the Update Security Questions link in the Settings portlet. Select new questions, or provide answers to your existing questions. See the help topic Update Security Questions Link for details.

If you are attempting to log in to NetSuite and are prompted to answer a security question but cannot remember the answer you gave, you might be required to reset your password or ask your account administrator to do so.

If an account administrator resets your password, your previously saved security questions are erased and you must set up these questions and answers again. If you reset your own password, the existing security questions and answers are maintained.

To deal with forgotten security questions:

Remember your answers! You will not often be prompted to answer a security question, so it is easy to forget you set them up. If you do forget your answers, the following suggestions should help.

1. You have six attempts to answer the questions, try the most likely answers you would have given.

2. If the first attempt does not succeed, try again. Keep trying the most logical answers to your security questions.
**Tip:** Case does not matter, so do not waste an attempt by changing some characters to a different case.

3. If you cannot reset your own password, and cannot remember your answers to security questions:
   a. Update your security questions when you are already logged in to NetSuite.
   b. Ask your account administrator to reset your password. If your account administrator resets your password, your existing security questions and answers are erased. After your password is reset, you must set up new security questions and answers. If you or your account administrator cannot reset your password, your account administrator can contact Support for assistance.
   c. Ask your account administrator to designate your role as a two-factor authentication (2FA) required role. Roles that are designated as requiring 2FA are never asked security questions. For more information, see the help topic Logging In Using Two-Factor Authentication (2FA).

### Getting Access When You Forget Your Password

If you need to change your password, use Change Password in the Settings portlet. For more information, see the help topic Change Password Link. See also Finding Your Settings Portlet.

However, if you cannot remember your password, you can try to reset your password yourself. Go to the NetSuite login page and click Forgotten Your Password? See the following procedure, The Forgotten Your Password Reset, for complete instructions.

### The Forgotten Your Password Reset

Use the following procedure when you cannot remember your password. Part of the password reset process includes answering security questions to verify your identity.

**Important:** If you did not set up security questions or do not remember the answers to them, you may need assistance to access your account. If this is the case, contact your NetSuite account administrator to reset your password. When your Administrator resets your password, you must set up new security questions and answers.

To reset your password:

1. On the NetSuite login page, enter the email address you use to log in to NetSuite.
2. Click **Forgot Your Password**.

3. On the Reset Password page, enter the email address you use to log in to NetSuite, and click **Continue**.
   
   Follow the instructions displayed on the screen.

4. Check your email client for an email message with directions and a link for resetting your password.

   **Note:** The link will expire in 60 minutes.
   
   a. If you do not receive an email message, verify whether the email address you entered in the previous step is correct. (The email address you entered is displayed in the instructions on the screen.)
   
   b. If the email address you entered is correct, and you still have not received an email message, please contact your NetSuite account administrator.

5. Click the link in the email message.

   **Note:** If you receive an error message that the link has expired, begin the password reset process again at step 1.

6. Answer the security questions to confirm your identity. Answers are not case sensitive.

   **Important:** You have 20 attempts to answer all three of your security questions correctly. If you want the answers you enter to be visible on the screen, clear the check from the **Hide Answers** box. If you fail all 20 attempts, contact your account administrator for help.

7. Click **Submit**.

8. You are redirected to the Change Password page. Complete the required fields.

   See the help topic **Change Password Link** for more information. See also **Creating a Strong Password**.

   After you have successfully reset your password, a confirmation message is sent to the email address from which the reset request was generated.

   **Note:** If you have an Administrator role in this account, and are requesting a password reset, the confirmation email message is also sent to everyone with an Administrator role in that account. If you have an Administrator role in more than one account, and are requesting a password reset, the confirmation email message is sent to everyone who has an Administrator role in any of those accounts.

   If you still need assistance to access your account, contact your NetSuite account administrator to reset your password. When your password is reset, you must set up new security questions and answers.

---

**My Login Audit Portlet**

The My Login Audit portlet shows information about your login activity. You can add the My Login Audit portlet to your dashboard. Use the portlet to monitor your previous successful login, your previous failed login, the IP address associated with your login activity, the date when your password will expire, and other login information.

- The My Login Audit Portlet cannot be added to the Customer Center or the Employee Center dashboards.
• The value shown for **Successful Logins** increments each time you switch roles. By switching to another role, you are (in a sense) logging in to a different role.

• The dates and times displayed in the portlet are based on the time zone you selected as your preference on the General subtab at Home > Set Preferences.

• If you are logged in and have just changed your password, refresh the portlet to display your new Password Expiration date.

**To add the My Login Audit portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.

2. In the **Standard Content** tab of the **Personalize Dashboard** palette, click or drag and drop the **My Login Audit** icon.

3. To configure the login information displayed in the My Login Audit portlet, click **Set Up** in the portlet menu.

**Choosing the Information Shown in the My Login Audit Portlet**

Click the **Set Up** menu option in the My Login Audit portlet to open a window. Multiple tabs let you select the type of information you want to see in the portlet.

- **Last Login** tab - options include:
  - Last Login
  - Last Login Using Browser
  - IP Address of Last Login
  - Current Login Using Browser
  - IP Address of Current Login
  - Last Login Using Mobile Device
  - Last Login Using Web Service
Logging in to the NetSuite UI

- Current Login Using Browser
- IP Address of Current Login
- Last Login Using Mobile Device
- Last Login Using Web Service

- **Successful Logins** tab - options for successful logins include: Today, This Week, This Month.
- **Login Failures** tab – options: Last Login Failure, IP Address of Last Login Failure, and options for failed logins include: Today, This Week, This Month.

**Note:** Entering an incorrect 2FA verification code is counted in the portlet as a Login Failure.

For more information about the options listed on each tab, refer to the field-level help.

### Logging In Using Two-Factor Authentication (2FA)

**Important:** Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts. Users should select an authenticator app as the primary method of authentication. SMS and voice call are subject to carrier availability and changes in local regulations. Therefore, delivery of verification codes by SMS or voice call is not as reliable as using an authenticator app. See the help topic [Supported Authenticator Apps](#).

**2FA Delivered Your Way for Users**

Requiring a second factor for authentication is a method of improving security. Your administrator can assign you a 2FA authentication required role. You will receive an email the first time you attempt to log in to your 2FA role. The email contains instructions and a verification code for your initial login to that role. You can use an authenticator app or your phone to generate the verification codes necessary during login. As long as your session remains valid, you will not be asked again for a verification code when you switch between roles, even when you switch between roles in different companies.

If you are assigned a role that requires 2FA authentication, you must set up an authenticator application or a phone number in NetSuite.
Logging In Using Two-Factor Authentication (2FA)

Note: You must complete the initial 2FA setup in the NetSuite UI on your computer. You can log in using 2FA with the NetSuite Mobile application. However, it is not possible to perform the initial 2FA setup from the mobile app.

For more information about setting up 2FA in NetSuite, see:

- Set up Your Preferences for Two-Factor Authentication (2FA)
  - Complete Your 2FA Setup
  - Supported Authenticator Apps
  - Troubleshoot Authenticator Apps

Important: If you lose your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. After resetting, you must start the 2FA setup process from the beginning.

To log in with a role that requires 2FA, you must first enter your email address and password on the NetSuite login page, and click Log In. After that step is successful, you are prompted for a verification code. For more information about using 2FA in NetSuite, see:

- Using 2FA
  - The Logging in Page for 2FA
  - Managing Your Trusted Devices
  - Reset Your 2FA Settings
  - Backup Codes for Two-Factor Authentication (2FA)

Set up Your Preferences for Two-Factor Authentication (2FA)

You must set up a primary method for 2FA. An authenticator app is recommended for your primary method. Authenticator apps can generate a verification code even when you cannot receive a text message (SMS) or voice call. For more information on selecting an authenticator app, see the help topic Supported Authenticator Apps.

Important: Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts. Users should select an authenticator app as the primary method of authentication. SMS and voice call are subject to carrier availability and changes in local regulations. Therefore, delivery of verification codes by SMS or voice call is not as reliable as using an authenticator app.

You are allowed to dismiss the prompt to set up a primary method five times before you are required to select an authentication method and set up either your authenticator app or phone number. You should also set up a secondary method to receive verification codes. Ten backup codes are generated when you complete the security setup page.

- When using an authenticator app for 2FA, you must enter the verification code obtained from the app to complete the setup.
- When using your phone for 2FA, the phone number is associated with the email address you used for login. Your phone number is not stored on your employee, partner, or vendor record. Your phone number is verified by sending a verification code, either by SMS or by voice call. Enter this code in NetSuite to complete the setup.

NetSuite Basics
For more information, see the following topics:

- Complete Your 2FA Setup
- Supported Authenticator Apps
- Troubleshoot Authenticator Apps

**Important:** If you lose your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. After the reset is completed, you must start the 2FA setup process from the beginning.

### Complete Your 2FA Setup

The first time you log in to NetSuite with a 2FA required role, you are automatically shown the **Security setup** page. If you do not see the following screen, you might not be logged in to NetSuite with a role that requires 2FA. Switch roles to a role that is 2FA required. If you do not know whether you have a role that requires 2FA, ask your account administrator.

**Note:** You must complete the initial 2FA setup in the NetSuite UI on your computer. You can log in using 2FA with the NetSuite Mobile application. However, it is not possible to perform the initial 2FA setup from the mobile app.

To complete your 2FA setup:

1. Select your primary method for receiving 2FA verification codes.

   a. Select **Authenticator app (recommended)**. If you did not already install an authenticator app on your phone, do so now.

   **Important:** Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts. Users should select an authenticator app as the primary method of authentication. SMS and voice call are subject to carrier availability and changes in local regulations. Therefore, delivery of verification codes by SMS or voice call is not as reliable as using an authenticator app. See the help topic Supported Authenticator Apps.

   Select SMS or phone call if you prefer to receive verification codes on your phone. Follow the directions in Step 4.
b. Click **Next**.

**Note:** You can click **Skip to NetSuite** to dismiss this prompt up to five times. After the fifth time, you are required to set up an authenticator app or your phone number.

2. Using the authenticator app on your phone:
   
a. Scan the QR code displayed, or manually enter the string of characters shown next to the QR code.

   The authenticator app generates a verification code.

   b. Enter the verification code.

   Verification codes generated by authenticator apps expire approximately every 30 seconds. Enter a new code if the initial code you receive expires.

   **Important:** If you have entered several codes in a row that have been refused, do not keep trying codes from your app. After six failed attempts, you will lock yourself out of NetSuite. If the time on your phone or app is not properly synchronized, NetSuite will not accept the verification codes generated by your app. See the help topic [Troubleshoot Authenticator Apps](#) for potential solutions.

   c. Click **Next**.

3. You should set up a secondary method to receive codes for two-factor authentication. If you selected SMS or phone call as your primary method, follow the directions in Step 1 for an authenticator app.
a. Select the flag that represents the country where your phone service originates, and enter the phone number to receive your verification code for NetSuite. Your phone number is linked to the email address you use to log in to the NetSuite UI.

You only need to type the numbers. Dashes and parentheses are not required.

If you do not see the correct country flag icon in the list, type a plus sign, your country code, and your phone number.

If you receive an error message, ask your administrator to verify that your country is supported for text messages (SMS) or voice calls.

b. Select either the SMS or the Voice call option.

A verification code is sent to your phone.

c. Enter the verification code.

d. Click Next.

4. Ten backup codes are displayed in the UI.

These unique backup codes can be used to log in to a 2FA role when you are unable to receive a verification code. Each backup code can be used only a single time.
Logging In Using Two-Factor Authentication (2FA)

5. Click Print to print the backup codes, if desired.

6. Click Next.

After your 2FA setup is complete, the Reset 2FA Settings and Generate Backup Code links appear in your Settings portlet. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet. If you do not see the links as expected, refresh your browser.

For more information, see the following topics:
- Supported Authenticator Apps
- Troubleshoot Authenticator Apps

Supported Authenticator Apps

You should use an authenticator application for roles that require 2FA. You can select an authenticator app from the vendor of your choice, as long it complies with the OATH TOTP standard. The following mobile phone apps are recommended:

If you lost your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. See also If You Lost or Replaced the Phone You Use for 2FA
- Google Authenticator
- Microsoft Authenticator
- OKTA Verify

Download the appropriate authenticator app for your mobile phone to get started.

Note: The authentication application you choose must support the OATH TOTP, the IETF RFC 6238 standard. OATH is the Initiative For Open Authentication. TOTP means time-based one-time password. IETF is the Internet Engineering Task Force.
Troubleshoot Authenticator Apps

Occasionally, NetSuite will not accept verification codes generated by your authenticator app. You may get an error message that the code is expired. If your phone (and perhaps your app) are not synchronized to the proper time source, your verification codes will not work.

**Important:** If you have entered several codes in a row that have been refused, do not keep trying codes from your app. After six failed attempts, you will lock yourself out of NetSuite.

If you need access to NetSuite right away, change the method by which you will receive the next code. For example, click **SMS message**, **Voice call**, or **Backup codes**.

Use the following procedures to verify settings on your phone and on your authenticator app.

**To synchronize time on your phone:**

1. Go to Settings on your phone. Locate the settings for date and time. The navigation path to the date and time settings, and the exact name of the settings varies depending on the type of phone you have (Apple or Android) and the version of the operating system (OS) software on your phone.
2. If you have an iPhone, go to Settings > General > Date & Time. Verify that the switch for the setting **Set Automatically** is on.
3. If you have an Android, go to Settings > System > Date & Time. Verify that the switch for the settings **Automatic date & time** and **Automatic time zone** is on.
4. Older software versions on some phones might have a **sync time to server** setting. Clear the box if the sync time to server setting is checked. Verify that the time on your phone is synchronized to network time.

**To synchronize time on your Google Authenticator app:**

The Google Authenticator app has an internal time sync setting, **Time correction for codes**. If the time is not correctly synchronized, the verification codes will not work. A Google Support site, **Common issues with 2–Step Verification**, details the steps for correcting the time in the app. Scroll down to the bottom of the page to the **My Google Authenticator codes aren't working (Android)** entry.

For more information, see the following topics:

- **Complete Your 2FA Setup**
- **Supported Authenticator Apps**

**Using 2FA**

**Important:** Authenticator apps for generating 2FA verification codes are supported in all NetSuite accounts. Users should select an authenticator app as the primary method of authentication. SMS and voice call are subject to carrier availability and changes in local regulations. Therefore, delivery of verification codes by SMS or voice call is not as reliable as using an authenticator app. See the help topic **Supported Authenticator Apps**.

After completing the initial 2FA setup, see the following topics about using 2FA in NetSuite:
Important: If you lose your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. After the reset is completed, you must start the 2FA setup process from the beginning.

2FA Access to Sandbox Accounts

When your sandbox is refreshed, roles that require 2FA authentication are copied from your production account to your sandbox. Your 2FA setup is also copied to your sandbox account. No additional 2FA setup is necessary.

The Logging in Page for 2FA

If your administrator designated one or more of your roles as 2FA authentication required, you can use an authenticator app to obtain a verification code, or use your phone to request a code by SMS message or voice call, or use one of your backup codes. For more information, see the help topic Logging In Using Two-Factor Authentication (2FA).

You can decide whether you want to check the Trust this device box. For more information about this box, see the help topic Managing Your Trusted Devices.

You can click one of the links to select an alternative method for receiving a code for this log in attempt. For example, click SMS message, Voice call, or backup codes.
Logging In Using Two-Factor Authentication (2FA)

Your other roles are listed on the page. You can select an alternative role by clicking Choose to the right of the role.

- **Important:** If you lose your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. After the reset is completed, you must start the 2FA setup process from the beginning.

Managing Your Trusted Devices

When you are providing a verification code for logging in to NetSuite, take notice of the Trust this device... text on the Logging in to... page. The text specifies the length of time that a device can be trusted. The length of time is configured by your administrator for your 2FA role. If you will use this device often to log in, you should check the box to the left of the text. Checking this box means you will not have to provide another verification code for the period of time that your administrator specified for this role. This trusted device time period can range from hours to days.

You can always remove the trust from this device, or from all of your devices, if needed. For example, if you lose or replace a device, you should remove the trusted status from that device. You can also restore the 2FA challenge for devices at any time. You have complete control over the management of your devices.

To mark a device as trusted when logging in:

1. Log in with a role that requires 2FA. Enter your email address and password on the NetSuite login page, and click Log In.
   After that step is successful, you are prompted for a verification code.
2. On the Logging in to... page, enter the verification code.
3. Check the Trust this device for... box, if desired.
4. Click Submit.

- **Note:** You might have access to NetSuite accounts for more than one company. Marking a device as trusted for a 2FA authentication required role makes that device trusted across all of the companies to which you have access.

To manage trust for your devices:

1. Find the Settings portlet on your Home page. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.
2. Click Manage Trusted Devices.

NetSuite Basics
In this example, you had previously marked a device as trusted upon login. Now you have changed your mind.

3. To reverse your earlier choice, select one of the **Restore 2FA ...** options.

Remember that when the 2FA challenge is restored for a device, the next time you log in, you must have your authenticator app, your phone, or one of your backup codes available.

**Backup Codes for Two-Factor Authentication (2FA)**

Backup codes are provided when you successfully complete setup of your 2FA preferences in NetSuite.

**Important:** Planning a trip to a location where you do not have phone service? Authenticator apps can provide a verification code even when you have no service. What if you do not want to turn on your phone at all? You should also take your backup codes with you. Keep your backup codes secure. Do not store them with your device.

These codes are associated with your email address and are unique. You are the only person who can use these codes. A backup code is used for verification on login. Each code can be used only one time. You can generate new backup codes as needed. Backup codes do not expire, however, if you generate a new set of backup codes, the previous set of your codes is no longer valid.

You can generate ten new backup codes if you use all your existing backup codes, or if you lose them, or if you feel your existing codes may have been compromised. Generating new backup codes invalidates your previous codes.

**To generate backup codes:**

1. Find the **Settings** portlet on your Home page.
   - If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.

2. Click **Generate Backup Codes**.

3. Enter your password. You might also need to enter a verification code or backup code.

4. Click **Generate**.

   Ten backup codes are displayed.

**Important:** This is the only time these unique ten codes are displayed in the UI. You cannot retrieve these codes from the system after you leave this window. If you lose these backup codes, generate new ones. Use the link in the Settings portlet. You may need a backup code if, for example, you must set up a different phone. For more information, see the help topic Reset Your 2FA Settings.

5. Click the printer icon to print the backup codes, if desired.
Important: Treat backup codes as securely as you would treat a password. Do not store your codes with your device.

6. Click Continue to return to the NetSuite UI.

Each time you use one of your backup codes, you receive an email notification that one of your codes was used.

Important: If you lose your phone, buy a new phone, change your phone number, change your authenticator app, or change your verification code delivery method, you must reset (clear) your 2FA settings in NetSuite. See the help topic Reset Your 2FA Settings. After the reset is completed, you must start the 2FA setup process from the beginning.

Reset Your 2FA Settings

You need to reset (clear) your 2FA settings in NetSuite if you:

- Lose your phone.
- Buy a new phone.
- Change your phone number.
- Change your authenticator app.
- Change your verification code delivery method.

When you reset your 2FA settings, you remove your existing 2FA setup information from NetSuite.

Important: The Reset 2FA Settings link only clears your existing 2FA settings from NetSuite. You will not be able to set up your 2FA preferences again until the next time you attempt to access NetSuite with a 2FA-required role. In this case, you receive a verification code by email. Enter the code and click Submit. You are prompted to set up your 2FA preferences in NetSuite. See the help topic Set up Your Preferences for Two-Factor Authentication (2FA).

You can reset your 2FA settings from the Settings portlet on your Home page (Dashboard) by using Reset 2FA Settings in the Settings portlet.

To reset your 2FA settings:

1. Find the Settings portlet on your Home page. If you cannot locate the Settings portlet, see the help topic Finding Your Settings Portlet.
2. Click Reset 2FA Settings.

![Settings](image)

**Note:** If you do not see the Reset 2FA Settings link on your Settings portlet, it indicates that you have already reset (cleared) your 2FA settings from NetSuite. The next time you log in to NetSuite with a 2FA-required role, you will be prompted to set up your 2FA preferences in NetSuite. See the help topic [Set up Your Preferences for Two-Factor Authentication (2FA)](#).

3. On the Reset 2FA Settings page, enter your NetSuite password. You might also need to enter a verification code or backup code.

![Reset 2FA Settings](image)

4. Click Reset.

When you click Reset, you remove your existing 2FA setup information. A confirmation screen states that your registered 2FA devices were successfully reset. You also receive an email notification from NetSuite that your registered 2FA devices have been reset, and can no longer be used to access your NetSuite account.

The next time you attempt to access NetSuite with a 2FA-required role, you receive a verification code by email. Enter the code and click Submit, and you are prompted to set up your 2FA preferences in NetSuite. See the help topic [Set up Your Preferences for Two-Factor Authentication (2FA)](#).

**Note:** If you are not able to log in to NetSuite to reset your 2FA settings, contact your account administrator for assistance.

---

### If You Lost or Replaced the Phone You Use for 2FA

If you have a 2FA-required role in NetSuite, you use a phone to obtain verification codes. If you lost your phone, or purchase a new phone, you must clear the settings (the setup information) of your old phone from NetSuite. After resetting your 2FA settings, you must set up your new phone in NetSuite. Even when your phone number remains the same, you cannot transfer an authentication app from one phone to another. You must set up your phone number in NetSuite and install and configure an authentication app on your new phone.
**Important:** If you lost your phone, you should remove the phone’s 2FA settings from NetSuite as soon as possible. You may need to contact an Administrator of your NetSuite account for assistance. An Administrator can use the User Access Reset Tool to help you if you are not able to log in to NetSuite.

Before you begin, verify that you have a current backup code available. If you cannot locate your current backup codes, and you are able to log in to NetSuite, generate a new set of backup codes. See the help topic [Backup Codes for Two-Factor Authentication (2FA)](https://www.netsuite.com/plつか kokc/).

### To change your 2FA phone setup in NetSuite:

1. Click **Reset 2FA Settings** in the Settings portlet. See the help topic [Reset Your 2FA Settings](https://www.netsuite.com/). You may be required to enter a backup code to complete the reset. A backup code is required if you are logged in from a device that is not a trusted device in NetSuite. For more information about trusted devices, see the help topic [Managing Your Trusted Devices](https://www.netsuite.com/).

   **Note:** If you cannot locate your Settings portlet, see the help topic [Finding Your Settings Portlet](https://www.netsuite.com/).

2. Log out of NetSuite.

3. Log in to NetSuite with a 2FA-required role. You are prompted to set up your 2FA preferences before you can access NetSuite. See the help topic [Set up Your Preferences for Two-Factor Authentication (2FA)](https://www.netsuite.com/). A video about 2FA setup is also available: 2FA Your Way for Users.

4. Follow the on-screen prompts to choose your primary and secondary methods for obtaining verification codes. See the help topic [Complete Your 2FA Setup](https://www.netsuite.com/).

   **Note:** You should choose an authenticator app as your primary method. See the help topic [Supported Authenticator Apps](https://www.netsuite.com/).
Logging out of NetSuite

For security reasons, you should log out of NetSuite manually. To do this, hover over your name in the top right corner and choose **Log Out** from the dropdown list:

After a period of no activity in the UI, you are automatically logged out of NetSuite. The length of time before the logout is controlled by the account administrator. For more information, contact your account administrator.
Setting Personal Preferences

This section of NetSuite Basics describes the preferences that are available to you as a NetSuite user. The Set Preferences page displays options for most aspects of your NetSuite account. These preferences enable you to set up your NetSuite account to fit your needs. Your user preferences are constrained by the features enabled for your account, company account-level preferences, and the role-based dashboards that are set up by your account administrator.

Note: Your password is not a personal preference, it is a setting in NetSuite. If you want to change your password, see the help topic Change Password Link. See also Finding Your Settings Portlet.

These preferences are specific to your NetSuite role. If you have multiple roles in NetSuite, the preferences you set in one role usually do not affect your other NetSuite roles. For example, changing the preference for date format does affect all of your roles. However, changing the color for the NetSuite application only affects the role where you set the preference. The preferences you set do not apply to other NetSuite users even if they are assigned the same role as you are.

Your account administrator can set preferences that may apply to you by default. The preferences your administrator sets can be for all users logging in with a role, for all users in a company, or if you are using NetSuite OneWorld, for all users in a subsidiary. See the help topic NetSuite Preference Levels Overview. However, the personal preferences you set normally take precedence over these other preferences set for a role, subsidiary, or company.

To set your personal preferences:

1. Go to Home > Set Preferences.
2. Click a subtab on the Set Preferences page to edit your preferences for a specific area of NetSuite.
3. When you are finished setting preferences, click Save.

You can set preferences on multiple subtabs before you click Save.

Your changes appear on the next transaction, or record you enter, or the next time you visit a page in NetSuite.

The topics listed below describe the options available on each subtab of the Set Preferences page:

- General Personal Preferences
- Personal Preferences for Appearance
- Personal Preferences for Transactions
- Analytics Personal Preferences
- Personal Preferences for Activities
  Also see Setting Calendar Preferences.
- Personal Preferences for Alerts
- Personal Preferences for Telephony
- Personal Preferences for Restricting Views

General Personal Preferences

Go to Home > Set Preferences. The General subtab is displayed by default. On this subtab you can set the preferences in the following table.
The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Profile</td>
<td></td>
</tr>
<tr>
<td>Nickname</td>
<td>Enter the name that you want to appear in the From field of email messages you send from NetSuite. For example, you can send an email message by clicking the Email subtab on your employee record.</td>
</tr>
<tr>
<td>From Email Address</td>
<td>Enter the email address you want shown as the From address in email you send through the system. Replies to this email are sent to this email address as well. If you do not enter an email address here, email you send will show your login email address.</td>
</tr>
<tr>
<td>Signature</td>
<td>Enter a signature (in HTML markup) you want to appear at the end of email you send from NetSuite. Note: The HTML must be formatted correctly, including line breaks, hyperlinks, character formatting such as Bold, and any other special formatting. If the signature is not correctly formatted, it will not display properly. For an example, see Customizing Email Signatures and From Fields.</td>
</tr>
<tr>
<td>Add Signature to Messages</td>
<td>Check this box if you want your signature automatically added to all fax and email messages you send. Note: If your signature is already included in the fax or email template you are using, your signature will not be added twice.</td>
</tr>
</tbody>
</table>

Localization

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Select the language for your NetSuite account. For more information, see Choosing a Language for Your NetSuite User Interface.</td>
</tr>
<tr>
<td>Search Sorting</td>
<td>Select the alphabetical order to use for search results.</td>
</tr>
<tr>
<td></td>
<td>▪ Language Specific – the alphabetical order specific to your NetSuite language settings.</td>
</tr>
<tr>
<td></td>
<td>▪ English (U.S.) – the U.S. English alphabetical order.</td>
</tr>
<tr>
<td>Language of the Help Center</td>
<td>Select the language for the NetSuite Help Center. Supported languages are English, German, Japanese, and Spanish. Note: You can choose a different language for the Help Center than the language you specify for the User Interface. Your preference is used the next time you open the Help Center, and this preference is maintained until you change it. For more information, see Choosing a Language for Your NetSuite User Interface. Note: You can also set this preference directly from the NetSuite Help Center using the dropdown list at the top right corner of the page. For more information, see Using the Help Center Window. Whether you select the language preference directly in the Help Center or from Home &gt; Set Preferences, the preference is maintained until you change it.</td>
</tr>
</tbody>
</table>
### Field Name | Function
--- | ---
**PDF Language** | This option is no longer used. To print your reports in a different language, change your NetSuite language in the Language field.

**Accounting Context** | If you have a OneWorld account and one accounting context is defined at Setup > Company > General Preferences, this dropdown list appears.

An accounting context can be a one-to-one relationship between a country's local GAAP (Generally Accepted Accounting Principles) reporting requirements and a statutory chart of accounts (COA). It can also be a unique relationship that meets your company's specific needs. Accounting contexts are useful when you prefer to work in a local GAAP context, rather than in the consolidated context with one centralized COA.

When you select an accounting context from this dropdown list, all transactions including system-generated transactions post to the defined COA account name and number.

This field is blank by default. When blank, all transactions including system-generated transactions post to the consolidated accounts across all subsidiaries.

**Time Zone** | Select the time zone where you work.

**First Day of Week** | Select the day that you want to start your week on.

**Calendar System** | A calendar preference is only available when you select Japanese as the Language preference.

Select the calendar to use within NetSuite.

- **Gregorian Calendar** - This is the default calendar. It is the internationally accepted civil calendar.
- **Japanese Imperial Calendar** - This is a specialized Japanese calendar. The imperial date format is required for some government documents and applications used in Japan.

**Use Furigana Field** | The Furigana field is only available on records in the NetSuite Japan edition when you select Japanese as the Language preference.

Check this box if you want to sort lists of records by the Furigana field.

**Formatting**

**Date Format** | Select the date format for all of your NetSuite roles.

**Long Date Format** | Select how to display the month, day and year in NetSuite.

**Time Format** | Select an option for how time displays in your NetSuite account.
### Field Name | Function
--- | ---
**Note:** If you change the time format, all of the roles associated with your email and password are affected.  
Number Format | Select the format to display numbers online for transaction forms and entity forms for all of your NetSuite roles. For more information, see the help topic Number Formats.  
**Note:** If you change the Number Format, all of the roles associated with your email and password are affected.

Negative Number Format | Select the format to display negative numbers online for transaction forms, entity forms, and search results. For more information, see the help topic Number Formats.  
**Note:** If you change the Negative Number Format, all of the roles associated with your email and password are affected.

Phone Number Format | Select an option to display phone numbers in your NetSuite account. This phone number format is used on all online forms that you print. This setting only applies to seven and ten digit phone numbers.

Auto Place Decimal | Check this box to insert a decimal point between the second and third digit from the right when you enter numbers. When you first start using NetSuite, this preference is activated.  
**Important:** Clear this box if you are using the Software Verticals Contract Renewals module. Enabling this preference may cause unwanted updates to transaction amounts calculated by Contract Renewals transaction processing. For more information, see the help topic Setting Up Contract Renewals Preferences.

CSV Column Delimiter | Select the symbol to be used as the default column separator when importing data from CSV files. For more information, see the help topic Setting CSV Import Preferences.

CSV Decimal Delimiter | Select whether you want to use a period or a comma as the default decimal mark in numbers in the CSV files you import. For more information, see the help topic Setting CSV Import Preferences.

**Defaults**

Use Multicurrency Expense Reports | In accounts with the Multiple Currencies feature enabled, check this box for expense reports to enable use of foreign currencies by default. When this option is enabled, the Use Multi Currency box on Expense Report transactions is checked by default.

Download PDF Files | Check this box if you use PDF forms and save them as files. Clear the box if you use HTML forms, or if you print PDF forms without saving them as files.

Address Mapping Type | Select a service for generating maps for addresses on forms and records. You can click the Map icon next to an address on a form or record to see the map. For more information, see Mapping Addresses on Records and Transactions.

Show Internal IDs | Check this box to be able to view the internal IDs for fields and records in the NetSuite application.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The Show Internal IDs field is only available when at least one of the following features is enabled in your account: Client SuiteScript, Server SuiteScript, SuiteScript Server Pages, SuiteFlow, or Web Services (on the SuiteCloud tab) or Advanced Site Customization or SuiteCommerce Advanced (on the Web Presence tab). For more information, see the help topic Enabling Features.</td>
<td></td>
</tr>
<tr>
<td>SOAP web services and SuiteScript code need to reference internal IDs to uniquely identify objects, so you should enable this preference whenever you are working with SOAP web services or SuiteScript. When this preference is enabled:</td>
<td></td>
</tr>
<tr>
<td>■ You can view the internal ID for a field by clicking on that field's label to open the field level help popup window. The internal ID is displayed in the lower right corner of this window.</td>
<td></td>
</tr>
<tr>
<td>■ You can view the internal ID for a record or a custom field in an Internal ID column that displays on a list or search results page for that type of record or custom field.</td>
<td></td>
</tr>
<tr>
<td>Only Show Last Subaccount</td>
<td>Check this box to indent subaccounts in list fields on transactions and forms. For example, with the box checked, subaccounts appear indented under the parent account: Parent account Subaccount 1 Subaccount 2 With the box cleared, subaccount names include the parent name: Parent account Parent account: Subaccount 1 Parent account: Subaccount 2</td>
</tr>
<tr>
<td>Only Show Last Subentity</td>
<td>Check this box to indent subrecords in dropdown lists on transactions and forms. This applies to relationship records, such as customers, partners and leads. For example: Parent customer Subcustomer 1 Subcustomer 2 When the box is cleared, subentity record names include the parent name: Parent customer Parent customer: Subcustomer 1 Parent customer: Subcustomer 2</td>
</tr>
<tr>
<td><strong>Note:</strong> When records display in popup lists, subentity names always include the parent name.</td>
<td></td>
</tr>
<tr>
<td>Only Show Last Subitem</td>
<td>Check this box to show only subitems and omit parent items in dropdown lists on transactions and forms. For example:</td>
</tr>
<tr>
<td>Field Name</td>
<td>Function</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Subitem 1</td>
</tr>
<tr>
<td></td>
<td>Subitem 2</td>
</tr>
<tr>
<td></td>
<td>When the box is cleared, subitem names include the parent name:</td>
</tr>
<tr>
<td></td>
<td>Parent item</td>
</tr>
<tr>
<td></td>
<td>Parent item: Subitem 1</td>
</tr>
<tr>
<td></td>
<td>Parent item: Subitem 2</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When records display in popup lists, subitem names always include the parent name.</td>
</tr>
</tbody>
</table>

### Messages

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Warnings</td>
<td>Check this box to see a warning when you are about to leave a page before submitting the transaction you were working on.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This is only available for the Internet Explorer browser.</td>
</tr>
<tr>
<td>Limit CC Field to Contacts &amp; Employees</td>
<td>Check this box so that email messages are only copied to contacts or employees.</td>
</tr>
<tr>
<td>Default Issue Email Notification</td>
<td>Select one of the following options to be notified at your login email address when an issue you have submitted or edited changes:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong> – Select this option if you do not want to receive any email notifications about changes to issue statuses.</td>
</tr>
<tr>
<td></td>
<td>- <strong>On Any Change</strong> – Receive an email every time someone edits the issue record.</td>
</tr>
<tr>
<td></td>
<td>- <strong>When Base Status is Open</strong> – Receive an email when the issue status changes to a base status of Open.</td>
</tr>
<tr>
<td></td>
<td>- <strong>When Base Status is On Hold</strong> – Receive an email when the issue status changes to a base status of On Hold.</td>
</tr>
<tr>
<td></td>
<td>- <strong>When Base Status is Resolved</strong> – Receive an email when the issue status changes to a base status of Resolved.</td>
</tr>
<tr>
<td></td>
<td>- <strong>When Base Status is Closed</strong> – Receive an email when the issue status changes to a base status of Closed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you set issue notification preferences via the Customer Center, these return to company default settings if your Customer Center access is suspended.</td>
</tr>
<tr>
<td>Notify Me Upon Issue Assignment</td>
<td>Check this box to receive a notification at your login email address when an issue is assigned to you.</td>
</tr>
</tbody>
</table>

### Optimizing NetSuite

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay Loading of Sublists</td>
<td>Check this box to delay loading information on subtabs until you click the specific subtab.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Setting this preference improves page-load times.</td>
</tr>
<tr>
<td>Number of Rows in List Segments</td>
<td>Enter the maximum number of records to display in each segment.</td>
</tr>
</tbody>
</table>
### Table: General Personal Preferences

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field Name</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>For example, if you have 200 customers, then enter 25 in this field to see them in groups of 25 per page.</td>
<td>To navigate through the list of results, select from the dropdown list or use the previous and next arrows on the toolbar. You can alter this amount of higher or lower depending on your visual and scrolling preferences.</td>
</tr>
<tr>
<td>Note:</td>
<td>Setting the list segment to 25 or less improves page-load times.</td>
</tr>
<tr>
<td>Maximum Entries in Dropdowns</td>
<td>Enter a number beyond which a dropdown list becomes a popup list. When the list reaches the maximum you set here, the list displays in a pop up window. Be aware that the number you place here is a guideline. If the list of values displayed for a field is dynamic, a popup may be used even for a smaller number of values. The use of a popup is especially likely for any custom field with values sourced from a dynamic list because the size of the list could sometimes be above the maximum.</td>
</tr>
<tr>
<td>Note:</td>
<td>Setting the maximum entries to 25 or less improves page-load times.</td>
</tr>
<tr>
<td>Note:</td>
<td>The Case/Task/Event field for time transactions is displayed as a dropdown list only if the sum of all company-wide case, task, and event records is less than 5000 and less than the number entered here. Roles that can enter time transactions on behalf of other employees will always have a pop-up field displayed.</td>
</tr>
<tr>
<td>Type-Ahead On List Fields</td>
<td>When you check this box, NetSuite displays a list of matching records you can select from when you type characters into a dropdown list field. This preference may enable you to enter data into list fields more quickly.</td>
</tr>
<tr>
<td>Require Exact Match on Item Type-Ahead</td>
<td>When you turn on the Type-Ahead On List Fields option (above), check this box so that NetSuite selects a record based on an exact match of the characters you type. Otherwise, NetSuite chooses a record based on the first character you typed.</td>
</tr>
<tr>
<td>Show Quick Add Row on Lists</td>
<td>Check this box to use quick add on lists that can be edited inline. Quick add enables you to create new records from lists and only add basic information. You can turn this preference off on individual lists.</td>
</tr>
<tr>
<td>Display Bounce Warnings on Campaigns</td>
<td>Clear this box to restrict the automatic scanning of hard-bounced email addresses in your marketing campaign. When this preference is turned off, you can manually screen hard-bounced email addresses.</td>
</tr>
</tbody>
</table>
| Prefer Native Select Fields over NS Dropdowns In Internet Explorer. | **Important:** This field is only for users of the Internet Explorer browser. Select this box to use native dropdown lists rendered by your Internet Explorer browser rather than dropdown lists rendered by the NetSuite user interface. This can improve page performance, particularly on pages with many dropdown lists. Page performance varies due to the interaction of many factors, including:  
  - the type and complexity of the page  
  - whether the page has been customized  
  - the number and type of features enabled in an account  
  If you continue to experience less-than-optimal page performance even with this option selected, please contact Technical Support.                                                                                       |
### General Personal Preferences

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SuiteCloud Development Framework</strong></td>
<td></td>
</tr>
<tr>
<td>Show App ID Field</td>
<td>Check this box to display the App ID field on custom objects that are supported by SDF.</td>
</tr>
<tr>
<td>Show ID Field on Sublists</td>
<td>Check this box to display script ID fields in sublists that are supported by SuiteCloud Development Framework.</td>
</tr>
</tbody>
</table>

### Choosing a Language for Your NetSuite User Interface

With the Multi-Language feature, you can choose the language in which NetSuite displays whenever you log in to your account.

This preference is available only if an account administrator has enabled the Multi-Language feature at Setup > Company > Setup Tasks > Enable Features, on the Company subtab.

**To set your language preference:**

1. Go to Home > Set Preferences.
2. On the **General** subtab, in the Localization section, **Language** field select a language. The following choices are supported:
   - Chinese (Simplified)
   - Chinese (Traditional)
   - Czech
   - Danish
   - Dutch
   - English (AU)
   - English (CA)
   - English (International)
   - English (UK)
   - English (U.S.)
   - Finnish
   - French
   - French (Canada)
   - German
   - Indonesian
   - Italian
   - Japanese
   - Korean
   - Norwegian
   - Portuguese (Brazilian)
   - Russian
   - Spanish
   - Spanish (Latin America)
   - Swedish

---

NetSuite Basics
Thai
Turkish
Vietnamese

**Important:** For the languages listed above, NetSuite provides translation strings for the user interface and for printed transaction forms. The Multi-Language feature also supports the use of several additional languages for website translations, but these languages must be defined in company preferences and translation strings must be provided. See the help topic **Configuring Multiple Languages**.

3. In the **Language for the Help Center** field, you can select a different language for the Help Center.

   The following languages are available:
   - 简体中文 (Chinese Simplified)
   - Deutsch (German)
   - English
   - 日本語 (Japanese)
   - Español (Spanish)

   **Note:** You can also set this preference directly from the NetSuite Help Center using the dropdown list at the top right corner of the page.

For more information, see **Using the Help Center Window**. Whether you select the language preference directly in the Help Center or from Home > Set Preferences, the preference is maintained until you change it.

4. Click **Save**.

This preference does not affect others with access to your account. For the best results when viewing translated NetSuite pages, set your browser to view UTF-8 encoded pages.

- In Internet Explorer, go to View > Encoding > Auto-Select.
In Firefox, go to Tools > Options, and in General options, click Languages. In the Default Character Encoding field, select Unicode (UTF-8).

Mapping Addresses on Records and Transactions

You can quickly view maps for addresses on records and transactions by clicking the Map links.

To select the mapping website to use to display maps, go to Home > Set Preferences. In the Address Mapping Type field on the General subtab under Defaults, select whether to open maps in Google Maps, Yahoo! Maps, or Mapquest.

**Note:** There is also a Custom option; if you select this option, the mapping type set by the account administrator for each country is used. For information about setting address mapping types for different countries, see the help topic Supported Countries.

This feature is especially useful for:

- Deliveries
- Door-to-door sales campaigns
- Service calls
- Contacting hard-to-reach customers, contacts or employees

Transactions or records with address fields have a Map link next to the address. After you fill in the street address, city, state, zip code and country fields on records, you can click the icon to view a map of the address location. This map opens in a new window, where you can zoom in or out for a bigger picture or more detail, and you can print step-by-step driving directions to this address from any location.

The Map link shows on transactions next to Bill To and Ship To fields. On records, the icon shows next to Billing Address and Shipping Address fields.

When viewing a record, click the text of the underlined address to view the map. When you are finished viewing your map or driving directions, close the map window to return to NetSuite.

Personal Preferences for Appearance

Go to Home > Set Preferences and click the Appearance subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors</td>
<td></td>
</tr>
<tr>
<td>Color Theme</td>
<td>Select a color theme for your NetSuite pages and tabs. Select a color and click Save to determine how the scheme looks on your monitor. Although you can't modify or add new color themes, some special themes are available in certain editions of NetSuite in addition to the basic color themes.</td>
</tr>
<tr>
<td></td>
<td>- The US edition has color themes for schools (various colleges and universities) organized by conference.</td>
</tr>
<tr>
<td></td>
<td>- The Canadian edition has color themes for National Hockey League (NHL) teams.</td>
</tr>
<tr>
<td></td>
<td>- The UK edition has color themes for Premier League clubs.</td>
</tr>
</tbody>
</table>
## Personal Preferences for Appearance

### Field Name | Function
---|---
| **Note:** If the Accessibility preference for displaying a theme with optimal color contrast is checked, the Color Theme preference is disabled.

### Styles

**Screen Font**
Open Sans is the default font for NetSuite. You may select a different font from the Screen Font dropdown list. Your selection changes the font on your pages only and only for your current role. It does not affect any forms or your website.

**Note:** To change the size of the font, use your browser zoom controls.

**Compensate for Large Fonts**
Displays easier-to-read layouts if you have set your computer display to use large fonts.

**Register Look on Lists**
Check this box to display lists of records and transactions as registers. This setting applies shading every other row in your list, making it easier to read.

**Density Setting for Internet Explorer**
Select the density of your NetSuite pages. This setting is for Internet Explorer 10 and higher. The options are:
- **Normal** – 100% zoom
- **Higher Density** – similar to 80% zoom
- **Very High Density** – similar to 67% zoom

Other browsers, such as Chrome and Firefox, enable you to set the zoom independently for each website.

### Chart Themes

**Chart Theme**
Defines a default appearance for data in all dashboard charts. (Can be overridden in individual portlets.) Options are:
- **Basic** – provides limited color contrast (the default)
- **Colorful** – provides more color contrast
- **Match Color Theme - Bold** – harmonizes with your choices in the Colors section, using bolder shades
- **Match Color Theme - Light** – harmonizes with your choices in the Colors section, using lighter shades

A thumbnail is displayed to represent the look of each Chart Theme option.

**Chart Background**
Defines a default display behind data in all dashboard charts. (Can be overridden in individual portlets.) Options are:
- **Lines** (the default setting)
- **Bands**
- **Grid**

### Centers & Dashboards

**Use Classic Interface**
Check this box to use the Classic Center as your NetSuite interface. When you enable this option, you see the same tabs in NetSuite that the Administrator role does.

**Note:** This option does not appear when using an Administrator role.

If all users enable this option, they all can see the same tabs and use the same navigation paths.
### Personal Preferences for Appearance

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landing Page</td>
<td>Select the tab that you want to be the first page displayed when you log into your NetSuite account. If you do not make a selection in this dropdown list, your Home page is the initial landing page. The list of possible landing pages includes all standard tabs and custom tabs in your center. The page you select here is overridden if your account administrator sets the general company Landing Page preference to use a custom landing page created by a Suitelet.</td>
</tr>
<tr>
<td>Show Portlet Hint</td>
<td>Check this box to display a popup notice when slow-loading dashboard portlets time out during dashboard loading. To improve page load time on the dashboard, minimize the slow-loading portlets.</td>
</tr>
<tr>
<td>Set Customer Dashboard as Default View on Customer Record</td>
<td>Check this box to set the customer dashboard view as the default view on customer records.</td>
</tr>
<tr>
<td><strong>Entry Forms</strong></td>
<td></td>
</tr>
<tr>
<td>Limit Entry Forms to Two Columns</td>
<td>Check this box to limit the columns of fields on entry forms to two columns. By default, fields on entry forms are arranged in three columns.</td>
</tr>
<tr>
<td>Expand Tabs on Entry Forms</td>
<td>Check this box to expand tabs on your NetSuite pages.</td>
</tr>
<tr>
<td>Enable Rich Text Editing</td>
<td>Check this box to use the rich text editor in text fields. Each field includes the Formatted Text header with a link you can click to enter HTML Source Code. The Formatted Text header includes Font, Size, and Color dropdown lists, and a toolbar with text style, alignment, and paragraph format options. Use these tools to format text you enter into the field. Clear the box to remove the Formatted Text header on text fields.</td>
</tr>
<tr>
<td>Default Rich Text Editor Font</td>
<td>Select the default font for rich text editor fields.</td>
</tr>
<tr>
<td>Default Rich Text Editor Font Size</td>
<td>Select the default font size for rich text editor fields.</td>
</tr>
<tr>
<td><strong>Accessibility</strong></td>
<td></td>
</tr>
<tr>
<td>Display Default Theme with Optimal Color Contrast</td>
<td>Check this box to display a theme with optimal contrast that can aid users with low vision to view the UI.</td>
</tr>
</tbody>
</table>

**Note:** If this preference is selected, the Color Theme preference is disabled.

### Personal Preferences for Transactions

Go to Home > Set Preferences and click the Transactions subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.
### Personal Preferences for Transactions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Fill Transactions</td>
<td>Check this box to automatically enter information on transaction pages based on the last transaction for the entity you select.</td>
</tr>
<tr>
<td></td>
<td>When you clear this box, you can use the Auto Fill button on transaction pages to automatically enter information.</td>
</tr>
<tr>
<td>Alphabetize Items Regardless of Type</td>
<td>Check this box to list items in alphabetical order, regardless of item type, on transactions such as Sales Orders, Purchase Orders, and Inventory Adjustments.</td>
</tr>
<tr>
<td></td>
<td>Clear this box to display items listed on transactions grouped by item type, and within each item type, listed in alphabetical order.</td>
</tr>
<tr>
<td><strong>Warnings</strong></td>
<td></td>
</tr>
<tr>
<td>Duplicate Number Warnings</td>
<td>Choose from the list how NetSuite responds when you enter a document number you've used before.</td>
</tr>
<tr>
<td>Inventory Level Warnings</td>
<td>Check this box to see warnings when you sell inventory items with quantities at or below their reorder points.</td>
</tr>
<tr>
<td></td>
<td>You must also set these minimum quantities in the Reorder Point field on item records at Lists &gt; Items.</td>
</tr>
<tr>
<td>Customer Credit Limit Handling</td>
<td>Select your preferred method for handling customer credit limits:</td>
</tr>
<tr>
<td></td>
<td>▪ Ignore – Enables you to enter sales orders and invoices that exceed the customer’s credit limit without a warning.</td>
</tr>
<tr>
<td></td>
<td>▪ Warn Only – Generates a warning when you enter a sales order or invoice that exceeds the customer’s credit limit. The warning displays in a dialog box so you can choose to enter or cancel the transaction.</td>
</tr>
<tr>
<td></td>
<td>▪ Enforce Holds – Blocks you from entering a sales order or invoice that exceeds the customer’s credit limit.</td>
</tr>
<tr>
<td>Vendor Credit Limit Warnings</td>
<td>Check this box to receive a warning when you exceed the credit limit for a vendor.</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Print Using HTML</td>
<td>Check this box to print transaction forms in HTML format.</td>
</tr>
<tr>
<td></td>
<td>Clear this check box if you prefer to print transactions forms in PDF format. Printing PDF forms requires Acrobat Reader.</td>
</tr>
<tr>
<td>Transaction Email Attachment Format</td>
<td>Choose the format for which transaction email attachments are sent.</td>
</tr>
<tr>
<td></td>
<td>▪ HTML – Sends email attachments in HTML format.</td>
</tr>
<tr>
<td></td>
<td>▪ PDF – Sends email attachments in PDF format.</td>
</tr>
<tr>
<td>Horizontal Print Offset</td>
<td>Enter a positive number in inches to move the text to the right. Enter a negative number in inches to move the text to the left.</td>
</tr>
<tr>
<td>Vertical Print Offset</td>
<td>Enter a positive number in inches to move the text lower. Enter a negative number in inches to move the text higher.</td>
</tr>
</tbody>
</table>

Your administrator can customize the layout of your printed forms using advanced PDF/HTML templates. For information, see the help topic [Advanced PDF/HTML Templates](#).
Analytics Personal Preferences

Go to Home > Set Preferences and click the Analytics subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting</td>
<td></td>
</tr>
<tr>
<td>Report by Period</td>
<td>Select what type of reports you want to view by period.</td>
</tr>
<tr>
<td><strong>All Reports</strong></td>
<td>Select this option to view all applicable reports by period. When this option is selected, reports that support reporting by period include a period filter in the report footer.</td>
</tr>
<tr>
<td><strong>Financials Only</strong></td>
<td>Select this option if you want specific financial reports reported by period. For a list of these financial reports, see Report by Period: Financials Only Reports.</td>
</tr>
<tr>
<td><strong>Never</strong></td>
<td>Select this option if you do not want to exclude reports that can be run in both by date and by period mode.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>When you select Financials Only or Never, you may encounter problems with data for KPI scorecards that use accounting periods.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In OneWorld accounts, if you post transactions with dates outside posting periods, best practice is to run all reports by period. Select All Reports.</td>
</tr>
</tbody>
</table>

This option requires the Accounting Periods feature to be enabled. For details, see the help topic Accounting Period Management.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Reports in Grid</td>
<td>Check this box to show reports in the grid.</td>
</tr>
<tr>
<td>Customize Font on Financial Reports</td>
<td>Check this box to be able to configure the font settings on custom financial reports.</td>
</tr>
<tr>
<td>Print Company Logo</td>
<td>Check this box to include your company logo on all printed reports.</td>
</tr>
<tr>
<td>Display Report Title on Screen</td>
<td>Check this box to display the report title, company name, and date or period range at the top of all reports displayed on your screen. Even when this preference is not enabled, this title information still prints on reports.</td>
</tr>
<tr>
<td></td>
<td>To display report title information only on selected reports, do not check this box. Instead, click Options in the footer of each report, and check the Display Title box.</td>
</tr>
<tr>
<td>Display Report Description</td>
<td>Check this box to display customization details as part of report title for all reports. These details are from the Description field in the More Options step of the Report Builder.</td>
</tr>
<tr>
<td></td>
<td>To disable the display of customization details for selected reports, click Options in the footer of each report, and clear the Print Description box.</td>
</tr>
<tr>
<td>Default Bank Account</td>
<td>Select the bank account to use as the default account for the Bank Register listed on the Reports page and the Bank Balance snapshot on the Home page.</td>
</tr>
<tr>
<td>Calculate Forecasts as Weighted</td>
<td>Check this box to show the weighted forecast value instead of total projected forecast values on reports.</td>
</tr>
</tbody>
</table>
### Field Name | Function
--- | ---
**Analytics Personal Preferences**<br>**You can set this preference at both Home > Set Preferences, and at Setup > Sales > Sales Preferences, on the Forecasts subtab. The setting you select for this preference on the Set Preferences page overrides the company wide setting for this preference on the Sales Preferences page.**

### Search

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show List When Only One Result</strong>&lt;br&gt;Check this box to list search results, even when there is only one result. If you clear this box and there is only one result from a search, the record or transaction automatically opens.</td>
<td></td>
</tr>
<tr>
<td><strong>Quick Search Uses Keywords</strong>&lt;br&gt;Check this box so that the Quick Search portlet returns records with names that <em>start with</em> AND records with names that <em>contain</em> the keywords you enter.&lt;br&gt;<strong>If you clear this box, the Quick Search portlet displays Starts With and Contains buttons. Searches can return records with names that start with keywords OR records with names that contain keywords, based on the button you select.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Popup Search Uses Keywords</strong>&lt;br&gt;You use popup searches when you type a keyword and press TAB to make a selection in a field on a transaction or form.&lt;br&gt;Check this box to base search results for popup lists only on keywords that start with and include all the search terms entered.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Enabling this preference removes the Starts With and Contains options from the Quick Search portlet.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Include Inactives in Global &amp; Quick Search</strong>&lt;br&gt;Check this box to include inactive records in results returned for keywords entered in the Search field or in the Quick Search portlet.&lt;br&gt;By default, only active records and transactions are searched with these fields.</td>
<td></td>
</tr>
<tr>
<td><strong>Popup Auto Suggest</strong>&lt;br&gt;Check this box to have NetSuite suggest matches for the text you enter in fields as you type. You can select from the list of matching records to select the record you need.</td>
<td></td>
</tr>
<tr>
<td><strong>Global Search Auto Suggest</strong>&lt;br&gt;This box is checked by default. NetSuite suggests matches for the text you enter in the Search field, automatically as you type. You can select from the list of suggested records to go directly to the record you need.</td>
<td></td>
</tr>
<tr>
<td><strong>Global Search Sort by Name/ID</strong>&lt;br&gt;Check this box to sort global search results by name, instead of by record type and then by name within each record type.</td>
<td></td>
</tr>
<tr>
<td><strong>Global Search Customer Prefix Includes Leads and Prospects</strong>&lt;br&gt;By default this box is cleared, and when you type the <em>cu</em> prefix in the Search field, only customer records display in search results.&lt;br&gt;Check this box to display leads, prospects, and customers in your search results when you type the <em>cu</em> prefix in the Search field.</td>
<td></td>
</tr>
<tr>
<td><strong>Global Search Includes Transaction Numbers</strong>&lt;br&gt;By default, when searching for a number in Global Search, the search results only include results by document number.&lt;br&gt;When this box is checked, search results include results whose document number AND transaction number match the number searched.</td>
<td></td>
</tr>
</tbody>
</table>

### PDF

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PDF Page Orientation</strong>&lt;br&gt;Select landscape or portrait orientation for your PDF output when you export a report or search results as a PDF.</td>
<td></td>
</tr>
<tr>
<td><strong>PDF Font Size</strong>&lt;br&gt;Select a font size for the PDF output when you choose to export a report or search results as a PDF.</td>
<td></td>
</tr>
</tbody>
</table>

### Export
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSV Export Character Encoding</td>
<td>Select an alternate character encoding for CSV exports of lists, reports, and searches. Default encoding is UTF-8. Other options are Windows 1252, the default format for Microsoft Excel, and Shift-JIS, the most widely used format in Japan.</td>
</tr>
<tr>
<td>KPI and Snapshot</td>
<td></td>
</tr>
<tr>
<td>Accounting Book</td>
<td>If you use the Multi-Book Accounting feature, select the Accounting Book you would like to use for reporting.</td>
</tr>
<tr>
<td>KPI Scorecard with Period Specific Consolidation Rates</td>
<td>Select the accounting period that provides the consolidation rates you would like to use in the KPI Scorecard report.</td>
</tr>
<tr>
<td></td>
<td>The following KPIs are affected by the period consolidation rates you select:</td>
</tr>
<tr>
<td></td>
<td>- Bank Balance</td>
</tr>
<tr>
<td></td>
<td>- Credit Card Balance</td>
</tr>
<tr>
<td></td>
<td>- Receivables</td>
</tr>
<tr>
<td></td>
<td>- Payables</td>
</tr>
<tr>
<td></td>
<td>- Other Current Assets</td>
</tr>
<tr>
<td></td>
<td>- Other Current Liabilities</td>
</tr>
<tr>
<td>Note:</td>
<td>If Multi-Book Accounting is provisioned in your NetSuite OneWorld account, the accounting book selected on the user preference reflects the accounting book currency.</td>
</tr>
<tr>
<td></td>
<td>This preference has no affect on standard KPIs.</td>
</tr>
<tr>
<td></td>
<td>This preference is available for all NetSuite user roles.</td>
</tr>
</tbody>
</table>

Report by Period: Financials Only Reports

The following is a list of financial reports that properly execute when the Report by Period preference is set to Financials Only:

- Account Detail
- Balance Sheet
- Balance Sheet Detail
- Budget Income Statement
- Budget Income Statement Detail
- Budget vs. Actual
- Cash Flow Statement
- Cash Statement
- Cash Statement Detail
- Comparative Balance Sheet
- Comparative Income Statement
- Deferred Revenue By Customer
- Deferred Revenue By Item
- Deferred Revenue By State
- Deferred Revenue Reclassification
Deferred Revenue Rollforward By Customer Summary
Deferred Revenue Rollforward Summary
Deferred Revenue Rollforward Transaction Details
Financial Layout Description
General Ledger
GL Audit Numbering
GST on Purchases Detail
GST on Purchases Summary
GST on Sales Detail
GST on Sales Summary
Income Statement
Income Statement Detail
Realized Exchange Rate Gains and Losses
Revenue By Customer
Revenue By Item
Revenue By State
Trial Balance
Unrealized Exchange Rate Gains and Losses
VAT on Purchases Detail
VAT on Purchases Summary
VAT on Sales Detail
VAT on Sales Summary

Note: If you have enabled the GL Audit Numbering feature, select Financials Only to filter the GL Audit Numbering Report by accounting period.

Personal Preferences for Activities

Set your personal preferences before you start working with your calendar, and activities such as phone calls and tasks. Here, you can set preferences for sending email invitations, types of reminders, and more. You can also set a default priority for tasks and phone calls. If you use the Outlook Integration feature to synchronize records, you can set a default category for contacts synchronized between Outlook and NetSuite.

Go to Home > Set Preferences, and click the Activities subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar</td>
<td></td>
</tr>
<tr>
<td>Edit Activities from Calendar</td>
<td>Check this box to open events in Edit mode when you click events on your calendar.</td>
</tr>
<tr>
<td>Send Invitation Emails</td>
<td>Select recipients for email notification about events.</td>
</tr>
<tr>
<td></td>
<td>- Internally - Send email only to employees and groups of employees in your NetSuite account.</td>
</tr>
</tbody>
</table>
### Field Name | Function
--- | ---
To All Invitees | Send email to everyone invited to the event, including customers, contacts, partners, etc.

Restrict Invitees to Employees | Check this box to choose only employees as invitees on event records.

Default Event Access Setting For New Events | Choose an option for Event Access.

- **Public** - Anyone can see public events, tasks, and calls.
- **Private** - Only you and your account administrator can see events, tasks, and calls you mark as private. Other invitees with access to your calendar can also see private events.
- **Show as Busy** - Events marked to show as busy show on your calendar as unavailable time. The details of these events cannot be seen by anyone except you and your account administrator.

Default Reminder Type | Specify the type of event reminder that you prefer:

- **None** - Select this option if you do not want to receive reminders about your calendar events.
- **Popup Window** - Select this option if you want to receive calendar reminders in a popup window.
- **Email** - Select this option if you want calendar reminders emailed to you.

Default Reminder Time | Select the amount of time before an event when you prefer to receive reminders.

Play Audio with Popup Event Reminders | Check this box to play a sound with popup event reminders. You must have your browser set to play sounds in websites.

### Tasks & Phone Calls

Default Priority for Tasks | Select a default priority for new tasks. Priority options include **Low**, **Medium**, and **High**.

You can change the priority for a task in the Priority field on the task record.

Default New Tasks Public | Check this box to make all new tasks public by default.

You can mark a task private by checking the Private Task box on the task record.

Default New Phone Calls Public | Check this box to make all phone calls you create public by default.

### Sync

Default Sync Category | Select the category you want contacts to sync to by default.

---

### Personal Preferences for Alerts

Go to Home > Set Preferences, and click the Alerts subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role. For more information about setting preferences for email alerts, see NetSuite Basics.
**Receiving Email Alerts.** For more information about subscribing to email alerts, see the help topic Enabling Saved Search Email Alerts.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Selection</td>
<td>Select an initial time to receive an email message containing the latest information about the events, reminders, key performance indicators, and report snapshots displayed in portlets on your Home page.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>By default, this value is set to 12:00 am. If you do not want to receive the email alerts, you can change this value to be blank.</td>
</tr>
<tr>
<td>Second Selection</td>
<td>Select an second time to receive an email message containing the latest information about the events, reminders, key performance indicators, and report snapshots displayed in portlets on your Home page.</td>
</tr>
<tr>
<td>Third Selection</td>
<td>Select a third time to receive an email message containing the latest information about the events, reminders, key performance indicators, and report snapshots displayed in portlets on your Home page.</td>
</tr>
<tr>
<td>Include links in HTML Alerts</td>
<td>Check this box to include links to key performance indicators and reminders included in your alert email.</td>
</tr>
<tr>
<td></td>
<td>When you click a link, a browser window opens where you can log in to NetSuite and view the report for that key performance indicator or reminder.</td>
</tr>
<tr>
<td></td>
<td>You must also have the Email Using HTML box checked on the Transactions subtab of the Set preferences page to include links.</td>
</tr>
<tr>
<td>Respect Quick Date Portlet Settings</td>
<td>Check this box so that email alert results are based on the date specified in your Dashboard View filter.</td>
</tr>
<tr>
<td></td>
<td>Clearing the box sends email alert results based on a different date.</td>
</tr>
<tr>
<td>E-Mail</td>
<td>Select an email address to which email alerts should be sent.</td>
</tr>
<tr>
<td>Send an On-Demand Alert from this Role</td>
<td>Check this box to enable on-demand alerts. On-demand alerts enable you to send email to <a href="mailto:alerts@alerts.netsuite.com">alerts@alerts.netsuite.com</a> or to reply to an alert email and receive an email from NetSuite with the contents of your dashboard to your login email address.</td>
</tr>
<tr>
<td>Click Here to send a test email message to &lt;your email&gt;.</td>
<td>Click the link to send a test message to the specified email address.</td>
</tr>
</tbody>
</table>

**Note:** When you remove an Activities, Reminders, Key Performance Indicators, or Report Snapshot portlet from your home page, alert emails no longer include information from the portlet you removed.

**Receiving Email Alerts**

On the Alerts subtab of the Set Preferences page, you can choose to receive two different sorts of email alerts:

- You can choose to receive a Daily Facts email alert up to three times a day. This standardized message summarizes the latest information in the Events, Reminders, Key Performance Indicators, and standard Report Snapshots portlets on your Home page, if these portlets are visible and not minimized on your dashboard. Note that these messages do not include data from custom and sales management report snapshots.
Important: The Daily Facts email alert does not include contents from portlets that are minimized on your dashboard or not showing on your dashboard.

You can also email alerts@alerts.netsuite.com from the email address you use to log in and automatically receive an email alert.

- You can choose to receive email updates when information in one or more of your most important saved searches changes.

To set up email alerts:

1. Go to Home > Set Preferences.
2. Click the Alerts subtab.
3. Choose the times of day you want to receive your three email alerts.
   - If you do not want to receive any of these email alerts, change the value for the First Selection dropdown list to be blank.
4. Check the Include Links in HTML Alerts box to enable you to click links in email alerts and open your account to the relevant information.
5. Check the Send an On-Demand Alert from the Role box to enable you to send email to alerts@alerts.netsuite.com and automatically receive your email alerts.
   - You must send email to this address from the email account you use to log in to NetSuite.
6. To receive email alerts when saved search data changes, select the record type that search is based on in the Record Type field.
7. In the Search field, select the name of the saved search.
   - A search must have the Available as Alert box checked to appear in this list. Only Administrators can set searches to be available as alerts.
   - For information about how saved searches are made available for alerts, see the help topic Enabling Saved Search Email Alerts.
8. Check the Send on Update box if you want to receive alerts both when new records are added and when current records are updated.
9. Click Add/Edit.
10. Repeat steps 6 – 9 to add up to five saved searches.
11. Click Save.

You will now receive email alerts at the times you set.

Personal Preferences for Telephony

The Telephony subtab appears on the Set Preferences page only if you use the Telephony Integration feature.

To enable the feature an administrator must go to Setup > Company > Enable Features. On the SuiteCloud subtab, in the Integration Add-Ons section, check Telephony Integration, and click Save.

Go to Home > Set Preferences and click the Telephony subtab to set any of the preferences in the following table.

The following fields are available, based on the features in your NetSuite account, and the permissions associated with your NetSuite role.
### Personal Preferences for Telephony

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Telephony Option</strong></td>
<td>Select TAPI to use Telephony Integration with a TAPI-enabled phone or software for TAPI integration, such as Artisoft’s TeleVantage. Select CTI to use a NetSuite partner, 8x8 or Five9, for integration.</td>
</tr>
<tr>
<td><strong>TAPI Device</strong></td>
<td>Enter the name of the TAPI device you use to connect your phone to your computer.</td>
</tr>
<tr>
<td><strong>CTI URL</strong></td>
<td>Enter the URL for the CTI partner with whom you have an account.</td>
</tr>
<tr>
<td><strong>Prefix to Dial Out</strong></td>
<td>Enter any numbers that should be dialed before the number in a phone number field. For example, you may need to dial 9 or 1 before you dial out of your phone system.</td>
</tr>
</tbody>
</table>

If you are using TAPI for telephony integration, follow the additional instructions listed on the Telephony subtab of the Set Preferences page to set up your phone and install the proper drivers.

For more information about using telephony integration, see the help topic Using Telephony Integration.

### Personal Preferences for Restricting Views

Click the **Restrict View** subtab of the Set Preferences page to limit your access to information for the specific class, location, department, or subsidiary you select. The restrictions apply only for the duration of your current session. The next time you log in, your original settings will be restored.

**Important:** If you use NetSuite OneWorld, some reports do not support consolidation and can return results for only one subsidiary at a time. Before you can run one of these reports, you must set your user preferences to restrict your view to a single subsidiary. Some standard reports return errors when you attempt to run them before setting this preference.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subsidiary</strong></td>
<td>(NetSuite OneWorld accounts only) Restrict your access to those records from the subsidiary you select. The restrictions apply to the user interface, searches, and reports for the duration of your current session.</td>
</tr>
<tr>
<td><strong>Include Sub-Subsidiaries</strong></td>
<td>(NetSuite OneWorld accounts only) Check this box to include records from child subsidiaries, in addition to the selected parent subsidiary for the current login session. When you select your root subsidiary above, it does not make sense to check this box. Records from all the sub-sub-subsidiaries are available by default.</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>Restrict your access to those records from the department you select. The restrictions apply to the user interface, searches, and reports for the duration of your current session. The next time you log in, your original settings will be restored.</td>
</tr>
<tr>
<td><strong>Include Sub-Departments</strong></td>
<td>Check this box to include records from sub-departments of the selected department for this session.</td>
</tr>
</tbody>
</table>

*NetSuite Basics*
## Personal Preferences for Restricting Views

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Unassigned</td>
<td>Check this box to include records that do not have a designated department in this session.</td>
</tr>
<tr>
<td>Location</td>
<td>Restrict your access to those records from the location you select. The restrictions apply to the user interface, searches, and reports for the duration of your current session. The next time you log in, your original settings will be restored.</td>
</tr>
<tr>
<td>Include Sub-locations</td>
<td>Check this box to include records from sublocations of the selected location for this session.</td>
</tr>
<tr>
<td>Include Unassigned</td>
<td>Check this box to include records that do not have a designated location in this session.</td>
</tr>
<tr>
<td>Class</td>
<td>Restrict your access to those records from the class you select. The restrictions apply to the user interface, searches, and reports for the duration of your current session. The next time you log in, your original settings will be restored.</td>
</tr>
<tr>
<td>Include Sub-Classes</td>
<td>Check this box to include records from sub-classes of the selected class for this session.</td>
</tr>
<tr>
<td>Include Unassigned</td>
<td>Check this box to include records that do not have a designated class in this session.</td>
</tr>
</tbody>
</table>

For more information, see the help topics Inactivating Roles and Restrict Your Subsidiary View.
Working with Records, Transactions, and Lists

All the information you need to keep your business running smoothly is organized and stored in records in NetSuite. These records are accessible from list pages that include all records of a specified type. You can customize these lists to display various fields from each record type.

This section includes general information about working with records and lists. Transactions, which are records of financial exchanges, are also included in this section. Instructions for using specific types of records are included in the help for the functional area. To learn how the help for functional area is organized, see NetSuite Documentation Overview. This section is divided into the following subsections:

- Working with Records
- Duplicate Record Detection
- Working with Groups
- Working with Transactions
- Working with Lists

Working with Records

Through records, you keep track of all the information from your NetSuite account. You can have records of your employees, customers, vendors, items, web sites, updates, activities and so on. There are standard records provided in NetSuite for many business purposes, such as Accounts, Items, Shipping Items, Marketing Campaigns and so on. You can also create custom record types.

For example, you create a new customer record to track address, phone and email information. Then you link customer records with contact records to keep track of the individuals you do business with. You also create records for each of your financial accounts, any items you may sell, marketing campaigns, customer support cases, phone calls, events, and so on. Any information that you use to conduct business is tracked in NetSuite on a record.
For information about creating records in NetSuite, use the help topics for the specific record type. For more information, see NetSuite Record Types.

NetSuite uses transactions to record business events. Some transactions post to the general ledger while other transactions are non-posting. For more information about Transactions, see Working with Transactions.

After you create records in NetSuite, you can look at account registers, track customer activity, and receive reminders for upcoming events and phone calls. For more information about filling in the fields on a record page, see NetSuite Record Pages.

Roles and Permissions

The types of records you can view, create, and edit vary according to the roles and permissions assigned to you. Administrators control which records members of their organization can view and regulate the operations they can perform on records. For example, you may have been granted only edit permissions to a certain record type, so can update the record but not delete it or create a new one. Few users have permissions to view or edit all of the record types in NetSuite. For more information, see the help topic NetSuite Permissions Overview.

Groups

You can create groups of records to communicate with a set of individuals within your organization or other companies you do business with. For example, you can invite a group of employees to a meeting or send a marketing email blast to a group of customers. With NetSuite, you can create a dynamic group that changes based on record search results, or you can create a static group using a set of records that you select. For more information, see Working with Groups.

Lists

Lists enable you to access existing records in NetSuite. They include controls for working with the whole list and for working with individual records. For more information, see Working with Lists.

Creating a Shortcut to a Record

You can add any individual record to your shortcuts. Shortcut links appear as menu options under the star menu available on every NetSuite page, and in the Shortcuts portlet. If the Shortcuts portlet does not yet exist on your dashboard, you may be able to add it. For instructions, see the help topic Adding a Portlet to a Dashboard.

To add a shortcut from the page where you want the shortcut to go:


2. Edit name for the shortcut link. By default it is the name of the page.

3. If you want the linked page to open in a new window, check the Open in New Window box.

4. Click Save.

NetSuite Record Pages

Each NetSuite record is represented as a page in the user interface. To enter a record page, go to the Lists tab and select the relevant record type. Click Edit.
Basic data appears in fields in the upper part of the page (the record form), and more detailed data (including data from related records) is displayed in lists and fields on subtabs in the lower part of the page. The fields in the form are often grouped to keep similar or related fields together.

For information about creating records in NetSuite, use the help topics for the specific record type. For links to these topics, see NetSuite Record Types.

The following screenshot shows a sample customer record in edit mode. The asterisks indicate that the field is required. The areas of the page are identified by number:
1 The record type (Customer in this example) and ID appear at the top with buttons and links that enable you to act on the record and navigate to other records.

2 Horizontal bars divide the fields into related groups.

3 Subtabs divide the record data further. For more information, see Record Subtabs.

For technical information about the fields in a record, such as the data type or maximum field length, you can use the SuiteScript Record Browser. For more information, see the help topic Working with the SuiteScript Records Browser.

Record Subtabs

Subtabs on records enable you to enter additional information. They appear at the bottom of the record page and are called subtabs to distinguish them from the tabs at the top of the page. Subtabs may contain fields, other subtabs, sublists, and a combination of these elements. Which subtabs are included depends on the record type. For links to help topics for specific record types, see NetSuite Record Types.

Here is an example of a subtab. It is the Marketing subtab on a customer record. This subtab includes fields at the top and its own subtabs at the bottom. The selected Item Orders subtab contains a sublist, only a portion of which is shown here.

1 Primary subtab – The bold font and pointer below the label indicate that this subtab is selected. This is the Marketing subtab. Some subtabs appear on most NetSuite records:

- **Communication** – This subtab messages and files to the record. For more information, see Attaching Files to Records and Entering Communication Information on a Transaction.

- **Related Records** – This subtab lists records and transactions that are related to the current record and includes links to these related records. It often includes secondary subtabs to categorize the related records.

- **System Information** – This subtab includes a System Notes subtab that enables you to view details about changes to the record.

2 Expand Tabs button – When you click this button, the subtabs expand and are stacked vertically on the page. The header for each subtab includes a button to return the subtabs to their original tabular layout. This rollup button appears only when your pointer is in the header area.

3 Secondary subtab – The bold font and pointer below the label indicate that this subtab is selected. The dot to the right of a secondary subtab indicates that information is included in the subtab.

4 Sublist – Sublists contain references to other records. Each record in the list is referred to as a line item. Sublists often include links to the record that is referred to. You can see an example in the Item column of this sublist.
Some sublists can be edited. These sublists include buttons for working with each row of the list. For more information, see Using Buttons in NetSuite.

Record and Transaction Data Fields

Enter data on record and transaction forms using fields, boxes, and buttons. Some fields require a particular type of entry like a date or currency.

**Note:** If you are not sure which fields to include when building a report, you can use the SuiteAnalytics Connect Browser to view table summaries and domain diagrams for the most widely used domains. For more information, see the help topic Working with the Connect Browser.

Text Fields

Text fields can have only letters, numbers, and basic punctuation. You cannot enter any special characters or HTML codes in text fields.

Date Fields

Click the calendar icon next to a date field to open a popup calendar in which you can click the date. If you know the date format your company uses, you can type the date in the field. For tips, see Using Keyboard Shortcuts.

Amount Fields

Amount fields support addition, subtraction, multiplication, and division. You do not need to calculate the value before you enter it in the field. For example, John Wolfe of Wolfe Electronics wants to write a check for automobile expenses. The business spent $87.45 on gas for one catering van, and $125.36 on gas for another van. If John wants to add these expenses together in the same check, he can compute the total in the Amount field.

**To compute amounts:**

1. In the **Amount** field, type = (equal sign).
2. After the equal sign, enter numbers and the computation symbols.
   - For example, type =125.36+87.45
   - To separate actions, use parenthesis, for example, =10+10)*2.
3. Click another field on the page, or press Enter, to complete the calculation.
   - The result appears in the **Amount** field.
   - The results for the examples in step 2 appear as 212.81 and 40.00.

For more information, see Currency Field Limitations.

NetSuite Record Types

NetSuite includes record types for all areas of your business. Click the links below to learn more about each record type and how to create new records:

- **Accounting** – See the help topic NetSuite Accounting Overview.
- **Items** – See the help topic Creating Item Records.
- **Shipping Items** – See the help topic Creating Shipping Items.
  - If you use the Shipping Label Integration feature, see the help topic Shipping Integration with FedEx, UPS, and USPS/Endicia.
**Gift Certificates** – See the help topic Setting Up Gift Certificates.

**Employees** – See the help topic Adding an Employee.

**Relationships** – You can create records for different types of business relationships:
- **Leads** – See the help topic Lead Management Overview.
- **Prospects** – See the help topic Prospects.
- **Customers** – See the help topic Customers.
- **Projects** – See one of the following topics in the Help Center:
  - Creating a Basic Project Record
  - Creating a Project Record
- **Contacts** – See the help topic Contacts.
- **Groups** – See Working with Groups.
  Groups are a collection of contact, customer, employee, job, partner, or vendor records that you select. Using groups in NetSuite enables you to communicate efficiently with individuals and companies you do business with.
- **Vendor** – See the help topic Adding a Vendor Record.
- **Competitors** – See the help topic Competitors.
- **Other Names** – See the help topic Other Name Records.

**Commissions** – See the help topic Commissions.

**Marketing** – See the help topic Marketing Automation Overview.

**Support Management** – See the following topics in the Help Center:
- Setting Up Case Management
- Issue Management
- Knowledge Base

**Web Site** – See the following topics in the Help Center:
- Site Builder Items, Forms, & Images
- Site Builder Tabs & Categories
- Setting Up Items for the Web Site

**Search** – See the help topic Defining a Saved Search.

**Mass Updates** – See the help topic Mass Changes or Updates.

**Custom** – See the help topic Creating Custom Record Types.

**Activities** – NetSuite enables you to create records to keep track of your business activities. See the following Help Center topics:
- Scheduling Events
- Creating CRM Task Records
- Scheduling or Logging Phone Calls

### Searching for Records

NetSuite includes several search tools to help you find and view your records. Here is a summary of the available tools with links to more information:

- **Global search** – A search field appears in the center of the NetSuite header so that it is accessible everywhere in NetSuite. You can enter keywords here to search your entire NetSuite account. See Using Global Search.
■ **Search crosslink** – This link in the upper right of most record and lists pages opens a search page for the current record type. From this page you can search using the following methods:
  □ **Simple search** – Use the filters on the page to search. See the help topic *Defining a Simple Search*.
  □ **Advanced search** – Check the **Use Advanced Search** box to switch to advanced search mode. See the help topic *Defining an Advanced Search*.
  □ **Saved search** – Click **Create Saved Search** to open a page where you can define a search that you and others can run repeatedly for dynamically updated results. See the help topic *Defining a Saved Search*.

■ **Quick find** – Many NetSuite pages include an icon (Quick Find) at the top of the page that you can click to search for other records of the same type. See the help topic *Quick Find*.

■ **Dashboard search portlets** – Several portlets are designed to help you search for records. These are:
  □ **Custom Search** – Displays the results from a saved search in a list. See the help topic *Displaying Saved Search Results in Dashboard Portlets*.
  □ **Quick Search** – Contains a form where you can search for records of a selected type using a filter and keywords. See the help topic *Quick Search Portlet*.
  □ **Search Form** – Similar to Quick Search, but the form is more complex and can be personalized. See the help topic *Adding Personalized Search Forms to NetSuite Pages*.

### Viewing and Editing Records

After you create records in your NetSuite account, you can access those records to enter new information or edit information.

To create a new record, go to the NetSuite navigation menu that lists the record you want, and then click the New link next to the record type. For more information, see *NetSuite Record Types*.

Many types of records can also be created from the Create New menu. For more information, see *Using the Create New Menu*.

#### Viewing Records

To view an existing record:

- Search for it by name or ID. See the help topic *Finding Records*.
  
  When you do this, the record is presented in view mode. In view mode, you can see all the information in the fields on the record but you cannot change the data. Click Edit to add, delete, or edit information on the record.

- Go to the NetSuite navigation menu that lists the selected type of record and click the link for that type of record to open a list of the records. Then click the View link for the record.
  
  On the list page, you can sort the list of records and customize the list to display certain fields in the list view. For more information, see *Working with Lists*.

#### Editing Records

You can edit an individual record by clicking Edit next to the record in a list. If inline editing is enabled, you can change data on multiple records from the list page. For more information, see *Using Inline Editing*.

#### Entering Subtab Data on Records

Subtabs on records enable you to enter additional information. For example, address information is often maintained on a subtab rather than in the main record form. Which subtabs are included depends on the record type. To learn more, use the help topics for the specific record type. For links to these topics, see *NetSuite Record Types*.
Some subtabs contain sublists of related records. These sublists include buttons to add, insert, copy, and remove records in the list. Sublists are common on transaction records. See Working with Transactions.

The Communication subtab, which is available for most record types, enables you to attach files to the record. For more information, see Attaching Files to Records.

Currency Field Limitations

You can enter up to 17 digits including integers and decimals in a currency field on a record.

- For decimal currencies, the maximum field size is $15 + 2$. You can enter numbers with up to 15 integers and 2 decimals. Example: $123,456,765,890,123.12$
- For currencies without decimals, the maximum field size is $17 + 0$. You can enter numbers with up to 17 integers. Example: $12,345,678,905,612,345$

View-only currency fields such as totals, display up to 18 digits.

- For decimals currencies, the maximum field size is $18 + 2$. Example: $123,456,789,012,345,678.12$
- For currencies without decimals, the maximum field size is $18 + 0$. Example: $123,456,789,012,345,678$

Creating a Transaction from a Record

You can create transactions from lead, prospect, and customer records.

To create a transaction from a record:

1. View the record by clicking View next to a record in a list.
2. Click the menu on the record to open a list of records and transactions that you can create and link to the current record.
3. Select a transaction type. Some transactions types that are commonly available are sales order, invoice, and cash sale.

When you create a transaction from a record, the record is automatically linked to the transaction.

Attaching Files to Records

You can attach documents in the File Cabinet to records and transactions using the Communication subtab. This is useful if, for example, you want to keep a copy of a contract or license on a customer record. You do not need to edit the record to attach a file. You can also attach files in view mode.

To attach a file to a record or transaction:

1. Click the Communication subtab on the record.
2. Click the Files subtab. The subtab looks like this:
Here you can attach a file that is already in the File Cabinet or add a new file to the File Cabinet and attach it.

- To attach a file that is already in the File Cabinet:
  1. Select a file from the **Attach Existing Files** list.
  2. Click **Attach**.

- To add a new file and attach it:
  1. Click **New File** to open a popup File window.
  2. To add a file from your computer, select a File Cabinet destination from the **Folder** list. To create a new folder, click the plus sign next to the **Folder** field. A popup window Document Folder appears. Fill in the folder name and other optional information about the folder and click **Save**.
  3. Click **Browse** to open a popup window and select the file you want to add.
  4. Click **Save**. The file you selected is saved to the filing cabinet and attached to the record.

When anyone in your company opens the record, they can also view files associated with the record. Access to the File Cabinet folder is required to view a file from that folder when it is attached to a record or transaction. For information about access to File Cabinet folders, see **Restricting Access to File Cabinet Folders**.

**Important:** A file in the Attachments Sent folder or Attachments Received folder cannot be attached to records or transactions. You must move the file to another folder. For more information, see **Moving and Copying Files from the File Cabinet**.

### Inactivating Records

As your business grows, you may no longer need certain records in your NetSuite account. Rather than deleting a record you do not currently use, you can mark the record as inactive.

When you mark a record as inactive, the record remains in the system for future reference. However, the inactive record does not show on transactions for selection in lists.
Inactivating records is a quick and useful way to clean up your lists and keep your records up to date. By keeping only current records active, it is easier to find the right selection in lists on transactions because outdated choices do not show in the list. This makes form entry easier, accurate, and less prone to error.

You can make records inactive one at a time by checking the Inactive box on individual records. The Inactive box shows for users with the appropriate permission to change records.

You can also make many records inactive at one time by marking them on a list page, as described below.

**To inactivate list records:**

1. Check the **Show Inactives** box. The page automatically reloads to display the **Inactive** column.
2. In the **Inactive** column, check the boxes next to the records you want to inactivate.
3. Click **Submit**.

After a record is marked inactive, it no longer appears in dropdown lists or popup lists in NetSuite. You can see inactive records on list pages by checking the Show Inactives box.

**Important:** After you inactivate a record, it will not show on transactions for selection in lists. However, if the Search option shows in the dropdown list for a field, the search will return inactive records if the Inactive filter is set to Either or Yes. Inactive records in these search results can be added to transactions. To filter inactive records out of search results, be sure to set the Inactive filter to No in the search criteria.

## Duplicate Record Detection

The Duplicate Detection & Merge feature helps you find duplicate records in your NetSuite account and use the information in them to create a single record.

An administrator can turn on the Duplicate Detection & Merge feature at Setup > Company > Enable Features (Administrator) on the Company subtab in the Data Management section. The administrator configurations the types of records you detect duplicates of and also chooses which fields to consider when finding duplicates. For more information on the setup of this feature, see the help topic Setting Up Duplicate Detection.

Four types of records support duplicate matching:

- Customer
- Vendor
- Partner
- Contact

**Note:** Private contacts are excluded from the Duplicate Detection process.

You must have full access to the entity types you are merging. For example:

- You must have Full access to Vendors to merge two vendors.
- You must have Full access to both Contacts and Customers to merge Individual Customers, which are composed of both.
- You must have Full access to both Customers and Vendors to merge into a Customer/Vendor polymorphic entity.

Duplicate Customers and Vendors can be detected across subsidiaries. The subsidiary a potential duplicate customer or vendor belongs to is shown in the Primary Subsidiary column. You must first
enable the Detect Duplicates Across Subsidiaries feature at Setup > Company > Company Management > Duplicate Detection.

**Warning:** Merging entities is a data-intensive operation, and complex merges many records such as transactions, custom fields, or workflows may time out when processing. You should test the merge process in a sandbox account first to ensure that it can be completed.

With this feature enabled, you receive notification before saving a record that might be a duplicate. Notification occurs in two ways:

- When you create a new record and enter matching data in fields the administrator set up as duplicate criteria, a warning appears at the top of the record with a link to the potential duplicates. If you have permission to view those records, you can click the link to resolve these matching records.
- When you add a record from a list by using Quick Add or use the Edit button to make changes to a record that would make it a duplicate, you receive a popup warning.

You can also go to Lists > Mass Update > Entity Duplicate Resolution to search for all possible duplicate records based on criteria you have set. With the duplicate resolution mass update, you can find and resolve large numbers of duplicate records in your NetSuite account in a single operation.

For more information about how to manage duplicate records, see Manage Record Duplicates Page.

For more information, see the following:

- Merging or Deleting Duplicate Records
- Merging Large Numbers of Records
- Merging Different Types of Records
- Words Excluded from Duplicate Detection Matching

### Merging or Deleting Duplicate Records

When you find duplicate records in your NetSuite account, you can merge them, resulting in one complete record for each person or company you do business with.

The Administrator role is required to set up which types of records you detect duplicates for and how you determine that two records are duplicates. An administrator selects fields on records to check for matching information. When matches are found, the system identifies the records as possible duplicates. For example, the administrator may choose to identify duplicates based on matching email addresses. If the selected fields are blank, they do not match.

When you merge records, the records' transaction histories are also merged. The original data, such as entity name, is retained to preserve a transaction's history. Your administrator may have restricted the ability to perform merges to specific roles.

**Note:** System notes are not transferred from duplicate records to the master record during a merge.

You can merge duplicate entity records that have login access but have different email addresses only if an administrator has set the Resolve Duplicates with Conflicting Login Access preference to By deleting the duplicates' access. This setting deletes the login access of records you define as duplicates. When this preference is set to the default value of Manually, you must first manually remove the login access of one record before you merge. The person whose access is removed must use the login access defined on the master record. Be sure to notify this person of the change because the deleted login will no longer work.

To prevent you from merging records that are not duplicates, you can only merge records if they have the same tax registration numbers or if both records do not have tax registration numbers.
This section is divided into the following subsections:

- Manage Record Duplicates Page
- Submitting Merge Operations
- Merging Records with Active Workflow Instances
- Status and Timing of Merge Operations

Note: For NetSuite OneWorld accounts: entities associated with different subsidiaries can be merged only if they are the same type.

For more information administrators should see the help topic Setting Up Duplicate Detection.

Manage Record Duplicates Page

The Manage Duplicates page presents lists of records that NetSuite has identified as possible duplicates.

You can access this page in two ways:

- The Manage Duplicates page opens when you click the link on a duplicate warning message. These warning messages appear when you open a record that has been identified as having potential duplicates or when you attempt to save a new record with information that matches an existing record.

- If you use the administrator role or have a role with the Mass Updates permission, you can access this page at Lists > Mass Update > Entity Duplicate Resolution. From here, you can search matching records and resolve many duplicates in a single operation. For more information, see the help topic Setting Up Duplicate Detection.

On the Manage Duplicates page, you specify which records are duplicates and which are not. You can also specify a master record for each set of possible duplicates. If the master record and duplicate record have different information for the same field, the information from the master record takes precedence and is preserved. The information in the duplicate records for these fields is lost.

In the Merge Type field at the top of the page, you select how to process the records in the list. For more information, see Submitting Merge Operations.

For duplicate searches of customer and contact records, some common words are excluded to prevent false matches. For a list of these words, see Words Excluded from Duplicate Detection Matching. Also note that in OneWorld accounts, records associated with different subsidiaries are never considered duplicates even if the information in those records matches.

In the following screenshot, you can see an example of the Manage Duplicates page. The list of records is filtered to show customers. You can change the Entities filter value to see duplicates of other types of records.
All potential duplicate records are grouped together on this page. These groups are assigned a number in the Group # column. For example, if you are searching for duplicates by phone number and have three records with the same phone number, all of these records have the same group number.

The Fields column shows how many fields on each record contain data. Often duplicate records have less information entered than master records do.

You can customize the columns displayed on the Manage Customer Duplicates page by clicking Customize View. Creating a customized view can be helpful when the default view does not display columns for the fields you are most interested in. For example, if you are searching for duplicates based on the Email field, you may want to create a view called My Duplicates where the Email field is displayed as a column.

You can use the following buttons to quickly select and resolve duplicate records:

- Click Mark All As Dup. to check all the boxes in the Duplicate column. When you click Merge Selected, these records are processed according to the option you select in the Merge Type filter.
- Click Mark All As Not Dup. to check all the boxes in the Not A Dup. column. These records are not merged.
- Click Unmark All to clear all the boxes.

### Submitting Merge Operations

| Note: You must have full access to the Duplicate Entity Management permission to merge duplicates. By default, the Sales Person role has only View access. The Sales Manager and Administrator roles have Full access. |

To search for possible duplicates:

1. Click the notice in the duplicate record.

   ![WARNING](image)
   
   This record may have duplicates.

   ![Lead](image)
   
   Millin, James

2. Expand the Filters area at the top of the list to display the filters.

3. In the Entities filter, select a type of record to view possible duplicates for that type. For example, select Contacts to view all contacts you have access to that have some of the same information as other contact records.

   ![Important](image)
   
   You can merge two records that both have login access only if those records have different login email addresses and passwords.

4. In the Merge Type field, select how you want to merge the selected records:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark all selected as not duplicates</td>
<td>This leaves all records without any changes.</td>
</tr>
</tbody>
</table>
### Duplicate Record Detection

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Make duplicates subcustomers of master</strong></td>
<td>This option is available only for customer records. It makes the duplicate record a subcustomer of the master customer record. For more information, see the help topic <a href="#">Subcustomers</a>.</td>
</tr>
<tr>
<td><strong>Merge duplicates into master record</strong></td>
<td>This merges all information from the duplicate records into empty fields in the master record. If information is entered in field on both the master and the duplicate, the information on the master record remains the same.</td>
</tr>
<tr>
<td><strong>Merge duplicates into record created the earliest</strong></td>
<td>This saves the record with the earliest date in the Created column and places information from selected duplicated records into any empty fields on the saved record.</td>
</tr>
<tr>
<td><strong>Merge duplicates into record with most populated fields</strong></td>
<td>This saves the record with the highest number in the Fields column and places information from selected duplicate records into any empty fields on the saved record.</td>
</tr>
<tr>
<td><strong>Merge duplicates into record with most recent activity</strong></td>
<td>This saves the record with the most recent date in the Last Activity column and places information from selected duplicate records into empty fields on the saved record.</td>
</tr>
<tr>
<td><strong>Delete duplicates, keep master record</strong></td>
<td>This saves only the record you selected as the master and deletes all records you selected as duplicates.</td>
</tr>
<tr>
<td><strong>Delete duplicates, keep record created the earliest</strong></td>
<td>This saves the record with the earliest date in the Created column and deletes all other selected records in this group.</td>
</tr>
<tr>
<td><strong>Delete duplicates, keep record with most populated fields</strong></td>
<td>This saves the records with the highest number in the Fields column and deletes all other selected records in that group.</td>
</tr>
<tr>
<td><strong>Delete duplicates, keep record with most recent activity</strong></td>
<td>This saves the record with the most recent date in the Last Activity column and deletes all other selected records in the group.</td>
</tr>
<tr>
<td><strong>Make duplicates subrecords of master</strong></td>
<td>This saves the record you designate as the original, master record and converts those you marks as duplicates into its subrecords.</td>
</tr>
</tbody>
</table>

5. For each group of records, check the box in the Master column next to the record you want to designate as the main record. Information from duplicate records is merged into empty fields on the master record.

6. Check the box in the Duplicate column next to any record that is for the same person as the master record. Information from these records is merged into the master record.

   You can also click **Mark All As Dup.** to check all boxes in the Duplicate column.

7. Check the box in the Not A Duplicate column next to any record that is not for the same person as the master record. These records remain unchanged.

   You can also click **Mark All as Not Dup.** to check all boxes in the Not a Dup column.

8. Click **Submit Selected** to complete the action you selected in the Merge Type field.

### Merging Records with Active Workflow Instances

When you merge records, the records may have active workflow instances running on them. In this case, NetSuite keeps the workflow instance running on the record that you choose to keep and cancels any other workflow instance.

For example, you merge duplicate customer records that each have an active workflow instance named Process Customer running. Depending on the options you choose in the Merge Type list on the manage duplicates page, NetSuite keeps one of the records, merges the other entity fields with that record, and cancels any workflow instances on the duplicates. In this example, only one instance of the Process Customer workflow will run on the record after the merge operation.

For more information on the types of merges that you can perform, see [Submitting Merge Operations](#).
**Status and Timing of Merge Operations**

When you submit a duplicate merge operation, it is placed in a queue and is executed when operations ahead of it in the queue are completed. Go to Lists > Mass Update > Duplicate Resolution Status to view the Duplicate Resolution Status page. Here you can view the status of duplicate merge operations, the number of records merged, and the number of records that could not be merged. You can view possible errors that occur during the operation by clicking the Details link in the Errors column.

After you submit a duplicate merge operation, you can continue to work in NetSuite without waiting for the merge operation to finish. Records you have marked as duplicates cannot be edited during the time that the duplicate operation is queued or running. The record you mark as the master is locked only for a brief time when the merge operation begins.

**Warning:** Merging entities is a data-intensive operation, and complex merges many records such as transactions, custom fields, or workflows may time out when processing. You should test the merge process in a sandbox account first to ensure that it can be completed.

Historical log records for duplicate merge tasks are saved in NetSuite for only seven days before the information is permanently erased.

**Merging Large Numbers of Records**

NetSuite can merge an unlimited number of records using the Mass Update functionality. Administrators set the rules for the merge process to determine which record in a set of duplicates is the master record and configure the criteria to control the search results.

**Warning:** Merging entities is a data-intensive operation, and complex merges many records such as transactions, custom fields, or workflows may time out when processing. You should test the merge process in a sandbox account first to ensure that it can be completed.

To merge large numbers of duplicate records:

1. Go to Lists > Mass Duplicate Resolution.
2. In the Action column, expand the Duplicate Resolution options, and click the type of record you want to merge.
3. Use the dropdown list in the Master Selection Mode field to define the master record. You can use the following modes:
   - Created earliest – This mode selects the record that was created first as master record.
   - Most populated fields – This mode selects the record that has the most fields containing data as master record.
   - Most recent activity – This mode selects the record with the most recent activity as master record.
4. Use the Record Selection Mode list to define which records are selected. You can use the following modes:
   - All from duplicate group – Both the master record and the duplicate records are selected from the complete group of duplicate records, and search results are used only to determine the groups.
   - Master from duplicate group – The master record is selected from the whole group, and duplicates are selected from the search results only.
   - Master and duplicates from search only – Both the master record and the duplicate records are selected only from the search results.
You can use various criteria to define which records are included in the operation and schedule regular duplicate merge operations to take place automatically at regular intervals.

Merging Different Types of Records

Sometimes duplicate records exist between record types, such as a vendor record and a partner record for the same person or company. The Duplicate Detection feature only searches for possible matches within the same record type, but if you know of duplicated between two record types, you can merge them manually.

**Warning:** Merging entities is a data-intensive operation, and complex merges many records such as transactions, custom fields, or workflows may time out when processing. You should test the merge process in a sandbox account first to ensure that it can be completed.

You can merge records between the following record types:

- Partners
- Vendors
- Customers

Merging Customer/Vendor Entities in Different Subsidiaries

You can merge Customer/Vendor entities across subsidiaries, creating a single multi-subsidiary Customer/Vendor entity. Merging two entities from different subsidiaries results in the following:

- The primary subsidiary becomes the Master Entity subsidiary.
- The Duplicate Entity subsidiary becomes a secondary subsidiary for each individual entity.
- The Contact from the primary subsidiary is linked and synchronized with the master entity.

To merge records of different types:

1. Open the duplicate record you want to merge into a master record in edit mode. Do not make any changes to the record.
2. Click **Merge**. This opens a new page.
3. In the **Master** field, select the name of the customer, partner, or vendor record into which the record should be merged.
   - The record selected in the **Master** field becomes the master record.
4. A summary of the files to be merged will appear in the **Duplicate/Master Summary**.
5. Click **Save**.

The merged record opens. All activities, transactions, messages, files, cases, contacts, and other subtab lists are combined on the merged record. Fields previously blank on the master record are filled with information from the duplicate record, but no field data is replaced.

**Note:** Administrators can restrict the ability of users to merge records. For more information on how to limit the merge function by role, see the help topic **Duplicate Entity Management Permission**.

Words Excluded from Duplicate Detection Matching

Records are listed as duplicates when they have either matching or similar information. When searching for similar information, NetSuite excludes certain words or phrases that occur often in fields to avoid false duplicates. This list is organized by field name.
Customer, Partner, and Vendor Name

The following words or abbreviations are not considered when searching for similar information to prevent false matches in the company or customer name field:

- Corp.
- Corporation
- Co.
- Company
- Inc.
- Incorporated
- Enterprise(s)
- Firm

Note that duplication detection also ignores variations of these terms, such as abbreviations without periods at the end.

Email Address

If you identify duplicates based on matching email address, you can set duplicate criteria on Email (full) to identify duplicates only if the full email addresses of two records match exactly.

If you set duplicate criteria based on Email (domain only), the domain names listed below are not considered when searching for similar information to prevent false matches for email addresses. Administrators can add or remove a domain from the default list in the Excluded Domains subtab on the Set Up Duplicate Detection page at Setup > Company > Company Management > Duplicate Detection. Administrators can also configure a unique list of domains to be excluded from Email (domain only).

- adelphia.net
- altavista.com
- ameritech.net
- aol.com
- attbi.net
- att.net
- bellsouth.net
- bigfoot.com
- comcast.net
- cox.net
- earthlink.com
- excite.com
- gmail.com
- home.com
- hotmail.com
- ix.netcom.com
- juno.com
- lycos.com
- mail.com
- mindspring.com
- msn.com
- netscape.net
Duplicate Record Detection

- netzero.com
- pacbell.net
- prodigy.net
- qwest.net
- sbcglobal.net
- swbell.net
- sympatico.ca
- verizon.net
- worldnet.att.net
- yahoo.com
- yahoo.co.uk

**Note:** Potential duplicate results are determined differently when using the email address from a customer record than from a contact record. Customer records are flagged as potential duplicates when the domain name portion of the address matches, provided the domain name is not listed on the Excluded Domains list. Contact records are flagged as duplicates only if the entire email address matches. This difference prevents false potential duplicate results when multiple contact records from one company use the same domain name in their email addresses.

### Phone Number

When searching the phone number field for duplicates, all prefixes and extensions are excluded so that only the 9 digit or 6 digit numbers are considered. If two matching phone numbers are compared, one with an area code and one without, they are not detected as duplicates.

### Address

Addresses are considered potential duplicates based on the street number and name. Similar numbers with a street name match are considered potential duplicates, for example.

The following words or symbols are not considered when searching for potential duplicates in the Address field:

- Street/St.
- Avenue/Ave.
- Court/Ct.
- Suite/Ste.
- Apartment/Apt.
- #
- Lane/Ln.
- Highway/Hwy.
- Road/Rd.
- West/W.
- North/N.
- East/E.
- South/S.
- NW
- SW
- SE
Working with Groups

A group is a set of employees, contacts, customers, partners or vendors. You can create groups of records to communicate with a set of individuals. For example, invite a group to a meeting, or create folders in the File Cabinet for a specific group in your organization.

With groups you can do the following:

- Invite everyone in a group to the same event.
- Use the shared calendar to see when the group meets or has other scheduled events.
- Create folders in the File Cabinet that only group members can view.
- Assign cases, leads, and support or sales territories to groups if the Support Group or Sales Group box is checked on the group record.
- If you use the Marketing Automation feature, customer, lead and prospect groups can be selected as target groups for marketing campaigns. You also send email, mail or faxes in bulk to a group using the Mail Merge feature. You can divide groups into marketing test cells that enable you to test different versions of a marketing template.
- If you use the Team Selling feature, you can create sales teams. For more information, see the help topic Setting Up a Sales Team.

You can create groups by choosing members individually or by using a search of records. To create a group, go to Lists > Relationships > Groups > New (Administrator).

You can create two types of groups:

- **Dynamic groups** – Dynamic group membership changes to include anyone who meets the group's criteria.
  
  For example, you can set search criteria to create a group of all employee sales reps. When a new sales rep is hired, the rep automatically becomes a member of this dynamic group. When a sales rep takes a position in another department, that rep is removed from the group automatically. Whenever you use the Mail Merge feature to send bulk email to this dynamic group, NetSuite uses the search criteria to determine the current group members.
  
  You can create dynamic groups from new searches or saved searches. See Creating a Dynamic Group.
Static groups – The membership of static groups does not change.

You can create static groups by selecting members from lists or with a search. Support and sales groups must be static groups. See Creating a Static Group.

You can use also CSV Import to create static groups. For more information, see the help topic Group Import.

Note: Be aware that you cannot create a static group with more than 10,000 members. For groups larger than 10,000, you must create a dynamic group.

When you create a group, the Restrict Group Editing to Owner box is checked by default. Please be aware that if you clear this box, anyone with access to the group can modify it, delete members and access File Cabinet folders. You should ensure that the appropriate permissions have been applied to the roles assigned to this group.

For detailed information about groups, see the following topics:

- Creating a Dynamic Group
- Creating a Static Group
- Creating a Contact Group
- Adding and Removing Members of Groups

Creating a Dynamic Group

Dynamic group membership changes to include anyone who meets the criteria defined in a saved search.

For example, you can set search criteria to create a group of all employee sales reps. When a new sales rep is hired, the rep automatically becomes a member of this dynamic group. When a sales rep takes a position in another department, that rep is removed from the group automatically. Whenever you use the Mail Merge feature to send bulk email to this dynamic group, NetSuite uses the search criteria to determine the current group members.

You can create a dynamic group from an existing saved search or you can create a new saved search when you create the group.

To create a dynamic group:

1. Go to Customers > Relationships > Groups > New.
2. On the Create Group page, choose Dynamic.
3. Choose the kind of members you would like this group to contain.
4. Click Continue.
5. Enter a name for this group.
6. Select an existing saved search in the Saved Search list.
   - Only saved searches that include the kind of members you selected in step 3 appear in the list.
   - For more information on saved searches, see the help topic Defining a Saved Search.
   Depending on the kind of group you are creating, you can use joined searches to generate your results. For example, if you are creating a customer group, you can use a transaction search to give you the desired results. If you are creating a contact group, you can search for vendors that meet the criteria.
   After you select or create a saved search, the members of the group are shown on the Members subtab.
7. If the owner of this group is someone else, select that person in the Owner field.
8. (Optional) If this group shares an email alias, enter the email address in the Email field.

9. (Optional) Enter other information about this group in the Comments field.

10. (Optional) Check the Private box if you want to restrict viewing (and also editing) of this group to its members.

11. (Optional) If you want to restrict access to this group to members of another group, select the group in the Restrict To field.

12. (Optional) Clear the Restrict Group Editing to Owner box if you want to allow other group members to edit this group. By default, this box is checked.

    You should check the Restrict Group Editing to Owner box when you set up a group that controls access to sensitive information such as access to particular File Cabinet folders.

    If you intend to grant other members of the group editing permissions, you should either make the group private or restrict it to another group by enabling the relevant setting on the group records page. Do not put sensitive material in a File Cabinet folder that is accessible from a public group.

    You should also ensure that the role used to access the group has an appropriate CRM Groups access level assigned to it on the relevant manage roles page. Go to Setup > Users > Role > Manage Roles.

    If you clear the Restrict Group Editing to Owner box and choose to make your group public, any user with access to a role with edit-level access to CRM Groups can access and edit your group’s content. This includes access to File Cabinet folders as well as adding and deleting members.

    For more information on assigning role-based permissions, see the help topic Reviewing Permissions Assigned to Roles.

13. Click Save.

Now, every time a record of this type is created, it is added to this group if it matches the criteria in the saved search.

Creating a Static Group

The membership of a static group remains constant. You can create static groups by selecting members from lists and with a search. Support and sales groups must be static groups.

You can also use CSV Import to create and update static groups. For more information, see the help topic Group Import.

You can add or remove members from a static group at any time.

    Note: You cannot create a static group with more than 10,000 members. For groups larger than 10,000, you must create a dynamic group.

To create a Static Group:

1. Go to Customers > Relationships > Groups > New.
2. On the Create Group page, choose Static.
3. Choose the kind of members you would like this group to contain.
4. Click Continue.
5. Enter a name for this group.
6. If applicable, complete the following:
   - If the owner of this group is someone else, select that person in the Owner field.
   - If this group shares an email alias, enter the email address in the Email field.
   - Enter other information about this group in the Comments field.
   - Check the Private box if you want to restrict viewing (and also editing) of this group to its members.
   - If you want to restrict access to this group to members of another group, select the group in the Restrict To field.

   **Note:** Restricted groups cannot be marked private. Restricted groups can only be used by members of the group you select in the Restrict To field.

   - Check the Restrict Group Editing to Owner box if you want to restrict editing permissions to the group owner as specified in the Owner field.
     
     You should enable the Restrict Group Editing to Owner preference whenever you are setting up a group for the purpose of controlling access to sensitive information. For example, when restricting access to certain File Cabinet folders.
     
     If you intend to grant other members of the group editing permissions, either make the group private or restrict it to another group by enabling the relevant setting on the group records page. Do not put sensitive material in a File Cabinet folder that is accessible from a public group.
     
     Also ensure that the role used to access the group has an appropriate CRM Groups access level assigned to it on the relevant manage roles page. (Go to Setup > Users > Role > Manage Roles.)
     
     If you disable Restrict Group Editing to Owner and choose to make your group public, any user with access to a role with edit-level access to CRM Groups, can access and edit your group's content. This includes access to File Cabinet folders as well as adding and deleting members.
     
     For more information on assigning role-based permissions, see the help topic Reviewing Permissions Assigned to Roles.

7. If you are creating an employee group, the following fields are available:
   - **Support Group** – Check this box to mark this group a support group.
     
     On case records, support groups are listed in the Assigned To field. When you assign a case territory, support groups are listed in the Support Rep. field.
   - **Product Team** – Check this box to mark this group as a product team.
     
     Product team groups can be selected in the Product Team field on issues. Product teams designate who is responsible for resolving an issue. Members of this team are emailed when an issue is first entered so that everyone is aware of the problem.
   - **Functional Team** – Check this box to mark this group as a functional team.
     
     Functional teams can be emailed copies of the issue from the Communication subtab on issue records. You may want to check this box for all product team groups and then create additional function team groups for other teams you want to email.
   - **Issue Role** – Select a role that corresponds to the role of this group's members, and this group can be assigned to issues.

8. On the Members subtab, do one or more of the following:
To add individual members, enter part of a member’s name in the Name column, and press Tab. Select a member, and click Add. Repeat these steps for each member.

Click Add Multiple, and hold CTRL to select more than one member from the list.

Click Add With Search to enter search criteria for the members you want to add.

You can use more than one of these methods to add members to the same group. For example, you can select a few members individually and then add all the members that meet search criteria.

Depending on the kind of group you are creating, you can use joined searches to generate your results. For example, if you are creating a customer group, you can use a transaction search to give you the desired results. If you are creating a contact group, you can search for vendors that meet the criteria.

Note: To access a Group’s calendar, use the dropdown menu below the date selector on the calendar portlet.

To add a member to this group, open the group record. On the Members subtab, use one of the methods in step 8 to add a member.

To remove a member from this group, open the group record. On the Members subtab, click Remove on the row of the member you want to remove.

Creating a Contact Group

You can create a contact group from the contacts associated with an entity search or entity groups. If your company deals with customers, vendors, and other entities that are more often companies as opposed to individuals, you probably use contact records for the people you work with in those companies.

You can create contact groups based on contact record criteria or on criteria for the entity records those contacts are associated with. For example, you might want to create a group of contacts for all customer companies in a certain country. Your contact group would be based on customer search criteria.

Creating a Static Contact Group

You can create contact groups based on searches for the record they are associated with. For example, you could search for all customers with a specific sales rep and create a group of all contacts associated with these customers.

To create a static contact group based on customer or other criteria:

2. Select Static.
3. Choose the kind of record you want to enter criteria for.
   In the example mentioned above, you would choose Customers. When you select Contact, the group can include members from more than one entity type.
4. Enter a name for your group.
5. On the Members subtab, click Add With Search
6. Choose the criteria you want to use for the search.
7. Enter criteria for the records whose contacts you want to create a group from.
8. Click Search & Select.
9. Click Add Static Members.
10. On the Create Static Group page, click Save.
11. When the record has saved, click Group Contacts.

![Static Customer Group](image)

12. Enter a name for the static contact group.

13. If you want to remove any of the contacts from the group, choose the contact name and click Remove.

14. Click Save.

You can also create static contact groups from an entity group. To do this, open an entity group record, and click Group Contacts at the top of the record.

You can also use CSV Import to create and update static Contact groups. For more information, see the help topic Group Import.

**Creating a Dynamic Contact Group**

Dynamic groups are defined by search criteria. This means that the membership of a dynamic group changes as new contact records are created that meet your criteria and as existing contact records are edited and no longer meet the group criteria.

To create a dynamic contact group based on customer or other criteria, you should first go to and create a saved search for the contacts based on fields from customer or other records.

![Saved Contact Search](image)

**After you have created your saved search:**


2. In the dropdown list, select Contact.
3. Click **Continue**.
4. Enter a name for the group.
5. In the **Saved Search** field, select the saved search you created.
6. Click **Save**.

**Adding and Removing Members of Groups**

Dynamic group membership is updated automatically as the results of the saved search change. You must add and remove members of static groups manually.

**To add members to a static group:**

1. Go to **Lists > Relationships > Groups**, and click the link to open the record for the group you want to add a member to.
2. On the **Members** subtab, do one or more of the following:
   - To add individual members, enter part of a member's name in the **Name** column, and press **Tab**. Select a member, and click **Add**. Repeat these steps for each member.
   - Click **Add Multiple**, and hold **CTRL** to select more than one member from the list.
   - Click **Add With Search** to enter search criteria for the members you want to add.

You can use more than one of these methods to add members to the same group. For example, you can select a few members individually and then add all the members that meet search criteria.

**To remove members from a static group:**

1. Go to **Lists > Relationships > Groups**, and click the link to open the record for the group you want to add a member to.
2. On the **Members** subtab, click **Remove** on the row of the member you want to remove.

**Working with Transactions**

A transaction is a record of a business event. Many transactions record financial agreements between your business and its customers or vendors, such as sales and purchase orders, invoices, vendor bills, and so on. Other transactions record events such as inventory adjustments and assembly build transactions.

Many transactions result in the posting of an amount to the general ledger (GL). Some examples of posting transactions are bank deposits, vendor bills, and credit memos. Those transactions that do not impact the general ledger are called non-posting transactions. Some examples of non-posting transactions are purchase orders, sales orders, and return authorizations.

A transaction is a specialized type of a record. For general information about records, see Working with Records.

Click a link below for information that is specific to transactions:

- Creating Transactions
- Entering Transaction Line Items
- Entering Relationships on a Transaction
- Entering Communication Information on a Transaction
- Tips for Working with Transactions
- Finding Transactions
Working with Transactions

- Voiding, Deleting, or Closing Transactions
- Memorized Transactions
- Preferred Transaction Delivery on Customer and Vendor Records
- Transaction Detail Report
- Transaction Detail Workbook
- Limits for Display of Transaction Lists and Sublists

Most transactions support scripting using SuiteScript. For a list of scriptable transactions, see the help topic SuiteScript Support. The individual transaction topics in this area include a brief description of the transaction and a link to detailed information.

Creating Transactions

The types of transactions you can create and view depend on your role. Many roles have no access to transactions. The set of tabbed pages you see in NetSuite, called a center, also depends on your role. The centers are organized to facilitate your work. Most centers do not have a tab dedicated to transactions. You may find transactions on tabs with a variety of names, such as Customers, Vendors, Revenue, or Financial.

If you use the classic interface for NetSuite, you have a Transactions tab that provides access to all of the transaction types for which you have permission. This is a user preference in NetSuite. For more information, see Personal Preferences for Appearance.

To enter a transaction:

1. Click the tab where you access transactions, and click the kind of transaction you want to create. The transaction page opens with default information completed.
2. Enter or verify information in the required fields on the page. Required fields are indicated by an asterisk (*). This information may include the transaction date, transaction number, transaction status, class/department/location classification, or a memo.
   
   Note: In OneWorld accounts, after you select a subsidiary on a transaction and save it, the subsidiary cannot be changed.
3. Enter information in the required fields in other areas of the page. NetSuite automatically completes certain data based on information you enter. For example, when you select a customer on an invoice, the customer's default ship to and bill to addresses automatically appear on the transaction. An administrator can configure the default values.
4. Enter data in the remaining fields as needed, including any custom fields that you have created.
5. Enter additional information for the transaction on each subtab. For example, sales order, cash sale, and invoice transaction pages include an Items subtab. When you select an item and click Add, the item appears as a line item on the transaction. Click on an existing line item to add or edit, insert, remove or clear that line item.
6. When you have finished entering data for the transaction, NetSuite provides various options for saving the transaction:
   - Click Save to save the information and return to the Transactions page.
   - Click Save & New to save the information and open a new transaction page of the same type.
   - Click Save & Print to save the information and send the transaction to the print queue.
Click **Save & Email** to immediately save and email the transaction. The email message includes the transaction as a PDF attachment, which is created using the customer’s preferred language.

**Note:** When processing transactions, you must save one page at a time. If you do not save each individual page, information is not retained and can be lost when you click a different page.

NetSuite prompts you if any required field is not completed. It also checks for basic data entry errors. If you have not completed a required field, you receive an error message about the missing data. Enter data in the required field, and click **Save** again. When the information is correct and complete, NetSuite accepts and records the transaction.

You can create and edit related records as you enter transactions. The following topics in this section include information about transactions and related records:

- Working with Addresses on Transactions
- Creating New Records as You Enter Transactions
- Editing Records as You Enter Transactions
- Defining Subsidiaries for OneWorld Transactions
- Using Transaction Links
- Linking a Transaction to a Support Case

### Working with Addresses on Transactions

When you create transactions, the shipping and billing addresses from the entity record are used by default on the Shipping and Billing subtabs. If no shipping or billing address is available for an entity, the address field is left blank. You must enter shipping and billing information for the transaction.

When entering transactions, you can add or edit shipping or billing addresses on entity records from within the transaction. You can also enter a custom address that is used only for the specific transaction and not stored on the entity record.

**Note:** If you use an address in an entity record and then change the address after creating the transaction, ensure that you update the transaction record with the correct address. Otherwise, some address fields might be blank.

See the following sections:

- To add or edit address on the entity record, see Adding or Editing a New Address from a Transaction.
- To enter or edit a custom address for this transaction, see Adding or Editing a Custom Address for a Transaction.
- To change your state or province preference, see Setting the State or Province Field Preference.

### Adding or Editing a New Address from a Transaction

You can add or edit an address for an entity from the transaction record.

**To add a new address from a transaction:**

1. Create a transaction. For more information, see Creating Transactions.
2. Enter entity in the appropriate field. For example, on a sales order, select a customer in the Customer field.
   
   The default shipping and billing addresses display on the Shipping and Billing subtabs. If a shipping or billing address has not been entered for the entity, the Ship To or Bill To field is blank.
3. Click either the **Shipping** or the **Billing** subtab.
4. Select **New** in the **Ship To Select** or **Bill To Select** field, or click the + icon.
   - Check the box to make this address the default for shipping or billing.
   - Check the **Residential Address** box if this address is not a business. This helps retrieve accurate rates when you use UPS or FedEx integration.
   - Enter a label to be displayed for this address in dropdown list address selectors.
   - Ensure the value for **Country** is correct. If it not, select a different country.
5. Enter the address information and click **Save**.
   The address is saved on the entity record.

You can edit an existing address from a transaction.

### To edit an existing address from a transaction:

1. Create a transaction. For more information, see **Creating Transactions**.
2. Enter an entity in the appropriate field. For example, on a sales order, select a customer in the **Customer** field.
   - The default shipping and billing addresses display on the **Shipping** and **Billing** subtabs. If a shipping or billing address has not been entered for the entity, the **Ship To** or **Bill To** field is blank.
3. Click either the **Shipping** or the **Billing** subtab.
4. Select a different address in the **Ship To Select** or **Bill To Select** field.
5. A popup window appears. Edit address information as required.
6. Click **Save**.
   - The address changes are saved on the entity record.

### Adding or Editing a Custom Address for a Transaction

You can add custom shipping or billing addresses for a single transaction.

Custom addresses are created on transactions automatically when an address has been used in transactions and then the address is changed on the entity record. When the entity address is changed, the address used in the transactions is changed to a custom address to keep it unchanged.

### To enter a custom address on transactions:

1. Create a transaction. For more information, see **Creating Transactions**.
2. Select an entity in the appropriate field. For example, on a sales order, select a customer in the **Customer** field.
   - The default shipping and billing addresses display on the **Shipping** and **Billing** subtabs. If a shipping or billing address has not been entered for the entity, the **Ship To** or **Bill To** field is blank.
3. Click either the **Shipping** or the **Billing** subtab.
4. Select **Custom** in the **Ship To Select** or the **Bill To Select** field.
   - A popup window appears. Enter address information as required.
     - Check the **Residential Address** box if this address is not a business.
     - This helps retrieve accurate rates when you use UPS or FedEx integration.
     - Ensure the value for **Country** is correct. If it not, select a different country.
5. Enter the address information and click **Save**.
   - The address appears only on the transaction where it is entered and **is not saved** on the entity record.
To edit a custom address on an existing transaction:

1. Open the transaction record.
2. Click the Shipping or Billing subtab.
3. In the Ship to Select or Bill To Select field, select Custom, and then click the Edit icon.
   A popup window displays address fields where you can change the address.
4. Click Save.

Setting the State or Province Field Preference

The Allow Free-Form States in Addresses preference affects the few cases where the state field appears as a body field on a record. In most cases, the state field is not a body field, but is part of a subrecord, and is not affected by this preference. When the state field is part of a subrecord, states entered as free text are automatically converted to abbreviations.

When the state field of the address appears as a body field on a record, you can set the format of the state or province field. Check the Allow Free-Form States in Addresses box to enter any text you choose in the State or Province field on addresses.

To set your State or Province field preference:

1. Go to Setup > Company > Preferences > General Preferences (Administrator).
2. Choose an option for the Allow Free-Form States in Addresses box:
   - Clear the box to disable free-form text entry in the State/Province field. Then, any text you enter is converted to standard state or province identifiers.
   - Check here for more information on standard province identifiers.
   - Check the box to enable free-form text entry in the State/Province field. Then, you can enter any text and it is not converted to standard state or province identifiers.
3. Click Save.

This preference does not affect your web store address form entries or UPS and FedEx shipping.

Creating New Records as You Enter Transactions

When you are entering transactions, you can create new records as you complete the transaction fields. You do not need to leave the transaction record to create new records.

The following transactions in NetSuite require you to select an entity prior to adding a record from the transaction:

- **Write Checks** – You must select a payee before you can create a new account.
- **Enter Sales Orders** – You must select a customer before you can create a new job.
- **Accept Customer Payments** – You must select a customer before you can create a new bank account.

For example, you are entering checks and want to enter a new bank account. Select a payee and then click next to the Accounts field. In the popup window, enter the new bank account name, account number, and whether the account is a subaccount of another. When you click Save, the Check page appears displaying the new account in the Accounts field.
Editing Records as You Enter Transactions

In NetSuite, some fields on transactions pages have an open icon next to them. Click the open icon to view the selected record in a new tab. In the new tab, click Edit and make changes as needed.

For example, when you are entering a sales order you may want to enter a new phone number for the customer. On the sales order, select the customer and then click the open icon. On the open customer record, click Edit and enter the new phone number. Then click Save. The changes you make to the open record are included in the sales order you are entering.

Defining Subsidiaries for OneWorld Transactions

Each transaction in NetSuite OneWorld, except advanced intercompany journal entries, is tied to one subsidiary. When a transaction includes an entity, such as a customer, the transaction is assigned to the same subsidiary as the entity. For transactions without entities, you must manually select a subsidiary. When you process transactions in bulk, such as fulfilling, bill payments, or commission authorizations, select the appropriate subsidiary to filter the list of transactions to process.

Intercompany journal entries post to two subsidiaries. These journal entries record transactions between subsidiaries. Each advanced intercompany journal record includes an originating subsidiary and one or more receiving subsidiaries. For more information, see the help topic Making Advanced Intercompany Journal Entries.

Some time entries and expense transactions may be associated with multiple subsidiaries. Each time or expense record is associated with the subsidiary of the employee. In addition, a customer or project can be defined for each line of these records. If the Intercompany Time and Expenses feature is not enabled, each line-level customer or project must be associated with the same subsidiary as the employee. If this feature is enabled and related accounting preferences are set, customers and projects from other subsidiaries can be selected at the line-level. For more information, see the help topics Enabling Intercompany Time and Expenses, Understanding Expense Reports, and Understanding Time Tracking.

When a transaction has line-level associations to more than one subsidiary, the general ledger posts only to the subsidiary identified in the transaction header. Advanced intercompany journal entries can be created to transfer time, expense, or both charges from one subsidiary to another. An automated adjustment process is available for intercompany expenses. For more information, see the help topic Creating Intercompany Adjustments for Time and Expenses.

Note: In NetSuite OneWorld, List view pages and search results convert the transaction currency to the base currency of the user’s subsidiary. For more information about List view pages, see List View.

Using Transaction Links

Most transactions in NetSuite provide links to other related transactions. You can use these links to drill down to the related transactions.

Some transactions provide links to the transactions from which they were created. For example, on a sales order the Created From link opens the estimate used to generate the sales order.

Other transactions have a link to the transaction created from them. For example, estimates have an Orders and Sales link. Click the link to open the sales orders, cash sales, and invoices created from the estimate.

Transactions such as payments or credits provide links to the transactions to which they are applied. For example, on a deposit the Payments subtab displays the payment transactions associated with that deposit. Clicking the date link next to a payment opens the payment transaction.
Linking a Transaction to a Support Case

You can link the following types of transactions to support cases:

- Sales orders
- Invoices
- Purchase orders
- Estimates
- Cash sale
- Opportunity
- Work order

For example, your company can create an invoice for a repair service performed for a customer and associate it with the support case that originated the service request.

To link a transaction to a support case:

1. Open a transaction record.
2. Click the Related Records subtab.
3. Click Support Cases.
4. Click New Case to create a new support case or click Attach to link an existing support case to the transaction.

Entering Transaction Line Items

Most transactions require you to enter one or more line items to account for the transaction total. Line items you enter determine the changes that post in NetSuite when you process the transaction. For example, when you enter line items on an invoice and post it, the inventory total decreases and the accounts receivable total increases, reflecting account changes for that transaction.

**Note:** The limit for transactions submitted through the user interface is 500 lines. For transactions submitted through CSV import or SOAP web services, the limit is 5,000 lines per transaction. Once you submit transactions exceeding the 500 lines limit through the CSV import or SOAP web services, you must do all additional changes and edits through the CSV import or SOAP web services.

For journal entries, these limits are 1,000 lines for the user interface and for synchronous SOAP web services, and 10,000 lines for CSV import and asynchronous SOAP web services.

The method for entering line items depends on the type of transaction you are creating. Line-item information is entered by either selecting and entering data and adding as a line item, or by selecting lines with check boxes.

To enter line items by entering data:

1. Fill out the line-item information on the form.
2. Click Add to add the information as a line item.
   - The transaction total is updated in the header as you add each line item, and a new, empty line is added.
3. Add more line items as necessary.
4. Click **Save**.

**To enter line items by selecting them from a list:**

In this case, you see lines of data, each with a check box on the left. Many pages have data-entry fields on the line.

1. Check the box next to the line you are choosing.
2. If there are data fields, enter values into them.
3. Repeat Steps 1 and 2 until you have chosen all your line items.
   - The transaction total is updated in the header as you check each line item.
4. Click **Save**.

To change a line item, click on the line in the list. When the line-item data appears in the center of the page, make your changes and then click **Edit**.

To remove a line item, click on the line in the list and then click **Remove**.

If you use the U.S. Version of NetSuite, you can charge taxes on a line item basis. For more information, see the help topic **Setting U.S. Tax Preferences**.

**Recalculating Line Item Amounts When the Tax Code Changes**

When you change the tax code on a line item, the system recalculates the amounts depending on the order of the columns on the form.

If the **Amount** column is before the **Gross Amt** column, then whenever you change the tax code on the line item, the system updates the value in the **Gross Amt** column based on the tax rate of the selected tax code. The value in the **Amount** column does not change.

If the **Amount** column is after the **Gross Amt** column, then whenever you change the tax code on the line item, the system updates the value in the **Amount** column, based on the tax rate of the selected tax code. The value in the **Gross Amt** column does not change.

For information about rearranging the order of the columns, see the help topic **Configuring Fields or Screens**.

**Entering Relationships on a Transaction**

You can associate contacts with a transaction by adding them on the Relationships subtab.

If you have the Multi-Partner Management feature enabled, you can associate partners with the transaction. For more information, see the help topic **Associating Partners With Customers and Transactions**.

The Relationships subtab shows only on transactions that involve working with customers, partners, or other entity records. Entity records include company, contact, vendor, and employee.

**To add contacts when creating a transaction:**

1. On the transaction page, click the **Relationships** subtab.
2. Under **Contacts**, enter the contact's name, title, email address, phone number, subsidiary, and role, and click **Add**.
3. Click **Save**.

You can also add contacts in view or edit mode after the transaction has been created.
Enter Communication Information on a Transaction

Use the Communication subtab to create and send messages to your customers. You can also create tasks, events, and phone calls and associate them with a transaction.

After you save the transaction, this information is combined on an Activities subtab. This enables you to track meetings and conference calls you schedule in the process of finalizing a sale.

Not all transaction records have a Communication subtab.

Attaching Messages to a Record or Transaction

You can add messages as HTML, PDF, letter, or fax attachments. You can also embed the transaction within the body of the message.

To attach messages as PDF, letter, or fax, you must have the Mail Merge feature enabled. For more information, see the help topic Working with Mail Merge.

The Communication subtab tracks all related email and faxes sent and received. For information on sending messages, see Sending Email from NetSuite.

Attaching Files to a Record or Transaction

You can attach documents in the File Cabinet to records and transactions using the Communication subtab. For more information, see Attaching Files to Records.

Attaching Events, Tasks, and Calls to a Record or Transaction

You can create and track activities directly from the transaction. For more information, see the help topic Attaching Events, Tasks, and Calls to Records and Transactions.

Adding User Notes to a Record or Transaction

To add any notes related to the record or transaction you are working with, on the Communication subtab, click the User Notes subtab. Then click New Note. The list permission Notes Tab controls access to the User Notes subtab. You need at least Create level access to see the New Note button and add a note.

Tips for Working with Transactions

Refer to the following sessions for tips when working with transactions:

- Customize
- Use Options
- Print, Fax, Email, and Copy
- Memorize
- Maintain
- Close
- View the General Ledger
- Use Shortcuts & Keyboard shortcuts
- Get help
Customize

- Most transaction forms can be customized by using the Customize menu at the top of the page. The appropriate permission is required to customize the form. If you do not see the Customize menu, your current role does not include the permission.
- Click List to open a list of all transactions of a specific type. From these lists, you can view and edit transactions, print and export your lists, and go to transactions’ registers. Your customization of the viewing and sorting of the list will retain for the future views. You can change the list sorting by clicking another column heading.
- Amount fields in transactions and records support computation. For more information, see Amount Fields.

Use Options

- Some fields on transaction forms display a double arrow button that you can click for the List, Search, and New options:
  - Click List to display a popup list of stored records from which to choose.
  - Click Search to search for a record.
  - Click New to open a window and create a new record for that field.
- On transactions and records that have buttons with a dropdown list, you can select a different button option. Use the Tab key to navigate to the dropdown button. Then use the Down Arrow key to expand the dropdown list. Click Enter to select the desired action. To collapse the dropdown list, use the Up Arrow key.
  For more information, see Using Popup and Dropdown Lists and Using Buttons in NetSuite.
- Click Add Multiple in the Items subtab to open the Choose Item window. This window displays a list of items you can add. You can filter the list by item type or search for all or part of a name. When you click an item in the left pane, it is added to the right pane, where you can enter a quantity for the item. When you click Done, items and quantities shown in the right pane are added to the transaction.

Print, Fax, Email, and Copy

- When you post a transaction, you can print, fax, or email a copy of the form:
  - Check the To Be Printed box to save the form in a queue for printing later.
  - Check the To Be E-mailed box and enter or verify an email address to email the form.
  - Check the To Be Faxed box and enter or verify a fax number to fax the form.
  Administrators configure the fax and print setup at Setup > Company > Preferences > Printing & Fax (Administrator). For more information, see the help topic Setting Printing and Fax Preferences.
  Administrators configure the e—mail setup at Setup > Company > Email > Email Preferences (Administrator). For more information, see the help topic Setting Email Preferences.
- When you view a transaction, you can make a copy of the transaction:
  - From the Actions list, select Make Copy to replicate all the information from the original transaction and link it to the original transaction.
    For example, if an invoice is created from a sales order, the value in the Created From field is copied to the new transaction. The new transaction is also displayed in the history of the original transaction.
  - From the Actions list, select Make Standalone Copy to make a copy of the original transaction that includes inventory costing but is not associated with the original.
For example, click **Make Standalone Copy** on a transaction that uses advanced shipping to create a cash sale or invoice that has the same items as the original and includes the cost of good sold (COGS) account impact in addition to revenue. Because a standalone copy is not linked to the original, it does not retain the value in the **Created From** field. The new transaction is not part of the history of the original transaction and is considered a brand new transaction.

**Memorize**

- Memorize a transaction to recall and use it again later. To memorize a transaction, go to the transaction type you want to memorize. Fill in the appropriate information on the form. From the **Actions** list, select **Memorize**. The Memorized Transaction page opens showing the information you entered. For more information, see Memorized Transactions.

**Maintain**

- To maintain performance, the limit for transactions submitted through the user interface is 500 lines. For transactions submitted through CSV import or SOAP web services, the limit is 5,000 lines per transaction.
- For journal entries, the limits are 1,000 lines for the user interface and for synchronous SOAP web services, and 10,000 lines for CSV import and asynchronous SOAP web services.

For more information, see Entering Transaction Line Items.

**Close**

- Close a line item on a transaction if you do not expect to fulfill or receive the item. To close a line item on a transaction, click **Edit** on the transaction. Click the line you want to close and then check the **Closed** box. Click **Done** and then click **Save**.
- Close an entire transaction so that it no longer has an open status. When you view sales orders, purchase orders, and return authorizations, click **Close** to check the **Closed** box for all lines on the transaction. Then when you click **Save**, the transaction is no longer open.

**View the General Ledger**

- To view the general ledger results of posting transactions, from the **Actions** list, select **GL Impact**. The details of the general ledger impact of lines on the originating transaction are displayed.

**Use Shortcuts & Keyboard shortcuts**

- Use the **Shortcuts** menu to place a shortcut link on your home page to frequently-used transactions. For more information, see Using the Navigation Menu.
- Transactions support many of the same keyboard shortcuts as other records. When using tabbed display, you can switch between subtabs by using keyboard shortcuts. Each subtab has a single letter underlined in the title. Press and hold the **Alt** key on your keyboard and then press the corresponding letter to switch to that subtab. The first field on the subtab is automatically selected. For information, see Using Keyboard Shortcuts.

**Get help**

- Click the **Help** link at the top of the page to get help specific to the transaction you are working with.
Click the field name to display a popup window with field level help.

**Important:** When processing transactions in bulk, you must submit one page at a time. If you do not process each page individually, information is not retained and can be lost when you click a different page.

## Finding Transactions

You can search for transactions in several ways.

**To review or edit an existing transaction, select from these five procedures:**

### Quick Find
1. On any Transaction page, click Quick Find at the top of the page.
2. When the Quick Find page pops up, enter some information to help you find this transaction or related group of transactions:
   - In the **Name** field, select the company or contact from the list whose transactions you'd like to find.
   - In the **Date** field, enter or pick the posting date of the transactions you'd like to find.
   - In the **Number** field, enter the number of the transaction you'd like to find.
   For example, enter **1135** to find check #1135.
3. Click Submit.

### Previous or Next
1. Click the Transactions tab.
2. Click the type of transaction you want to find.
3. On the transaction page, click **Previous** or **Next** until you see the transaction you want.
4. Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

### Go To Register
1. Click the Transactions tab.
2. Click the type of transaction you want to find.
3. On the transaction page, from the Actions list, select **Go To Register**.
4. If the transaction you want doesn't appear on the register, clear the Open box to see all transactions.
5. Click Submit.
6. On the full register, scroll to find the transaction you want.
7. Click the transaction date in the left-hand column to see the details.
   A view-only version of the transaction opens.
8. Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

### Search by Account
1. Go to Lists > Accounting > Accounts.
2. Click the name of the account with the transactions you want to see.
   For example, if you want to locate a recent invoice, click an **Accounts Receivable** account.
3. When the register appears, clear the Open box if you want to see all transactions.
4. Click Submit.
5. Scroll to find the transaction you want.
6. Click the transaction date in the left-hand column to see the details. A view-only version of the transaction opens.
7. Select the appropriate button to edit, print, email, credit, or otherwise work with this transaction.

■ Search Transactions
1. Go to Transactions > Management > Search Transactions. The type of search form you see is the type of search you last used to search for transactions.
2. If you see the search fields you want to use, enter criteria in the fields and click Submit for quick results.
3. If you do not see fields displayed, you are using Advanced Search Mode. If you are not in Advanced Search Mode and do not see the fields you want to use, check the Use Advanced Search box at the top of the page.
   a. In Advanced Search Mode, use the Criteria subtab to select the filters you want to use when searching.
   b. In the criteria popup, enter criteria for that filter.
   c. Click Add/Edit.
   d. On the Results subtab, you can select the fields from the resulting transactions that you want to see on your results list.
      Select a field, and click Add.

   Note: For a transaction search, adding a field that has multiple values for one record causes that record to occur multiple times in the search result. Also, if results include a record with a link type that has multiple values for that record, duplicates occur in results, even if the link type field is not included as a search results field.
   e. Click Submit to run the Search.

Voiding, Deleting, or Closing Transactions

You may need to change a transaction you have entered if it has errors or you do not intend to complete it. The following sections explain the differences between voiding, deleting, and closing transactions.

Important: Before you delete or void a posting transaction, check to ensure that the transaction is not part of a match on the Reconcile Account Statement page. You should not delete transactions that have been reconciled. For more information, see the help topic Viewing Matched and Submitted Transactions.

Voiding Transactions

Voiding a transaction sets its total and all its line items to 0 but does not remove it from the system. This is the preferred way to cancel an existing transaction because the audit trail is preserved. After you void a transaction, you cannot make changes that have general ledger impact to the original transaction, including changing the posting period.
If you void a transaction that was created to close another transaction, the original transaction is reopened. For example, if an invoice was created to bill a sales order, voiding the invoice reopens the sales order and sets the order's status to pending billing. Then you must invoice the order again. Another example is a bill payment that has been applied to a bill. If you void the bill payment, the bill is reopened. Another payment must be entered against the bill.

To void a transaction:

1. Open the transaction for editing.
2. Click Void.
   - If the preference to void transactions with a reversing journal entry has been enabled, only certain types of transactions can be voided. For more information, see the help topic Void Transactions Using Reversing Journals Preference.

Voided sales orders do not show on the Transactions subtab of customer records. To view voided sales orders, go to Transactions > Sales > Enter Sales Orders > List.

Additional help is available for some transaction types as follows:

- For information specific to check transactions, see the help topic Voiding a Check.
- For information specific to credit cards, see the help topic Voiding Credit Card Transactions.

Deleting Transactions

**Important:** If the Use Deletion Reason feature is enabled in your account, users must provide a reason for deleting transaction records. For more information about the feature, see the help topic Recording a Reason for Deleting a Transaction.

You may want to remove a transaction from the system entirely. For example, after entering a transaction you may realize it contains many errors. You can delete it and reenter the transaction.

From the Actions list on the transaction, select Delete. This option appears only if the Void Transactions Using Reversing Journals preference is not enabled. Only users with a role that has full permission to a type of transaction can delete that type of transaction. If you do not have the necessary permission, Delete does not appear on the Actions list.

If inline editing is enabled in your account and you have the necessary permission, you can delete transactions from the transaction's List page. Hover over the New column and click Delete Record from the menu that appears. For more information about inline editing, see Using Inline Editing.

If the Use Deletion Reason feature is enabled in your account, both deletion methods open a Delete popup window specific to the type of transaction being deleted. You must select a deletion reason and may optionally include a memo. If you select the deletion reason Other, you must include a memo. When you click Delete, the transaction record is removed from your system.

A deleted transaction does not retain a record of the transaction details. However, a record of the deleted transaction remains in your audit trail.

**Note:** You cannot delete a transaction if it is linked to other transactions. For example, you cannot delete an invoice that has been paid. You can, however, close linked transactions.

Closing Line Items and Transactions

You can manually close transaction line items when you do not intend to fulfill or receive open items on the order. For example, you sell 10 items to a customer and have already fulfilled five of them. Then
you discontinue the item and cannot fulfill the remaining five. If you close the line manually instead of changing the quantity, you retain a record of how many were ordered originally.

To close a line item on a transaction, click Edit on the transaction. Click the line you want to close, check the box in the Closed column and click Done. Then click Save.

**Note:** You must bill the sales order before you manually close the line. When all lines on a sales order are fulfilled or closed manually, the sales order is removed from the billing and receiving queues.

When you view sales orders, purchase orders, and return authorizations, click the Close or Close Remaining button to close the entire transaction. This action checks the Closed box for all lines on the transaction and changes the status of the transaction to Closed. You can reopen a closed transaction by clearing the Closed box for all lines on the transaction.

For specific information about sales orders, see the help topic Closing a Sales Order.

### Memorized Transactions

A memorized transaction is a transaction you set up to recur in NetSuite, such as recurring journal entries. Memorized transactions eliminate data entry and serve as useful reminders. A memorized transaction consists of two parts:

- **The Memorized Transaction Template** defines the transaction to be created.
- **The Memorized Transaction Definition** sets the parameters for when to create the transaction, whether they are recurring, and how many transactions to create.

When you memorize a transaction, you set up the transaction to recur over time. You choose whether the transaction automatically posts or if you are reminded to post it. Set the frequency the transaction should occur and set posting options. You can specify that the transaction should recur forever or a set number of times.

When you edit or delete a memorized transaction, the change is tracked on the system notes of the memorized transaction.

The following are limitations for posting memorized transactions in locked and closed periods:

- A user must have the Override Period Restrictions permission to enable the Allow Posting in Locked Period option for a memorized transaction. When this option is enabled, memorized transactions can post in locked periods even if users initiating these transactions do not have the Override Period Restrictions permission.
- Transactions can never be posted in closed periods. If the posting date for a memorized transaction is in a period that has been closed, it is posted to the next open period.

In NetSuite, you can memorize the following transactions:

- Checks
- Deposits
- Credit Cards
- Purchase Orders
- Bills
- Sales Orders
Working with Transactions

- Invoices
- Estimates
- Cash Sales
- Journal Entries
- Statement Charges
- Work Orders
- Purchase Requisitions
- Transfer Orders
- Opportunities
- Custom Transactions

The Reminders portlet includes a standard reminder for Memorized Transactions due. For more information, see the help topic Setting Up Reminders.

After you have memorized a transaction, you can view and manage transactions created by the memorized transaction by going to Transactions > Management > Enter Memorized Transactions. Click Edit next to the transaction. The Transactions subtab shows associated transactions.

The time when the system runs memorized transactions varies by location, but is usually shortly after midnight each day. The system checks for memorized transactions every four hours, and processes them according to the start date. If the start date is the current day, the system processes the transaction immediately, and then at the usual time each day afterward. If the start date is in the future, the system processes the transaction at the usual time on that future date, and each day afterward. If the start date is in the past, the system processes a transaction for each past day every four hours until caught up to the current day, then processes a transaction at the usual time each day afterward.

By default, when NetSuite creates a memorized transaction automatically, it lists the last user who edited the memorized transaction definition as the user who created the transaction. This user is visible in the memorized transaction definition. To list the user as –System- for automatic memorized transactions, set the Create Automatic Memorized Transactions as –System- preference at Setup > Company > Preferences > General Preferences (Administrator). Changes to this preference take effect when you create a new memorized transaction definition or you edit and save an existing one. For more information, see the help topic Setting General Account Preferences.

**Note:** When set, this preference does not support server-side scripting. If you want to use server-side scripting and SuiteFlow on transactions, disable the preference.

For specific instructions, see the following topics in this section:

- Memorizing a Transaction
- Submitting Memorized Transactions
- Editing Memorized Transactions
- Customizing the Memorized Transactions List
- Viewing the Status of Memorized Transactions
- Deleting Memorized Transactions

**Memorizing a Transaction**

For a list of the types of transactions you can memorize, see Memorized Transactions.
When you create a memorized transaction, the update is tracked on the system notes of the memorized transaction.

**To memorize a transaction:**

1. **Edit the transaction you want to memorize, and make sure the appropriate information is filled in.**
   - Posting transactions that contain serial or lot numbers cannot be memorized. This includes creating invoices, entering cash sales, and fulfilling sales orders.
   - Non-posting transactions with serialized or lot items can be memorized, as long as the serial or lot numbers are not entered on the transaction. This includes preparing estimates and entering sales orders.
   
   Memorized non-posting transactions with serialized items require serial numbers to be entered at item receipt or fulfillment time. For example, you create a sales order that includes a serialized item but do not enter the serial number for that item. Later, when you fulfill that sales order, you will be required to enter the serial number for the serialized item.
   - If you select to email or fax your customer, your customer automatically receives an email or fax each time the memorized transaction occurs.
   - If you enter credit card payment information, this credit card is automatically charged each time the memorized transaction occurs.

2. **From the Actions list, select Memorize.**
   
   When the Memorized Transaction page opens, the payee, vendor, customer, or project name you selected when entering your memorized transaction appears in the Name field.

3. **If you want to change the name of the memorized transaction, enter a new Name.**
   
   The name you enter appears in the list of memorized transactions but does not affect the name you entered on the original transaction.

4. **Choose one of three options in the Action dropdown list in the Primary Information section:**
   - Choose Template Only if you want to create a memorized transaction that will be used as a template, but will not create any actual transactions.
   - Choose Reminder if you want to be reminded when this transaction is due so that you can view and edit it before you save it.
   - Choose Automatic if you want this transaction to automatically post. For information about this option, see Automatic Memorized Transactions.

5. **Check the Inactive box to prevent the memorized transaction from creating any more transactions.**

6. **Check the Override Transaction Date box if you do not want the transaction to post on the creation date. Then you must do the following:**
   - In the Next Date field in the Recurring subtab, enter the next date you want the transaction to be generated.
     
     If you want this transaction to automatically occur, you must enter a next date here. If you do not enter a next date, the transaction will not automatically post.
   - In the Next Transaction Date field beside Next Date, enter the date you want the transaction to post.
     
     For example, today's date is 7/15. You want the first transaction to be generated on 7/16 and to post on 7/20. Check the Override Transaction Date box and enter 7/16 in the Next Date field and 7/20 in the Next Transaction Date field beside Next Date.

7. **Check the Allow Posting in Locked Period box to enable the transaction to post to an accounting period for which transactions are locked. You must have the Override Period Restrictions permission to check this box.**
When this box is checked, memorized transactions can post in locked periods even if the user who initiates the transaction does not have the **Override Period Restrictions** permission. Transactions can never be posted in closed periods. If the posting date for a memorized transaction is in a period that has been closed, it is posted to the next open period. For more information, see the help topic **Accounting Period Management**.

8. Check the **Update Addresses** box to have the memorized transaction use the customer email, fax, and address information that is current as of the date the transaction is created. This option applies only to addresses on the customer record. Any other addresses, such as those included in the To Be Emailed list, must be updated manually.

9. Check the **Update Prices** box to have the memorized transaction use sales pricing that is current as of the date the transaction is created.

10. There are two options for setting the frequency of the memorized transaction:

    ![Note:](image) You will not be able to set a frequency if you selected **Template Only** in the Action list in the Primary Information section.

    - To create recurring transactions based on a number of occurrences within a time period, enter the following in the **Recurring** subtab:
      - Select the **Next Date** on which the memorized transaction will create a new transaction.
      - Select the number of times in a time period a transaction will be created in the **Repeat Every** field.
      - Select the **Time Period** over which transactions will be created.
      - Enter the total number of transactions which should be created in the **Number Remaining** field. If you do not want to set a limit on the number of transactions created, clear the field and check the **Indefinite** box.
      - If you checked the **Override Transaction Date** box in the **Primary Information** subtab, enter the **Next Transaction Date** on which you want the transaction to post.

    - To create transactions on specific dates, enter the **Next Date** to generate a transaction in the **Custom Dates** subtab and click **Add**. If you checked the **Override Transaction Date** box in the **Primary Information** subtab, enter the **Next Transaction Date** on which you want the transaction to post.

    The frequency determines how often you receive the reminder if you choose **Remind Me**. If you choose **Automatic**, it determines how often the transaction occurs.

    ![Note:](image) If **Monthly** is selected, and the **Next Date** selected is the last day of a month, NetSuite will schedule all following transactions for this memorized transaction for the last day of each month. For example, if you select a Monthly frequency and set the Next Date as 2/28/2019, subsequent transactions will occur on 3/31/2019 and 4/30/2019.

    If you want your transactions to occur on the 28th, 29th, 30th, or 31st of every month, set up a custom frequency in the Custom Dates subtab.

11. When you have finished, click **Save**.

12. If you clicked **Automatic** for this memorized transaction, you will be prompted to continue. Click **OK**.

    Your memorized transaction is saved.

After you create a memorized transaction, you can review it in the following ways:

- Go to Transactions > Management > Enter Memorized Transactions > List. Select it from the list.
Go to Transactions > Management > Enter Memorized Transactions. Click View or Edit next to the transaction.

Go to your NetSuite Home page and click the reminder you set up.

Clicking the reminder takes you to a list showing memorized transactions that are currently due. To see all your memorized transactions, check the Show All box and click Refresh.

To view a list of memorized transactions due to be entered, go to Transactions > Management > Enter Memorized Transactions.

**Automatic Memorized Transactions**

If an error occurs when automatically executing a transaction, NetSuite generates an alert message and changes the memorized transaction from Automatic to Remind Me. In this case, the transaction will no longer be automatically generated. You must determine the cause of the error, then update the transaction to correct the problem. After you update the memorized transaction, you can again select the Automatic option on the memorized transaction. The memorized transaction will run automatically on the next scheduled date.

For example, an account used in a memorized journal entry has become inactive. You receive an alert that the transaction cannot be run. Update the journal entry with an active account number. Then select the Automatic radio button on the memorized transaction to reset the journal entry to execute as scheduled.

**Submitting Memorized Transactions**

After you have set up memorized transactions you can submit all transactions due to be posted at one time.

To create memorized transactions, see Memorizing a Transaction.

**To submit memorized transactions:**

1. Go to Transactions > Management > Enter Memorized Transactions.
2. On the Enter Memorized Transactions page, use the following filters to show transactions in the list:
   - **Date**
     Enter or select the date you want these transactions to post.
     The current date defaults in this field.
   - **Use Next Date**
     Check this box to use the date of the next scheduled occurrence of the transaction as the posting date. For transactions without a next date, the current date is used.
     When this box is unchecked, the current date shows in the date field and is the posting date.
     NetSuite remembers your preference for this box and checks or clears it the next time you use this form.
   - **Has Remaining**
     - Select Yes to show only transactions with remaining scheduled occurrences.
     - Select No to show transactions with no remaining occurrences.
     - Select All to show all memorized transactions.
   - **Next Date**
     - Select a date range to filter the list to show only transactions whose Next Date falls within this range.
Working with Transactions

3. To edit an individual transaction, click its **Edit** link.

4. To process several memorized transactions at one time, check the box in the Enter column next to each transaction you want to process.

   You can also choose to click the **Enter** link next to a transaction to enter it individually.

5. To change all memorized transactions from Automatic to Remind Me, or from Remind Me to Automatic at the same time, click **Switch Action**.

6. Click **Submit**.

   A list of the new transactions shows on the Processed Transactions page.

**Note:** There must be at least ten transactions for NetSuite to split the transactions into multiple workqueues.

To view a list of all memorized transactions, go to Transactions > Management > Enter Memorized Transactions > List.

**Important:** When the Allow Posting in Locked Period option is enabled for a memorized transaction, transactions can post in locked periods even if users initiating these transactions do not have the Override Period Restrictions permission. Transactions can never be posted in closed periods. If the posting date for a memorized transaction is in a period that has been closed, it is posted to the next open period. For more information, see the help topic Accounting Period Management.

**Editing Memorized Transactions**

You can make name, type, and schedule changes to a memorized transaction. You can also specify posting options and update addresses to ensure that your information is accurate. However, if the field that you want to edit on the memorized transaction is **dimmed or not included on the page**, you must create a new original transaction and then memorize that transaction.

Some details that appear on the Memorized Transactions page at Transactions > Management > Enter Memorized Transactions > List do not appear when you edit the transaction. For example, the transaction amount appears on the Memorized Transactions page, but not when you edit the transaction. You can edit such fields on the original transaction. For more information, see Working with Transactions.

When you edit a memorized transaction, the change is tracked on the system notes of the memorized transaction.
To edit specific details of a memorized transaction:

1. Go to Transactions > Management > Enter Memorized Transactions > List.
2. Click Edit next to the transaction you want to change. For a description of the fields, see Memorizing a Transaction.

   Note: You must have the Override Period Restrictions permission to enable the Allow Posting in Locked Period option. After this option is enabled, memorized transactions can post in locked periods even if users initiating these transactions do not have the Override Period Restrictions permission. Transactions can never be posted in closed periods. If the posting date for a memorized transaction is in a period that has been closed, it is posted to the next open period. For more information, see the help topic Accounting Period Management.

3. Make the appropriate changes and then click Save.

Your memorized transaction is now updated with the current information.

Customizing the Memorized Transactions List

When you view the Memorized Transactions list, you can customize the list view to show columns with additional information. For example, you can display whether transactions are set to be emailed.

To customize the memorized transactions list:

1. Go to Transactions > Management > Enter Memorized Transactions > List.
2. Click Customize View.
3. If the Results subtab is not displayed, click the Results subtab.
4. Select additional fields or change existing ones using the lists in Fields column.
   To display whether transactions are set to be emailed, for example, select Transaction Fields...
   and then in the Transaction Field list in the popup window, select To Be Emailed.
5. When you have finished with a row, click Add or OK.
6. When you finished your changes, click Save.

The Memorized Transactions list is a list view similar to other in NetSuite. For more information about how you can customize lists, see Customizing List Views.

Viewing the Status of Memorized Transactions

You can view the status of memorized transactions by going to Transactions > Management > Enter Memorized Transactions > Status.

Each scheduled memorized transaction is shown along with the status. The statuses include:

- **Complete** – The transaction has been successfully created.
- **Failed** – The transaction was not completed due to an error.
- **Pending** – The transaction has been queued and will be processed in turn.
- **Processing** – The transaction is currently being created.

If a memorized transaction fails, an Error link is shown in the View Result column. Click this link to open the error message that explains why the memorized transaction process failed.
You can customize the list of memorized transactions by clicking Customize View.

### Deleting Memorized Transactions

You can delete a memorized transaction if you no longer want it to recur. Deleting a memorized transaction does not delete the associated transactions.

When you delete a memorized transaction, the change is tracked on the system notes of the memorized transaction.

**To delete a memorized transaction:**

1. Go to Transactions > Management > Enter Memorized Transactions > List.
2. Click **Edit** next to the transaction you want to delete.
3. From the **Actions** list, select **Delete**.

   **Note:** If you do not see the Actions list with a Delete option, your role does not have the correct permission level. You must have Full access level for the Memorized Transactions permission to delete a memorized transaction.

   NetSuite prompts you to confirm the deletion.

4. Click **OK**.

### Preferred Transaction Delivery on Customer and Vendor Records

Because each customer and vendor can have an individual preference for how to receive transactions, you can set a preferred transaction delivery method on their records as the default way to deliver transactions to them.

On each customer and vendor record, define their preferred way to receive transactions: by regular mail (printing), by email, by fax, or by a combination of the three. Then, the preferred delivery method is marked by default in the following situations:

- on transactions when you select that customer or vendor
- on transactions created from that customer or vendor record
- on transactions that are copied or converted from a transaction that uses these settings

   For example:
   - If you click Make Copy on an invoice, then the delivery preferences default from the customer record on the new copy of the invoice.
   - If you click Bill on a sales order, then the delivery preferences default from the customer record on the bill that is created.

**To define the preferred transaction delivery method on entity records:**

1. Open the entity record.
   - For Customers: Go to Lists > Relationships > Customers > New. Click **Edit** next to the customer whose record you want to update.
For Vendors: Go to Lists > Relationships > Vendors > New. Click Edit next to the vendor whose record you want to update.

2. Click the Preferences subtab.

3. Next to Send Transactions Via, check the appropriate boxes:
   - Email – Check this box to check the To Be Emailed box by default on transactions when this entity is selected.
   - Print – Check this box to check the To Be Printed box by default on transactions when this entity is selected.
   - Fax – Check this box to check the To Be Faxed box by default on transactions when this entity is selected.

4. Click Save.

After you save these settings on their record, these boxes are checked by default.

Note: These settings override any customized settings on transaction forms you use.

For more information about printing and emailing transactions, see Printing Checks and Other Transactions and Emailing Transactions.

For more information on setting up customer and vendor records for preferred transaction delivery, see the help topics Preferred Transaction Delivery on Customer Records and Preferred Transaction Delivery on Vendor Records.

You can also set values these fields using the Mass Update function. For information, see the help topic Mass Changes or Updates.

Printing Checks and Other Transactions

You can print transactions as you enter them, or you can print a group of similar transactions at the same time. Transactions can be printed in HTML or PDF format. This topic includes general instructions for printing transactions. For information about printing specific transactions or records, see the help topic for the specific transaction or record:

- Printing Bar Code and Item Labels
- Printing Checks
- Printing Deposit Slips
- Printing Direct Deposit Vouchers
- Printing a Picking Ticket
- Printing a Sales Receipt
- Printing Shipping Labels
- Printing an Invoice

To print PDF files, you must install Adobe Reader. Visit the Adobe website to download the latest version at no charge.

Your administrator can customize the layout of your printed forms using Advanced PDF/HTML templates. For information, see the help topic Advanced PDF/HTML Templates.

If you print using PDF, files open in the default Adobe application. You can also download files and save them to print later. To do this, go to Home > Set Preferences and check the Download PDF Files box.
You can print transactions on blank paper, or you can purchase compatible customized checks and forms from the Forms Fulfillment Center, a NetSuite partner at www.netsuiteforms.com.

⚠️ **Important:** If the Multi-Language feature is enabled in your account, you can choose from different languages for printed transactions. However, only the system-supported languages available in user preferences are supported because pre-translated strings are provided for general terms in these languages. Additional languages that are available as company preferences are not supported for printed transaction forms, but they are supported for website translations. For more information, see the help topic Configuring Multiple Languages.

**To print an individual transaction:**

1. Go to the transaction you want to print and fill in the appropriate information.
2. When you have finished, click **Save & Print**.
   
   Your transaction is saved, and a preview of the printed transaction opens.

   🔄 **Note:** To print an existing transaction in view mode, click the print icon 🌐.

3. To print:
   - If you print using HTML, click **Print** on your browser.
   - If you print using PDF, click **Print** in Acrobat Reader.
   
   If you have the Download PDF Files preference enabled at Home > Set Preferences > General, you must save the PDF to your computer and open it from there to print it.

**To print multiple similar transactions:**

On each transaction record that you want to print, you must mark the record to be printed. To do this, check the **To Be Printed** box. The location of this box depends on the type of transaction. For example, on the check record, this box appears in the header of the record. For a purchase order, this box appears on the **Messages** subtab.

After you have saved the transaction records, you can print them all at one time.

1. Go to Transactions > Management > Print Checks and Forms.
2. Click the name of the transaction you want to print.
3. Check the box beside each transaction you want to print, or click **Mark All** to select and print all transactions in the list.
   
   If the list has multiple segments, use the **From – To** dropdown list to see a different set of records.
4. Click **Print**.
5. When the preview page opens:
   - If you print using HTML, click **Print** on your browser.
   - If you print using PDF, click **Print** in Acrobat Reader.

**Emailing Transactions**

Email is now the accepted method of sending transactions to customers for the vast majority of users. With NetSuite you can email the transaction directly from the active screen. NetSuite automatically saves a copy of the message and records the audit trail. Users with the Email Templates and Custom Transaction Forms permissions can select which transaction email template to use for each transaction type when
sending transaction emails with a PDF attachment. For information about determining the content of the email message, see the help topics Working with Email Templates and Assigning an Email Template to a Transaction Type.

No special permission is required to email a transaction, but your account be set up to enable the action. An administrator must do the setup. For information, see the help topic Setting Email Preferences.

Following are methods to email a transaction:

- To send the transaction by email as you complete or edit it, select Save & Email from the Save menu.

Save & Email verifies that the To Be E-Mailed box is checked and the field contains an email address. The box and field are located on the Communication > Messages subtab of the transaction record.

The To Be E-Mailed box must be checked and the field must contain an email address. If the field is blank, NetSuite prompts you to provide an email address. If the field contains an email address, the Save & Email method immediately saves the transaction and sends an email message with the transaction.

The default address in the To Be E-Mailed field is the email address specified in the header of the customer or vendor record. The box is automatically checked when the Email box is checked on the Preferences subtab of the entity record.

A log of sent transaction email, including any attachments is viewable from the entity record on the Communication > Messages subtab. A list of sent email is also available in the same location on the transaction record. To view the list, your role must include at least View level access to the Track Messages permission.

For information on how to set up a history log of all recently sent transaction email, see Creating a Sent Log for Transaction Email.

- To send the transaction to one or more specific email addresses, go to the Communication > Messages subtab, check To Be E-Mailed. Enter the email address you want to send the transaction to. Separate multiple addresses with semicolons. Optionally, you can select a standard message from the Select Message list or type a message in the Customer Message field.

To send a saved transaction by email in view mode, from the Actions list, select Email.

**Note:** Transactional email is not subject to monthly send limits. You can send an unlimited number of transactional email messages during the month.

### Sending Transaction Email in Bulk

Bulk transaction email can be generated from scriptable templates and can include attachments. Sending transaction email in bulk is useful if, for example, you want to send reminder email for multiple transactions for which payments have not been received. You enter search criteria to generate a list of transactions and then select which transactions you want to send email for.
To send transaction email in bulk:

2. Click Transactions to expand the mass update options.
3. Click Bulk Email.
   The Mass Update page opens.
4. On the Criteria subtab, define the transactions you want to send email for using the Filter dropdown list. For example, you can create a list of all unpaid invoices by doing the following:
   a. Select Type in the Filter column.
   b. In the popup window, select Invoice, and click Set.
   c. In the next row, select Status in the Filter column.
   d. In the popup window, select Invoice:Open, and click Set.
5. On the Recipients subtab, select which email address to use and the order in which the email fields are searched.
   For example, in the screenshot below NetSuite first searches for an email address in the transaction record. If none is found, NetSuite searches for an email address in the customer record. If none is found, the email address in the contact record is used.

Transaction Email refers to the email field that appears on the Communication subtab of a transaction such as a sales order.
Customer Email refers to the email field on the main Customer record page.
Contact Email refers to the email address related to the named contact within the company.
6. On the Message subtab of the Mass Update form, select the scriptable template to use or enter the text for the message in the Message field. Templates can be up to 4 MB in size.
7. Do one of the following:
   - Click Preview to view a list of transactions that match your search criteria.
   - Click Save to save this mass update to use later.
   When you click Preview, the Mass Update Preview Results page opens with a list of the transactions that match your criteria.
8. In the Apply column check the transactions for which to send email.
9. Click Perform Update.
Creating a Sent Log for Transaction Email

You can keep track of what email has been sent to a particular entity by looking at the log found in the Communication > Messages subtab of that record. You can also view a log of all recently sent transaction email messages by creating a simple saved search. For example, you might want to check that a bulk mailing of invoices was successfully delivered to their recipients.

To create a sent log for bulk transaction email:

1. Go to Lists > Search > Saved Searches > New.
2. Select Message.
3. Selecting items from the Filter dropdown list, add the following:
   a. Date – Specify the required date range for the search.
   b. Subject – Add any text which the transaction email is likely to contain in the subject header, for example “invoice”.
   c. Attachment Fields – Select File Type and specify what type of file was attached to the transaction mail, for example PDF.
4. Click the Preview button to check the search returns the expected results.
5. Add a Search Title and check the Public box if you want to make this search available to other users.
6. Click Save.

Transaction Detail Report

A Transaction Detail report lists, in chronological order, all transactions entered during a specific time period. Both posting and non-posting transactions are included.

To view this report, your role must include the Transaction Detail report permission.

The report includes the following columns:

- **Type** - the type of transaction
- **Date** - transaction date
- **Document Number** - a reference number (like an invoice number)
- **Name** - a name (of a vendor, customer or employee)
- **Memo** - a memo
- **Account** - the general ledger account associated with the transaction
- **CLR** - a notation whether the transaction has cleared your bank account
- **Split** - the other account involved in the double-entry bookkeeping notation. If more than one account was used to offset this distribution, you see the notation -Split-.
- **QTY** – the quantity
- **Amount** - amount (the transaction amount or transaction line amount)

To see a Transaction Detail report:

Go to Reports > Financial > Transaction Detail.
A message appears indicating that your report is loading. The status bar indicates the progress as your report loads. You can click Cancel Report to stop the report from loading.

Transaction Detail Workbook

SuiteAnalytics Workbook offers many workbook and dataset templates, each with predefined source data, criteria, pivot tables, and charts.

This section contains the information for the SuiteAnalytics Transaction Detail workbook in NetSuite. For more information about SuiteAnalytics Workbook, see Workbook and Dataset Templates.

- Transaction Detail Dataset
- Transaction Detail Workbook

Transaction Detail Dataset

This template combines fields from the Transaction and Transaction Line record types to list all transactions entered during a specific time period. It forms the source data for the Transaction Detail Workbook.

Dataset Configuration

The Transaction Detail dataset combines fields from two record types and multiple criteria filters. To edit the dataset, see the help topic Defining a Dataset.

<table>
<thead>
<tr>
<th>Root Record Type</th>
<th>Joined Record Type</th>
<th>Custom Formula Fields</th>
<th>Data Grid</th>
<th>Criteria Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction</td>
<td>Transaction Line</td>
<td>(none)</td>
<td>The following fields are included in the dataset.</td>
<td>The following criteria is used to filter the dataset:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transaction: Date</td>
<td>Transaction: Date on or after start of this month</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Internal ID</td>
<td>Transaction Accounting Line: Amount (not consolidated) is not empty</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transaction</td>
<td>Transaction Accounting Line: Accounting Book is Primary Accounting Book</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Type</td>
<td>Account: Type none of &lt;NO VALUE&gt;, Non Posting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transaction Line:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Amount (Transaction Currency)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Entity</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Memo</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Subsidiary</td>
<td></td>
</tr>
</tbody>
</table>

If using Multi-Book Accounting, a Primary Accounting Book filter is also included by default.

Transaction Detail Workbook

The Transaction Detail Workbook for SuiteAnalytics Workbook by default includes the same fields as the Transaction Detail Report in NetSuite, but can be further modified to provide more data. The report lists, in chronological order, all transactions entered during a specific time period. Both posting and non-posting transactions are included.
As with all standard workbooks, only Administrators can access the Transaction Detail Workbook.

This workbook includes the following pivot tables:

- **Transaction Overview** — The default definition includes a row for account type and a Transaction Count measure and a grand total of all accounts.

- **Account Turnover** — For OneWorld accounts. The default definition includes a row for Account, a Subsidiary column, and Amount (Sum) measures.

**Limits for Display of Transaction Lists and Sublists**

When working with transactions in NetSuite, the number of records, transactions, or rows of data that can be accessed at one time is limited to 10,000. This limit applies to all transaction types unless otherwise stated. For example, the maximum number of lines that can appear on a transaction record’s sublist is 10,000.

For example, if you know that you have more than 10,000 invoices, use the Customize button on the sublist to filter the invoices that are listed. For example, when working with the Credit Memo record, you can click the Customize button on the Apply sublist to narrow the list of invoices.

For more information about transaction line limits, see [Line Limitations for Transactions](#).

**Note:** The limits for submission of transactions are different than the limits for display of transactions. The limit for transactions submitted through the user interface is 500 lines per transaction. For transactions submitted through CSV import or SOAP web services, the limit is 5,000 lines per transaction.

For journal entries, these limits are 1,000 lines for the user interface and synchronous SOAP web services, and 10,000 lines for CSV import and asynchronous SOAP web services.

**Line Limitations for Transactions**

In NetSuite, there are specific limitations for lines when working with transactions. You should follow these limitations, otherwise the system may not perform the requested action. The line limitation applies to creating transactions, importing transactions (CSV, SOAP, user interface, and SuiteScript), and displaying transactions.

See one of the following tables with specific line limits for different transaction interactions:

- **Limitations for Creating Transactions**
- **Limitations for Importing Transactions**
- **Limitations for Displaying Transactions**

**Limitations for Creating Transactions**

When creating a transaction, the total number of lines per transaction should not exceed the following limits:

<table>
<thead>
<tr>
<th>Type of Transaction</th>
<th>Line Limit</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense Allocation Schedules</td>
<td>10,000</td>
<td>Creating Expense Allocation Schedules</td>
</tr>
</tbody>
</table>
### Limitations for Importing Transactions

To maintain performance, when you import transactions, the total number of lines per transaction should not exceed the following limits:

<table>
<thead>
<tr>
<th>Type of Transaction</th>
<th>CSV Import</th>
<th>SOAP Import</th>
<th>User Interface Import</th>
<th>SuiteScript Import</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>5,000</td>
<td>5,000</td>
<td>500</td>
<td></td>
<td>Transactions Import Type</td>
</tr>
<tr>
<td>Software Vertical Contract Renewals</td>
<td>5,000</td>
<td>5,000</td>
<td>500</td>
<td></td>
<td>Contract Renewals Best Practices</td>
</tr>
<tr>
<td>Single Inventory Worksheet Import</td>
<td>1,000</td>
<td></td>
<td></td>
<td></td>
<td>Single Inventory Worksheet Import</td>
</tr>
<tr>
<td>Sales Orders</td>
<td>1,000</td>
<td></td>
<td></td>
<td></td>
<td>Sales Orders</td>
</tr>
<tr>
<td>Journal Entries</td>
<td>10,000</td>
<td>Synchronous 1,000</td>
<td>10,000</td>
<td>10,000</td>
<td>You may notice a performance impact during import and in the user interface for journal entries with over 1,000 lines. For more information, see the help topic Making Journal Entries. Intercompany Journal Entry Body and Sublist Fields</td>
</tr>
<tr>
<td>Intercompany Journal Entries</td>
<td>10,000</td>
<td>Synchronous 1,000</td>
<td>10,000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Limitations for Displaying Transactions

When working with transactions in the NetSuite UI, the number of records, transactions, or rows of data that can be accessed at one time should not exceed the following limits:

<table>
<thead>
<tr>
<th>Type of Transaction</th>
<th>CSV Import</th>
<th>SOAP Import</th>
<th>User Interface Import</th>
<th>SuiteScript Import</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software Vertical Contract Renewals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single Inventory Worksheet Import</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Orders</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Journal Entries</td>
<td></td>
<td>Synchronous 1,000</td>
<td>10,000</td>
<td>10,000</td>
<td>You may notice a performance impact during import and in the user interface for journal entries with over 1,000 lines. For more information, see the help topic Making Journal Entries. Intercompany Journal Entry Body and Sublist Fields</td>
</tr>
<tr>
<td>Intercompany Journal Entries</td>
<td></td>
<td>Synchronous 1,000</td>
<td>10,000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Working with Transactions

<table>
<thead>
<tr>
<th>Type of Transaction</th>
<th>Line Limit</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transactions</td>
<td>10,000</td>
<td>Limits for Display of Transaction Lists and Sublists</td>
</tr>
<tr>
<td>Sublists on iPhone records</td>
<td>300</td>
<td>Working with Sublists</td>
</tr>
<tr>
<td>Software Vertical Contract Renewals</td>
<td>10,000</td>
<td>Contract Renewals Best Practices</td>
</tr>
<tr>
<td>Gross Requirements Inquiry</td>
<td>1,000</td>
<td>Gross Requirements Inquiry</td>
</tr>
<tr>
<td>Generate China VAT Transactions</td>
<td>10,000</td>
<td>Known Limitations of NetSuite China Localization</td>
</tr>
<tr>
<td>China Subledger Report</td>
<td>5,000</td>
<td>Known Limitations of NetSuite China Localization</td>
</tr>
<tr>
<td>China Cash &amp; Bank Journal Report</td>
<td>5,000</td>
<td>Known Limitations of NetSuite China Localization</td>
</tr>
</tbody>
</table>

### Working with Lists

You can use NetSuite lists to access individual records or to work with multiple records at one time. The location and access of lists of records depends on the role you use to log in. Only the Administrator role has access to all record types. For more information about permissions, see the help topic [NetSuite Permissions Overview](#).

To access lists of records, go to Lists tab and select a relevant list.

You can do the following with most lists:

- Select a preconfigured view from the View list or click Customize View to create your own. See [Working with List Views, Sublist Views, and Dashboard Views](#).
- Click a button near the top to create a new record to add to the list, New Customer in this example.
- Expand the Filter area to show and use the filters provided.
- Select an option from the Style dropdown list.
- Use the controls in the row at the top of the list to do the following:
  - Click one of the export icons to export the list as a CSV, Microsoft Excel, or PDF file.
  - Click the print icon to print the list.
  - Check the Show Inactives box to see inactivated records.
  - Select an option in the Quick Sort list.
  - Large lists of records may be broken down into smaller sections. Use the dropdown list to see a different page of records. Use the left and right arrows to move forward and back in the list.
- Click a column heading to sort the list by that column.
- Click Edit next to a name to make changes to the record.
- Click View or the name to view the record.

When the Inline Editing feature is enabled, click the Edit switch in the list toolbar to edit fields directly in the list. See Using Inline Editing.

For more information about filling in the fields on a record page, see NetSuite Record Pages.

Exporting Lists

You can export NetSuite lists as files that you can open in external applications. The toolbar at the top of the list has icon buttons to support the following file export types:

- Click (Export - CSV) to export results to a CSV file.
- Click (Export - Microsoft® Excel) to export results to an XLS file.
- Click (Export - PDF) to export results to a PDF file.

**Note:** If your account administrator enabled the Tableau® Workbook Export feature and assigned you the corresponding permission, your list toolbar also contains the Export to Tableau Workbook icon.

For results exported to a CSV or XLS file, you may save the file or open it immediately in Microsoft Excel. For results exported to a PDF file, the file opens immediately.

Internal ID field values are generated by the NetSuite system for each record. These values, which serve as unique identifiers, are always included as a results column in the list to be exported.

Each export format has advantages and limitations. Review the limitations before selecting a preferred format. The format you select can affect data accuracy and report readability. For details on the export formats and their limitations, see Comparing Export Formats.

**Known Excel Limitation for Values with More Than 16 Digits**

When you open a CSV file directly, Excel treats long numeric sequences as numbers and displays them using scientific notation. This treatment leads to a loss of precision when the number has more than 16 digits and to lost information when digits beyond position 16 are truncated. Even when the text is qualified by apostrophes or double quotes, it is recognized by Excel as a number. To avoid this limitation, open CSV files using the Excel multistep Text Import Wizard. The wizard enables you to set column formatting in the last step ("Text" format).

Using Inline Editing

Inline list editing enables you to update records quickly by changing data directly in a record's row on the list page. This capability supports faster and easier editing because you do not have to go into each individual record to edit it. Addresses cannot be edited on list pages using inline editing.

Inline list editing is available when the Inline Editing feature is enabled. To enable the feature, go to Setup > Company > Enable Features. On the Company subtab in the Data Management section, check the Inline Editing box and click Save.
To use inline editing:

1. Use the Edit switch at the top of the page to turn on inline editing. When editing is off, the switch displays an x.

![Vendors](image)

When editing is on, the switch has a green check.

![Vendors](image)

The list page refreshes to display an edit icon in each column header that contains editable fields.

**Important:** Columns that display an edit icon in the header may include field values that are not available for the inline editing due to data validation that prevents editing generally. The edit icon does not mean that you can use inline editing for every field in the column.

2. Click the field where you want to enter or change information.
3. Click away from the field to save your changes.

The data is automatically saved on that record.

Use the following keystrokes to navigate editable fields:

- Press Tab to move right.
- Press Shift+Tab to move left.
- Press Shift+Enter to move up.
- Press Enter to move down.
- Press Alt+X to edit the first editable field on the page.
- Press Ctrl+Z to revert the value in a field back to the previous value.
- Press Esc when you are done editing a field to save the new value and close the field.

You can also use the following tools to increase your data entry performance when inline editing is enabled:

- Edit the same field on multiple records by pressing Ctrl and holding it as you select multiple fields.
- Click Add above the list to open a Quick Add popup window for the current record type.
Click the icon in the **New** column to open menu of related records. Select an option to create the new record on a separate page. The icon appears when you move your pointer over the column.

If you change many field values in one session using inline editing, NetSuite may have to update multiple records simultaneously. In this case, you may receive the following message: “Too many inline edits. Please wait a few seconds and try the edit again.” You should be able to complete your most recent edit after a brief wait.

**Additional Notes about Inline Editing**

- **Edit and Customized List Views**
- **Limitations for Inline Editing on Referenced Fields**
- **Additional Setup Option for Custom Search Portlets**
- **Allow Editing Option for Custom Records Is Unrelated**

**Edit and Customized List Views**

You can customize the list view to display certain fields from a record type on the list page. For more information, see [Customizing List Views](#). Note that if the Use Expressions option is enabled for a search, inline editing is disabled in list, dashboard, and sublist views based on the search. If you want inline editing to be available for a view, ensure that the Use Expressions box on the Criteria subtab is not checked for the search that filters view results. See the help topic [Using And/Or Expressions in Search Criteria](#).

**Limitations for Inline Editing on Referenced Fields**

If a field on a record is referred to by a formula custom field, you cannot edit the referenced field with inline editing. For more information on sourcing, see the help topic [Creating Formula Fields](#).

**Additional Setup Option for Custom Search Portlets**

When the Inline Editing feature is enabled, editing is available by default for all search results in dashboard portlets. However, each Custom Search portlet has an Allow Edit setup option that you can use to enable or disable the Edit feature for specific portlets. See the help topic [Displaying Saved Search Results in Dashboard Portlets](#).

**Allow Editing Option for Custom Records Is Unrelated**

Each custom record type created in NetSuite has an Allow Editing option that is different from the general editing that is available when the Inline Editing feature is enabled. When enabled, the custom record type option permits records of this type to be edited directly when they display in a sublist on a parent record. Enabling this option does not control whether records of this type can be edited inline in their own list pages and views. This option is not related to the Inline Editing feature or to the Edit buttons that display on list pages when the feature is enabled.

**Using the Recent Records Menu**

NetSuite offers two ways to view a list of records you recently accessed.

Hover over the Recent Records icon to see a list of records you recently viewed or edited. This is the Recent Records menu. From here you can click a link to open a record in view mode, or move your cursor...
over the link and click Edit to open the record in Edit mode. You can also click All Recent Records to view a list of the 100 most recent records. This list includes the record type and the date the record was last accessed.

You can also create a Recent Records portlet on your dashboard to show the last 12 records you viewed or edited. Click Personalize Dashboard (under the tabs at the top of your dashboard) and then select Recent Records in the Add Content panel.

The difference between using the Recent Records menu and the Recent Records portlet is that the portlet constantly displays a list of recent records on the dashboard. The menu only displays recent records on demand, when you click or hover over the icon.

Working with List Views, Sublist Views, and Dashboard Views

NetSuite provides you with several different options for viewing lists of records in your account, including the following:

- List View
- Sublist View
- Dashboard View

List View

The list view is displayed when you go to the NetSuite tab that lists the record you want, and click the task link for that type of record. You can customize this view by changing the fields that display on the list page. A customized view is based on a custom search that you create for that record type.

To customize a list view, click Customize View or Edit View. Note that the Edit View button only appears when the list view has already been customized. For more information, see Customizing List Views.
Sublist View

Most records include subtabs that display additional fields or lists of other records. You can create a separate customized sublist view that displays different data than a list view. For more information, see Customizing Sublist Views.

Dashboard View

You may choose to display a list of records in a portlet on your dashboard. NetSuite enables you to create a separate customized view for list portlets on your dashboard. For more information, see Customizing Dashboard Views.

Your existing list, sublist, and dashboard views may be based on preferred view settings specified by your administrator or by another user with Publish Search permission, rather than on system-defined defaults. For information about how preferred view settings are defined, see the help topic Using a Saved Search as a View.

Customizing List Views

You can customize the list view for most record types. Customizing the list view enables you to change the columns displayed in the list and select the filter options available in the footer of the list page.

You can create custom views for any list that includes the Customize View or Edit View button on the list page.

If a saved search has been made available as a list view, you can select that saved search as your list view instead of customizing a new one. These searches are available from a View dropdown list. See Selecting an Existing Saved Search as a Custom View.

To create a custom view for lists:

1. On the list page you want to customize, click Customize View or Edit View.
If the list view of this record type has not been previously customized, the **Customize View** button is displayed. If the view has been customized, the **Edit View** button is displayed. In the example below, the Customers & Jobs page has **Customize View** button.

Clicking Customize View takes you to the page to customize the view.

2. In the **Search Title** field, enter a different name for your custom view if desired. Default search title is the word Custom followed by the record type and the selected view, for example, Custom Customer General View.

3. On the **Results** subtab:
   - Select a different field to use for sorting if desired.
   - Add, remove, and move fields as desired.
   - Enter custom labels for fields as desired. The default label is the field name.

4. On the **Available Filters** subtab:
   - Add, remove, and move fields to be displayed as filter lists on the list page.
   - Enter custom labels for filter lists as desired. The default label is the field name.
   - Leave the **Show in Filter Region** setting as **Yes** for all fields. If you change this setting to **No**, the filter list is not displayed.

5. When you have finished making changes, click **Save**. This customized view is now used for the selected record type’s list page.
You also can do the following:

- Click More Options to display a full saved search definition page where you can edit other options, such as filter criteria. (Note that if you make changes to other options on this page, these settings are preserved when you return to the customization page even though they are no longer visible.)
- Click Cancel to return to the list page, with no changes.
- Click Restore Defaults to return to the list page that uses your previously defined preferred search settings, if any, or system-defined defaults. (Note that this button only displays after you have customized the list view.)

Customizing Sublist Views

You can customize the view used for a list that appears on record’s subtabs. Available customizations include changes to displayed results columns and filter dropdown lists.

**Note:** If an existing saved search is available as a sublist view, you can select that search to customize your subtab view instead of creating a new one. These searches are available from a View list. See Selecting an Existing Saved Search as a Custom View.

**Note:** When you switch between custom views on a sublist, the filters on the sublist do not update automatically. For more information, see SuiteAnswers article 61407.

To create a custom view for a sublist:

1. On the sublist you want to customize, click Customize View.

2. In the Search Title field, you can enter a different name for your custom view.
   Default search title is the word Custom followed by the record type and the selected view, for example, Custom Item Transaction Sublist View.

3. On the Criteria subtab, add the desired Filter.

4. On the Results subtab:
- Select a different field to use for sorting if desired.
- Add, remove, and move fields as desired.
- Enter custom labels for fields as desired. The default label is the field name.

5. On the **Available Filters** subtab:
- Add, remove, and move fields to be displayed as filter lists on the list page.
- Enter custom labels for filter lists as desired. The default label is the field name.
- Leave the **Show in Filter Region** setting as **Yes** for all fields. If you change this setting to **No**, the filter list is not displayed.

6. When you have finished making changes, click **Save**. This customized view is now used for the selected record type's sublist.
   
   You also can do the following:
   - Click **More Options** to display a full saved search definition page where you can edit other options. (Note that if you make changes to other options on this page, these settings are preserved when you return to the customization page even though they are no longer visible.)
   - Click **Cancel** to return to the record that includes the sublist, with no changes.
   - Click **Restore Defaults** to return to the sublist that uses your previously defined preferred search settings, if any, or system-defined defaults. (Note that this button only appears after you have customized the sublist view.)

### Customizing Dashboard Views

You can customize the view used for a record type's lists in dashboard List portlets. Available customizations include changes to displayed results columns and filter dropdown lists. This is different from personalizing dashboards, which refers to changing the portlets on the dashboard.

**Note:** If an existing saved search is available as a dashboard view, you can select that search to customize your dashboard view, instead of creating a new one. These searches are available from a View dropdown list. See [Selecting an Existing Saved Search as a Custom View](#).

To create a custom view for list portlets on dashboards:

1. In the List portlet that display the dashboard list you want to customize, click the **Customize View** or **Edit View** link.

   If the dashboard view of this record type has not been previously customized, the **Customize View** link is displayed. If has been edited, the **Edit View** link is displayed.
2. In the **Search Title** field, enter a different name for your custom view, if desired.
   Default search title is the word Custom followed by the record type and the selected view, for example, Custom Item Basic View.

3. On the **Results** subtab:
   - Select a different field to use for sorting if desired.
   - Add, remove, and move fields as desired.

   **Note:** A List portlet displays only the first 7 columns when the portlet is placed in the center of the dashboard and only 2 when it is on the side.
   - Enter custom labels for fields as desired. The default label is the field name.

4. On the **Available Filters** subtab:
   - Add, remove, and move fields to be displayed as filter lists on the list page.
   - Enter custom labels for filter lists as desired. The default label is the field name.
   - Leave the **Show in Filter Region** setting as **Yes** for all fields. If you change this setting to **No**, the filter list is not displayed.

5. When you have finished making changes, click **Save**. This customized view is now used to display the selected record type in List portlets.

   You also can do the following:
   - Click **More Options** to display a full saved search definition page where you can edit other options, such as filter criteria. (Note that if you make changes to other options on this page, these settings are preserved when you return to the customization page, even though they are no longer visible.)
   - Click **Cancel** to return to the page displaying the List portlet, with no changes.
   - Click **Restore Defaults** to return to the page with the List portlet that uses your previously defined preferred search settings, if any, or system-defined defaults. (Note that this button only appears after you have customized the list view.)

### Selecting an Existing Saved Search as a Custom View

An administrator or another user with the Publish Search permission can make an existing saved search available as a list view, a sublist view, and a dashboard view. This enables you to select this search from a View dropdown list to customize your view, instead of clicking Customize View and creating your own.

If a View list is not displayed, it means that no saved searches of that record type have been set as available for that type of view.

The following screenshot shows the View list for a dashboard view:

For information about how saved searches are made available as custom views, see the help topic [Using a Saved Search as a View](#).
You can customize how saved search results are printed if your site uses advanced PDF/HTML templates. For more information about creating a custom template to print results from saved searches, see the help topic Advanced Templates for Printing Saved Search Results.

**Important:** If the Use Expressions option is enabled for a search, editing is disabled in list, dashboard, and sublist views based on the search. If you want editing to be available for a view, ensure that the Use Expressions box on the Criteria subtab is not checked for the search that filters view results. See the help topic Using And/Or Expressions in Search Criteria.
Working with Your Calendar and Activities

The calendar and activities features in NetSuite help you to make effective use of your work time. Use the calendar to manage your activities, including events, tasks, and phone calls. Access the calendar from the Activities tab as shown.

You must set preferences before you start using your calendar, and working with activity records in NetSuite. For more information, see Personal Preferences for Activities.

Read Using Your Calendar to learn how to set preferences for sharing your calendar with others in your organization, and how to synchronize your calendar using NetSuite for Outlook.

You can set up a number of calendar portlets on your activities page to display combinations of personal, group or team calendars. These portlets act independently of each other, so you can also display a variety of time frames for the same calendar. For example, you may set a monthly overview portlet on the left of your screen and in the center, a weekly view. See the help topic Calendar Portlets.

When you use the Time Tracking for CRM feature, you can track time on tasks, phone calls, events and cases. Tracking time on these activities can help you become more aware of how much time is spent on certain projects.

**Note:** The ability to track time in NetSuite is also required for Time Tracking for CRM.

The topics below provide more information about working with your calendar and activities:

- **Working with Events** describes how to create and edit events, as well as how to track time on event records.
- **Working with CRM Tasks** describes how to create CRM tasks and Project tasks, as well as how to track time on CRM tasks.
- **Working with Phone Calls** describes how to schedule phone calls, track time on phone calls, and use telephony with NetSuite.

Using Your Calendar

NetSuite enables you to manage your schedule by using a customizable calendar. The Activities page displays events you create in NetSuite automatically on your calendar.

To display tasks and phone calls on your calendar, check the Reserve Time box on task and phone call records, and then enter the start and end times.
Read the following topics for information about how to set up and use your NetSuite calendar:

- **Setting Your Calendar Time Zone** describes how to share events and meetings with your co-workers across the country or around the world.
- **Setting Calendar Preferences** describes how to make appointments visible on your calendar and how to share your calendar with other NetSuite users in your organization.
- **Navigating Your Calendar** describes how to best navigate the calendar page.
- **Synchronizing Your Calendar** describes how to use the NetSuite for Outlook client for viewing your appointments and making changes to your schedule without logging in to NetSuite. You must use the Outlook Integration feature, to take advantage of this functionality.

### Setting Your Calendar Time Zone

The first step in setting up your NetSuite calendar is to make sure your calendar reflects the time zone in which you work. The time zone you choose affects your calendar and events, and affects data returned by reports and searches for date fields with timestamps.

**To set your Calendar Time Zone:**

1. Go to Home > Set Preferences.
2. On the **General** subtab, in the Time Zone field, select your time zone
3. Click **Save**.

The next step in setting up your calendar is **Setting Calendar Preferences**.

### Setting Calendar Preferences

Before you begin working with your Activities page, you must set preferences for how you want to use your calendar. These preferences determine the following about your calendar:

- privacy settings
- calendar display
- sharing

Prior to setting your calendar preferences, set the time zone to make sure your calendar reflects the time zone in which you work. For more information, see [Setting Your Calendar Time Zone](#).
To set your calendar preferences:

1. Click the Activities tab.
2. In the page header, click Calendar Preferences to view the Personal Calendar Setup page.
3. In the Title field, enter a name for this calendar.
   You are the only person who can see this title. If you give others access to your calendar, they see your name when viewing your availability.
4. Use the Sharing field to set preferences for access to your calendar. Note that you can choose a different Event Access setting on individual event records.
   - Public – This gives everyone in your company access to your calendar.
   - Private – This restricts everyone in your company from seeing your calendar.
   - Defined Below – This enables you to select who can view and schedule appointments on your calendar using the Calendar Access subtab. For details, see Calendar Access.
5. If you choose Defined Below in the Sharing field, click the Calendar Access subtab to select the names of people you want to have access to your calendar.
6. Click Preferences to choose a default view for your calendar, set your time preferences, and enable sharing with iCal-compatible devices and applications. For details, see Preferences.
7. After you have set all of your preferences, click Save.

Calendar Access

Use the Calendar Access subtab to define how your events appear when others in your NetSuite account view your calendar.

1. In the Grant Access to column, select who should have access to your calendar. Note that only NetSuite users with login access to your account appear in this list.
2. In the Access Level column, choose one of the following access levels:
   - View – This person can see events you mark public and busy times for events you mark busy.
   - Edit – This person can see, change and remove events you mark public and see busy times for events you mark busy. They cannot delete events on your calendar.
   - Full – This person has view and edit access to public events on your calendar. Those with Full access can delete events on your calendar and also accept events on your behalf.
   - To grant access to your private events, check the Can Access Private Events box for the selected NetSuite user.
3. Click Add.

Note: Administrators are able to view or edit, including delete, any task, event or call, even if it is not assigned to them and regardless of the event access settings.

Preferences

The options on the Preferences subtab determine how the calendar displays when you are logged in to NetSuite. You can choose a daily, weekly, or monthly view, and designate a start and end time for your calendar day.

1. In the Default View field, choose to display your calendar in a daily, weekly or monthly format.
   You can always change the view on the calendar by clicking Day, Week or Month in the calendar.
2. In the Daily section, in the Start Time field, select the time your calendar day begins.
3. In the **End Time** field, select the time your calendar day ends. These can be the start and end of the work day.

4. In the **Time Increments** field, select how you want to display time on your calendar's daily view.

5. Under Calendar Sharing, check the **Public Calendar** box if you want to share your public calendar with iCal-compatible devices and applications. Checking this box generates a URL that you can use to view all public events on your NetSuite calendar.

6. Check the **Private Calendar** box if you want to share all of your calendar events (including private events and those shown as busy) with iCal-compatible devices and applications. Checking this box generates a URL that you can use to view all private and public events on your NetSuite calendar.

   **Note:** These options only enable you to view calendar events in an iCal application. You cannot update or edit NetSuite events from other devices. This is supported on iOS devices using iOS version 7.1.0 or later. For more information, see *Sharing Your Calendar with iCal-Compatible Devices and Applications*.

Now you can begin using your calendar. When you or others go to your calendar, your calendar appears according to your settings on the Preferences subtab.

Additional setup preferences are available for each calendar portlet. For details, see the help topic *Calendar Portlets*.

**Sharing Your Calendar with iCal-Compatible Devices and Applications**

You can share your NetSuite calendar with devices and applications that support iCal format internet calendars, including iPhones, Android devices, and Microsoft Outlook. This enables you or others to view (but not edit) your current NetSuite calendar outside of the NetSuite application and does not require login credentials.

First you must set up your calendar for sharing. This creates URLs that you can use to share your calendar.

**To set up your NetSuite calendar for sharing:**

1. In your NetSuite account, go to Activities > Setup > Calendar Preference.
2. Click the **Preferences** subtab.
3. Under Calendar Sharing, check the **Public Calendar** box if you want to share the events on your calendar that are public.
4. Check the **Private Calendar** box if you want to share all of your calendar events.
5. Click **Save**.

When you check these boxes, URLs are automatically generated. You can distribute these URLs to anyone you want to share your calendars with. You can reset these URLs at any time if you want to require the use of a new URL to view your calendar. After resetting these URLs, you must communicate the new URLs to those you’d like to share your calendar with.

As with any Internet calendar, reminder settings on events are not supported for Google Calendar and Outlook, but they are supported on iOS devices (using iOS version 7.1.0 or later).

For information on how to make your calendar events public or private by default, see *Setting Calendar Preferences*. 
Android Devices and Google Calendar

To view your NetSuite calendar on an Android device, you can either use the native NetSuite for Android app, or share it with your Google calendar. For more information on the NetSuite for Android app, see the help topic NetSuite for Mobile Overview.

**Note:** Google Calendar refreshes events from Internet calendars approximately every 24 hours. If you would like to update your calendar more frequently, you can use other Internet calendar applications.

**Important:** The Google Calendar Android app only supports viewing of subscribed calendars. To add a calendar, you must use the browser version of Google Calendar.

**To view your calendar on an Android device:**

1. In a browser, open your Google Calendar.
2. Open the options next to Other calendars, and click Add by URL.
3. Paste the URL generated on the Calendar Preferences page in NetSuite.
4. Click Add Calendar.

Microsoft Outlook

To view NetSuite events in Microsoft Outlook, you can use NetSuite for Outlook, or you can add it as an Internet calendar.

**To add an internet calendar to Outlook:**

1. Open your calendar in Outlook.
2. Right click My Calendars.
3. Select Add Calendar > From Internet.

4. Paste the URL generated on the Calendar Preferences page in NetSuite.

5. Click OK.

Mac OSX Devices

In some cases you may prefer to view your events using the Calendar application rather than logging into NetSuite. To do this you need to subscribe to the NetSuite calendar.

To view your NetSuite calendar on a Mac

1. In Calendar, choose File > New Calendar Subscription.

2. Enter the NetSuite calendar URL from the Calendar Preferences page and then click Subscribe.

3. Enter a name for the calendar in the Name field and choose a color from the adjacent pop-up menu.

4. If you have an iCloud account, choose whether you want the calendar on that account.

5. To view a subscription calendar in Calendar on your Mac and on devices with iOS 5 or later without resubscribing to it, choose your iCloud account.

6. To update your copy of the calendar when changes to it are published, choose the update frequency from the Auto-refresh pop-up menu.

7. Click OK.

To make changes to the calendar, click the name of the calendar, and then choose Edit > Get Info.

iOS Devices

To view your NetSuite calendar on an iOS device, you can use the native NetSuite for iPhone app, or you can add it as a subscribed calendar. For more information on NetSuite for iPhone, see the help topic NetSuite for Mobile Overview.
To view your NetSuite calendar on an iOS device:

1. Go to Settings > Calendar.
2. Tap Accounts, then Add Account.
3. Tap Other.
4. Tap Add Subscribed Calendar.
5. Paste the URL generated on the Calendar Preferences page in NetSuite into the Server field.
6. Tap Next.

**Important:** Do not enter your NetSuite user name and password. This is not required to view your NetSuite calendar on your iOS device.

7. Tap Save.

Navigating Your Calendar

Your Activities page includes a monthly calendar on the left and a list of calendar events in the center by default. You can view your calendar by day, week or month.

To see your calendars, click the Activities tab.

For more information, see Setting Calendar Preferences.

The figure above illustrates actions you can complete with the calendar. Both calendars are calendar portlets, but one is set to Monthly view in the narrow dashboard column, and the other is a daily view in the wide column. The numbered options below correspond with the numbers in the figure above:

1. Click Today to highlight today’s date. The same button in daily view in the wide column displays all events scheduled for today.

2. Click the arrows at the top of a calendar to view the next or previous increment of the view. For example, the arrows in the narrow calendar move through the months. In the wide calendar the arrow move through the days.
3. Click Print in the portlet menu to print the events listed in the center of the page. Click the ⌁ icon to refresh the contents of the calendar.

4. Select a calendar from the dropdown list. You can see only calendars and calendar entries that have been shared with you or made public.

5. Click Daily, Weekly, or Monthly to change the calendar view. In the narrow calendar, these options are included in a dropdown list instead of buttons.

6. In daily view, click a time to open a popup and create a new Event, Call, or Task.
   When you click a day in weekly view, the calendar changes to daily so that you can create a new entry. In monthly view, the behavior when you click a day depends on whether the calendar is narrow or wide. In narrow calendars, the view changes to daily. In wide calendars, the Create New popup opens.

7. Click an event to view the event’s record in a wide calendar.
   In the narrow monthly calendar, click the date to view events for that day. Hover over a date to see the events in a popup without changing the calendar view.

Calendar Colors

Colors denote the status of your events.

- Solid green shows an event you have accepted.
- Thin diagonal green lines show an event to you have tentatively accepted.
- Gray shows an event to which you have not yet responded.
- White indicates a calendar entry that is not an event.

If you decline an event or an event is canceled, it does not show on your calendar.

Displaying Your Calendar

You can display the Calendar portlet on your NetSuite Home page.

To show the Calendar portlet on the Home page:

1. Go to Home > Dashboard.
2. Click the Personalize link in the upper right of the page. The Personalize Dashboard palette opens at the top of the page.
3. In the Standard Content panel, click Calendar to add the portlet.
4. Click Setup in the portlet menu to set your preferences.

Synchronizing Your Calendar

With synchronization, you can quickly import and update your contacts, calendar events, tasks, and phone calls between NetSuite, Microsoft Outlook, and the Microsoft Outlook Exchange Server.

NetSuite for Outlook provides unidirectional and bidirectional synchronization of contact, event, task, and phone call records between NetSuite and Outlook, as well as the ability to save Outlook messages to NetSuite records. You can download this client from NetSuite and run it as an Outlook Add-In.

For information about using NetSuite for Outlook for synchronizations, see the help topic NetSuite for Outlook.
Working with Events

In NetSuite, you use event records to reserve time on your calendar for appointments and meetings. When you create an event, you are the owner. If you are invited to an event and you accept, then you are an attendee. You can click on an event displayed on your calendar to see more information about it, such as the location and a list of the people invited.

Read the topics below to learn more about working with events:

- **Scheduling Events** describes how to create new event records and how to use the Scheduler portlet to schedule events.
- **Sending Event Invitations** describes how to send an email invitation with details about the event, including the date, time and location.
- **Setting Up Recurring Events** describes how to create a record for an event that occurs on a regular basis, such as a weekly or monthly meeting.
- **Using Resource Records on Events** describes how to use event records to reserve certain resources, such as a conference room, or a speaker phone.
- **Tracking Time for Events** describes how to keep track of time spent on events for reporting purposes and billing. Note that you can only track time on events if you use the Tracking Time for CRM feature.
- **Responding to Event Invitations** describes how to accept, decline, or mark an event invitation as tentative.
- **Setting Up Event Reminders** describes the different types of event reminders and how to set them up when you edit an event record, or respond to an event invitation via email.
- **Canceling or Deleting Events** describes the difference between canceling and deleting events, as well as how to cancel one-time and recurring events.
- **Searching Event Records** describes how to set filters and find events that are not listed on your Events page.
- **Sharing Your Calendar with iCal-Compatible Devices and Applications** explains how to share your NetSuite calendar with Outlook, iOS devices, and Android devices.
Scheduling Events

You can schedule an event through an event record or by using the Scheduler portlet. The Scheduler is convenient when organizing an event for a group. You can click the link to the event on your calendar to make changes if necessary.

For more information about scheduling events, see the following:

- To understand how to enter information on an event record, read Creating a New Event Record.
- To learn an easy way to invite a group of people to an event, read Using the Event Scheduler Portlet.
- To find out about keyboard shortcuts, managing conflicting events, and marking events as private, see Event Scheduling Notes.
- To add a resource to an event, read Using Resource Records on Events.
- To learn how to cancel an event, or how to remove it from your calendar, read Canceling or Deleting Events.

Creating a New Event Record

Use an event record to send an email invitation, attach a document for discussion, and to reserve a resource such as a conference room.

When you create an event, you are the owner and automatically designated as the organizer. The event’s organizer, owner, or any role who has edit- or full-level permissions to Events can make changes to any event record including assigning an organizer.

**Note:** Administrators are able to view or edit, including delete, any task, event or call, even if it is not assigned to them and regardless of the event's access settings.

To create a new event record:

1. Go to Activities > Scheduling > Events > New.
2. Under Primary Information:
   1. You can select a Custom Form (optional).
   2. In the **Title** field, enter the subject or title for this event.
   3. Fill in the **Location** field, and select the date of this event.
   4. Select whether the status of the event is **Confirmed**, **Tentative** or **Canceled**.
   5. In the **Event Access** field, select how you want this event to appear on your calendar.
      - **Public** – This event and its information appear to everyone with access to the calendar.
      - **Private** – This event appears only to you and to invitees with access to the calendar. For more information, see Event Scheduling Notes.
      - **Show as Busy** – This event appears as a busy time slot to everyone with access to the calendar. No other information about this event is displayed.
   6. In the **Organizer** field, select the person who is organizing this event. The event organizer is automatically set as an accepted attendee for this event.

   If you edit the event record to change the organizer, the new organizer is not automatically added to the attendee list.

3. Under Date and Time:
   1. Select a date for the event.
2. Check the **All Day** box, if this event will last the entire day. When you check this box, the start and end times fill in automatically based on your calendar preferences.

**Note:** If you need to create an event that spans multiple days, create an all day event for the first day, and on the Recurrence subtab, choose Daily and set the last day of the event in the End By field.

3. Check the **Reserve Time** box if you want to reserve time on your calendar for this event. Events that do not reserve time appear first on your calendar on the day they are scheduled. These can include events such as birthdays or anniversaries.

4. Select the start and end times for this event. If the selected time slot conflicts with any existing events, a popup warning displays on the screen.

5. In the **Reminder Type** field select the type of reminder you want to receive.

6. In the **Reminder** field, select a time before the event when you want to be reminded. For more information, see **Setting Up Event Reminders when Creating or Editing Events**.

4. On the **Message** subtab, enter the message you want to show in the email invitation that is sent to attendees and is shown on the event record.

5. Click the **Attendees** subtab.

6. In the **Send Invitation To** column, select a name from the list. For more information, see **Sending Event Invitations**.

7. In the **Attendance** column choose whether this attendee is a required or an optional participant.

8. Click **Add**.

9. Repeat these steps for each attendee.

10. On the **Resources** subtab, you can reserve the necessary resources for this event such as a conference room or presentation materials. For more information, see **Reserving Resources for Events**.

The availability of those individuals and materials you have selected on the **Attendees** or **Resources** subtabs shows on the **Availability** subtab.

Click the arrows next to the date to view the availability on other days. The window of time shown on this subtab is the same as the Daily start and end times set in your calendar preferences.

11. Click the **Recurrence** subtab if the event is part of a series of events. For more information, see **Setting Up Recurring Events**.

12. When you have finished entering all of the information for this event, click **Save**.

The following are optional settings on the event record:

- **On the Related Records subtab:**
  - Select a company if this event is related to a customer, vendor, partner, or other name. The event record is attached to the entity record.
  - The **Contact** field lists the contacts for the entity you have selected. Select the contact with whom this event is associated, if any.
  - If this event pertains to a support case, select the case number in the Support Case field. The event record is attached to the case record.
  - If this event is related to a transaction, select the transaction number. The event is listed on the **Events** subtab of the transaction record.

- **Use the Time Tracking subtab,** if you use the Time Tracking for CRM feature and want to track time for this event. For more information, see **Tracking Time for Events**.
Click the **Communication** subtab to attach a file to this event. For more information on attaching files, see **Attaching Files to Records**.

**Using the Event Scheduler Portlet**

The Scheduler portlet is a quick way to enter event records. The Scheduler enables you to select people to invite, and see their availability directly on the Activities tab in NetSuite. It is useful for creating a group event. When you select the group in the View Group list, the list of group members displays in the Scheduler. After you set the date and time, click Create New Event to create the event record.

To schedule an event by using the Event Scheduler portlet:

1. Click **Activities Overview** on the **Activities** tab.
   - By default, the Scheduler portlet is located at the bottom of the Activities page.
2. From the **View Group** list, select the group for which you want to schedule an event.
3. Select the date of the event.
   - The earliest available time slot for everyone in the group is highlighted.
4. Click on a time slot for the event.
5. Drag the slider bars, under the time, to set the duration of the event.
6. Clear the boxes next to the group members you do not want to invite to the event.
   - The organizer is not invited to the event by default.
7. Click **Add Invitees** or **Add Resources** to include people or resources that are not a part of the group you selected.
   - After you save the event, the event displays on the invitees' personal calendar.
8. Click **Create New Event**.
9. Enter the title and other information concerning the event.
10. Click **Save**.

**Event Scheduling Notes**

As you are scheduling events, be aware of the following:

- **Calendar Hot Keys for Events**
- **Warning for Conflicting Events**
- **Marking Events as Private**

**Calendar Hot Keys for Events**

You can use keyboard shortcuts to quickly set dates on events and transactions. In NetSuite date fields, use the following keyboard shortcuts to quickly change dates:

---

NetSuite Basics
Working with Events

- Press Shift + t to enter tomorrow's date.
- Press t to enter today's date.
- Press y to enter yesterday's date.
- Press m to enter the end of the month.
- Press the Plus key (+) to move forward one day.
- Press the Minus key (-) to move back one day.

Warning for Conflicting Events

On an event record, when you select start and end times that conflict with an existing event, NetSuite displays a warning that clearly indicates the name and time of the conflicting event.

Marking Events as Private

An event marked as private can only be viewed by the owner of the event and its attendees. Private events do not show on the calendar, and they appear as Busy when checking availability on event records. If you have checked the Can Access Private Events box for one or more users, these users see private events. Only attendees can track time against a private event.

**Note:** Only the owner of a private event can delete it. Even those with the Administrator role cannot delete private events from another user's calendar. These events must be deleted through the Delete Events mass update. See the help topic Mass Deleting an Employee's Events.

Sending Event Invitations

Use the Attendees subtab on the Event record to select attendees for an event and to send email invitations.

After you save an event record, it appears on the NetSuite calendar for each person invited.

**To create and send event invitations:**

1. On the event record, click the Attendees subtab.
2. In the Send Invitation to column, select the name of the person or group you are inviting to this event.
   - The Availability field is automatically filled by NetSuite. When those invited are not in your company, this field always says Available.
   - If the person or group is in your company, their availability depends on whether they have conflicting events in their NetSuite calendars. You can view availability on the Availability subtab.
   - The Response column defaults to the status No Response when you add an invitee.
   - When those invited receive the invitation to the event, they can accept, decline, or tentatively accept the invitation. Their status displays here, on the event record. For more information, see Responding to Event Invitations.
3. In the Email column, check the box next to each person to whom you want to send an email invitation.
   - Check the Notify Attendees by Email box to send email to attendees in the list based on your preference for sending invitation email. For more information, see Personal Preferences for Activities.
4. In the Attendance column, select whether each person's attendance is optional or required.
5. Click Add.
6. Repeat these steps for each person or group you want to invite.
7. When you have added everyone you want to invite, click the Availability subtab to see if they are all available at this time, or click Save if you are finished with this event.

You can restrict the contacts that appear in the Send Invitation To column by setting the Restrict Invitees to Employees preference on the Activities subtab at Home > Set Preferences. If you check this box, only employees appear in the Send Invitation To column.

Setting Up Recurring Events

If an event occurs on a regular basis, such as weekly, monthly, or a specific day of the month, you can set a recurrence pattern for the event. The event appears on the calendar on the dates when it occurs.

To make an event occur more than one time:

1. On the event record, click the Recurrence subtab.
2. Select how often this event should occur:
   - Daily – Enter the interval between days if this event is every day or every few days, or select every weekday if this event is every day except Saturdays and Sundays.
   - Enter 1 as the interval if this event is every day, for example, or enter 2 if the event is every other day.
   - Weekly – Enter the interval between weeks, and select the day of the week this event repeats on.
   - Monthly – If this event occurs on the same day of every month or every few months, enter the date the event repeats, and select the interval between months.
   - If this event occurs on the same day of the week every month or every few months, select the week, the day of the week, and enter the interval between months.
   - Yearly – If this event occurs one time a year, select the month and day of the event, or select the week, day and month.
3. In the End By field, set the date this event stops recurring.
4. If the event continues indefinitely, check the No End Date box.
5. If you need resource materials for this event, click the Resources subtab. For more information, see Using Resource Records on Events.
6. Click Save to save the event.

To edit a recurring event, go to the calendar in NetSuite and click the event link. Select the occurrence or series.

Invitees can choose to decline either the entire series of events or specific dates in the series.

**Note:** If you change your time zone preference at Home > Set Preferences > Activities and then edit an event created in your original time zone, you may need to review the recurrence settings for that event to ensure they are set properly before saving your changes.

Using Resource Records on Events

Resources can be anything from conference rooms to speaker phones that you use within your company for meetings, and conferences. In NetSuite, you create resource records to reserve these items.

You must use the Resources subtab on the event record to reserve a resource for an event. If someone else creates an event for the same time, and attempts to reserve the same resource, the availability shows as busy.
For information about using resource records, see the following:

- **Creating a Resource**
- **Reserving Resources for Events**

## Creating a Resource

When you create a resource record, you are also creating a calendar associated with the resource. If the resource is public, then any NetSuite user in your account can select the resource on the calendar page and see when the resource is booked for a certain day, week, or month.

**To create a resource record:**

1. Go to Activities > Setup > Resources and click New.
2. In the **Name** field, enter a name for this resource. This name appears in the list on the Resources subtab of event records.
3. The **Owner** field displays your name by default as the creator of this resource record. You can select another user to be responsible for this resource record.
4. Enter a brief description of this resource in the Description field.
5. Check the **Private** box if you only want the owner to be able to view the resource calendar.
6. The **Title** field displays the name of the resource. You can edit this field to have a different title.
7. In the **Daily Start Time** and **Daily End Time** fields, select the time this calendar day begins and ends.
   - This can be the start and end of the work day, or any time you want to see events on this resource calendar.
8. Click **Save**.

Now you can reserve this resource when you schedule events. For more information, see **Reserving Resources for Events**.

## Setting Calendar Preferences for a Resource

After you create a resource record, you can select the resource in the My Calendar list on the calendar to check for availability.
Make changes to the resource record and its calendar preferences by going to Activities > Setup > Resources, and clicking Edit next to a resource.

The following fields display on the Calendar Preferences subtab of the Resource record:

- **Title** – The resource name entered in the Name field appears here as the name of the calendar.
- **Daily Start Time and Daily End Time** – Select the time that this calendar should begin showing events, and the time when this calendar should stop showing events.
- **Default View** – Choose to display this calendar in a daily, weekly or monthly format.
- **Daily Time Increments** – Select the increments of time for this calendar’s daily view.
- **Sharing** – Choose a level of access for this calendar. Note that you can still specify on event records how you want events to appear on this calendar.
  - **Public** – This gives everyone in your company access to this calendar.
  - **Defined Below** – This restricts everyone in your company from seeing this calendar except the people you select in the section below.

Give certain individuals access to this calendar by selecting a name in the User column. Only NetSuite users with login access appear in this list.

In the Access Level column, choose the level of access for each person who is allowed to see this calendar:
- **None** – This person cannot access this calendar.
- **View** – This person can see events marked public and busy times for events marked busy.
- **Edit** – This person can see, change and remove events marked public and see busy times for events marked busy.
- **Full** – This person has complete access for viewing and editing this calendar.

**Note:** Private events are not shown even to those with access to this resource calendar. To grant access to private events, check the Can Access Private Events box for the selected user.

### Reserving Resources for Events

Reserving resources is similar to inviting attendees. You must create resource records at Activities > Setup > Resources > New > New before you can reserve them for events.

**To reserve a resource for an event:**

1. On the event record, click the Resources subtab.
2. In the Resource column, select the resource you need to reserve. The resource availability for the time of this event shows in the Availability column.
3. Click Add.

   You can view the availability of the resource for other times on the Availability subtab after you have added the resource.

If you have not provided a location for your event, NetSuite uses the location associated with the resource you are planning to use as the suggested location for the event. For example if you add “Conference Room A, San Mateo” to an event with a blank Location field, the location will be updated to San Mateo. This only happens when first adding a resource. If you subsequently change an event resource the main event Location field remains the same, assuming you want to use a resource from another location, but not change the physical event location.
Tracking Time for Events

Time Tracking for CRM enables you to keep track of time spent on events with the option to bill that time to customers. Before you can use this feature, an administrator must enable the Time Tracking for CRM feature. See the help topic Enabling Time Tracking for CRM.

**To track time on event records:**

1. Go to Activities > Scheduling > Events.
2. On the Events list, click the event for which you want to track time.
3. On the Event record, click the Time Tracking subtab.

   **Note:** If any case, task, or event record has more than 9500 time entries to display on the Time Tracking subtab, all events display a static list of time entries. You cannot edit entries directly from the list.

   
   A new time transaction window opens.

5. Your name is selected in the Employee field by default. Other employees, as well as vendors, can be selected here.

   **Note:** For private events, only employees and vendors listed as attendees on the event record can track time against the event.

6. Enter information for this time transaction.
   
   For more information about entering time for Time Tracking, see the help topic Entering a Time Transaction.
   
   For more information about entering time for Timesheets, see the help topic Timesheets.

7. When you have finished, click Save.

   If you checked the Billable box, you can now bill this customer for this time on the Billable Time subtab when you create an invoice. View reports for time spent on cases, tasks and events on the Reports tab, under the Project/Time Tracking heading.

   All employee names are listed on the Time subtab by default.

Responding to Event Invitations

When you are invited to an event, you can choose to accept or decline the invitation or mark it as tentative. Unless the event organizer selects a response for you on the event record, your status is "No Response" until you respond.

**To respond to an event invitation choose one of the methods listed below:**

- **Email**
  
  Click the Accept, Tentative or Decline link displayed in the email invitation you receive.
  
  You do not need to log in to NetSuite to respond to the event with this method.
  
  Note that you do not have the option to set up an event reminder with this method.

- **Events List**
Go to Activities > Scheduling > Events. This is useful when you have several events to respond to.

To accept all events at one time, click Accept All on the event list.

To respond to individual events, click Edit next to the event, and then click the appropriate button on the event record.

- **Calendar**
  Go to the Activities tab to see your calendar, or go to Activities > Scheduling > Calendar.
  Click the event in the calendar to display the event record, and then click the appropriate button to respond.

- **Calendar Portlet**
  Go to a Calendar portlet on your Home or Activities tab.
  Hover over the event in the portlet to display the event popup.
  Click the appropriate button on the event popup.

**Note:** To display the Calendar or Reminders portlet on your home page, click the Personalize link at the top of the Home page, and then select Calendar or Reminders from the Standard Content panel.

Listed below are the available responses for an event invitation:

- **Quick Accept** — Accept the event without responding to the event organizer or setting a reminder. For more information, see Quickly Accepting Event Invitations.
- **Accept** — Agree to go to the event. With this option you have the option to send an email response to the event organizer.
- **Tentative** — Wait to respond to this event.
- **Decline** — Defer from going to this event. With this option you also have the option to send an email response to the event organizer.
  - If the status for an event is Declined, the event is removed from your calendar.
- **Decline This Date** — Decline only this occurrence of a recurring event.

Unless you click Quick Accept in NetSuite, when you respond to the event, a popup window opens. Here, you can email your response to the event organizer, and set your personal reminder for this event. For more information, see Setting Up Event Reminders.

If you choose not to send an email when you respond to the event invitation, the event organizer can still see the status for each invitee on the event record. People with permission to see the event's record can also see the status of those invited.

To set default preferences for events, see Personal Preferences for Activities.

### Quickly Accepting Event Invitations

If you receive several event invitations on a daily basis, you can quickly accept your events by clicking the Quick Accept button on event records.

Using the Quick Accept button:

- Accepts the event without asking you to set a reminder or respond to the event organizer.
- Marks the event accepted.
- Makes the event appear on your calendar.

To quickly accept an event, open the event record, and click Quick Accept.
If you accept your events from the email invitation, you can click the Accept the event link on the email message to quickly accept the event.

**Accepting Event Invitations on Behalf of Others**

If you have been given Edit or Full access privileges to a colleague's calendar, you may accept event invitations on their behalf. To assign a colleague access to your calendar see Calendar Access.

**Setting Up Event Reminders**

Event reminders are sent either as email messages, or they appear as popup messages in NetSuite. Reminders show the day, date, time, title and location of the upcoming event.

Event reminders are helpful when an event is scheduled far in advance.

When you receive a popup reminder, you can choose from the following:

- Click **Dismiss** to close the window
- Click **Go to Event** to open the event record in a new window.
- Click **Snooze** to select the amount of time before you want to be reminded again.

By default, reminders are set to include audio. You can change this preference, and set other preferences for event reminders on the Activities subtab at Home > Set Preferences.

When you are logged in to NetSuite with your default role, the preference you set for Default Reminder Type determines the type of reminder you receive for events. If you are not logged in with your default role, then the type of reminder you receive is determined by a company-wide preference set by an account administrator. For more information, see Personal Preferences for Activities.

You set event reminders when you create or edit an event, or when you accept or tentatively accept an event invitation. For instructions, see the following help topics:

- Setting Up Event Reminders when Creating or Editing Events
- Setting Up Event Reminders when Responding to Event Invitations

**Setting Up Event Reminders when Creating or Editing Events**

NetSuite offers different options for event reminders. You can choose to receive your reminder in an email message, or in a popup window when you are logged in to NetSuite. Note that others invited to the event can set their own reminders when they accept or tentatively accept the event invitation.

To ensure that you receive your reminder at the correct time, make sure the clock on your computer is set to your time zone, and then go to Home > Set Preferences to set the same time zone in NetSuite.

**To set up event reminders when creating or editing an event:**

1. Go to Activities > Scheduling > Events.
2. Click **Edit** next to an event in the list.
3. In the **Reminder** field, select the amount of time in advance of the event that you would like to be reminded.
4. In the **Reminder Type** field, select how you want to be reminded.
   - Popup reminders pop up in a window at the designated time if you are logged into your NetSuite account.
   - Email reminders are sent to the email address you use to log in to NetSuite.
5. Click **Save**.
Setting Up Event Reminders when Responding to Event Invitations

To set up event reminders when responding to an event invitation, you must log in and accept the invitation in your account. You cannot set reminders when using the links included in the email invitation.

To set up event reminders when responding to an event invitation:

1. Log in to your NetSuite account.
2. On the Home page, click the link in the Calendar portlet to respond to the event invitation. The event record appears in view mode with buttons to respond to the invitation. For a complete list of ways to respond to an event invitation, see Responding to Event Invitations.
3. Click Accept to accept the invitation, or click Tentative to tentatively accept the invitation. A window pops up where you can choose to email the event organizer and set your reminder for the event.
4. Choose whether to send the event organizer an email including your response. If you decide to email the organizer, you can add your own message to the email.
5. In the Reminder field, select the amount of time before the event's start time that you want to receive a popup or email reminder.
6. In the Reminder Type field, select which kind of reminder you want to receive: popup, email or none.

   **Note:** If you select None in either the Reminder field or the Reminder Type field, you will not receive a reminder.

7. Click OK.

Your event now shows on your calendar with a reminder icon. Note that if you decline an event invitation, you are not given the option to set a reminder. The event does not show on your calendar.

Canceling or Deleting Events

Only an event's organizer can cancel or delete an event.

When canceling an event, you can use the event record to alert attendees and to update the event's status. If your event is recurring, you can choose to cancel one instance or cancel the entire series of events.

Canceled and deleted events are both removed from the calendar unless you enable the Show Canceled Events option in your portlet setup. For more information, see the help topic Calendar Portlets.

**Note:** To edit events from the calendar, you must have checked the Edit Activities from Calendar box on the Activities subtab at Home > Set Preferences.

For more information, see the following:

- Canceling Events
- Deleting an Event
Canceling Events

You can cancel an event from the Events list or from your calendar. Only an event's organizer can cancel or delete an event.

**Note:** If you use NetSuite for iPhone, canceled events are not included in the iCalendar export.

**To cancel an event:**

1. Go to your calendar in NetSuite, and click the name of the event.
2. If the event is recurring, select *Open this occurrence* or *Open the series* in the popup.
3. In the event record, click *Edit*.
4. In the *Status* dropdown list, select *Canceled*.
5. On the *Attendees* subtab, check the *Notify Attendees by Email* box to update everyone invited about the status of the event.
6. Click *Save*.

If you do not need to notify those invited and want to remove the event from your Events list, you can delete the event. For more information, see Deleting an Event.

Deleting an Event

You must be the organizer to delete an event. Note that when you delete an event, the attendees are not notified, and the event is removed from the calendar.

**To delete an event:**

1. Go to your calendar in NetSuite, and click the name of the event.
2. If the event is recurring, select *Open this occurrence* or *Open the series* in the popup.
3. On the event record, click *Edit* or *Edit This Date* for a single instance of a recurring event.
4. In the *Actions* dropdown list, click *Delete*.

**Note:** Administrators can mass delete events for an employee no longer with your company. See the help topic *Mass Deleting an Employee’s Events*.

Searching Event Records

You can find a list of public and private events on the Events page at Activities > Scheduling > Events. Note that the list only displays events where you are listed as an attendee regardless of your ownership of the event and the event’s access settings. If you want to see a list that includes events where you are not an attendee, you can run a defined search.
To search event records:

1. Go to Activities > Scheduling > Events > Search.
2. Define at least two search filters. You can choose more than one option from each filter. To choose multiple options, click the names while holding the Ctrl key.

   **Important:** Defining the Date filter alone displays only the matched events which you are invited to. Set additional filters to expand the search.

3. Click Submit.

For more information on running simple searches in NetSuite, see the help topic Defining a Simple Search.

### Working with CRM Tasks

In NetSuite, tasks are records used to track work items that need to be completed within a certain time. Tasks can be assigned to you or to another person in your organization. NetSuite enables you to create two different types of tasks: CRM Tasks and Project Tasks.

### CRM Tasks

You can create a task record and assign it to an employee for completion or create a task, and then assign it to yourself as a reminder.

Each record contains details about the work that needs to be completed. A task shows on your list of tasks until you mark it Completed, or you delete it. For more information, see Creating CRM Task Records.

You can also assign tasks to partners. Go to Lists > Partners, click the partner record you want to work with, and then check the Assign Tasks box on the partner’s record. The Assign Tasks box appears only if your administrator has enabled the company general preference Assign Tasks to Partners.
If your administrator has enabled the Time Tracking for CRM feature, you can track time of tasks records to help you manage your time. For more information, see Tracking Time on CRM Tasks.

CRM tasks may be associated with a project but are not considered part of the project's schedule unless they are explicitly included using the Include CRM Tasks in Project Totals check box. For more information, see the help topic Including CRM Tasks in Project Totals.

You can view tasks associated with a customer record in the Tasks portlet of the customer dashboard. For information about displaying CRM Tasks and Project Tasks on your dashboard, see Tasks and Project Tasks Portlets on Your Dashboard. Tasks that are related to one or more customers are displayed in each dashboard's Activities portlet. If you want to see the list of companies that are related to a task record, go to the Task page through the Task portlet or through Activities > Scheduling > Tasks. Then, go to the Related Records subtab and see the list under Companies and Contacts.

Project Tasks

Use project task records instead of CRM task records to track information for projects. For more information, see the help topic Setting Up Project Management.

You can create a project task record only if you use the Project Management feature. Each project task represents an individual work item that must be completed to finish a project, and can only be created on a project record. Project tasks are used to facilitate project planning.

Creating CRM Task Records

Create a new CRM task record to track work items that need to be completed. Administrators can use the Import Assistant to import CRM tasks from another system into NetSuite. For more information, see the help topic Tasks Import.

To track tasks associated with projects, use Project Task records. For more information, see the help topic Project Task Records.

To set a preference for CRM Tasks to display on your calendar, go to Activities > Scheduling > Calendar > Calendar Preferences > Preferences subtab. Check the Display Non-blocking Tasks in Calendar box.

To create a CRM task:

1. Open a new task record by doing one of the following:
   - Go to Activities > Scheduling > Tasks > New, and click New.
   - Click Task in the Create New menu.
2. In the Primary Information field group:
   - Select the form you want to work with in the Custom Form field. This field appears only if multiple task forms are available.
   - Enter a Title for the task. The title should describe the task.
   - In the Assigned To field, select the employee who is assigned to the task.
   - Your name appears in this field by default.

   **Note:** In NetSuite OneWorld accounts, employees from all subsidiaries show in this field.

   - Check the Notify Assignee by Email box to send an email notification to the person who is assigned to the task. This email informs the person that a task has been created or edited and
assigned to him or her. If this person's record does not include an email address, no message is sent.

- Select the appropriate level of priority for this task.
- Use the Insert Before field to change the order of tasks. Select a task from the list that the new task should be placed above.
- Select a Status for this task. Only someone with permission to edit the task record is allowed to change the status.
- (Optional) Check the Private Task box if you want only you or the person in the Assigned To field to see this task. If you also use Time Tracking for CRM, only the person assigned to a private task can track time against the task.

3. In the Date and Time field group:
- Set the Start Date for this task.
- In the Due Date field, enter the date when this task should be completed.
- After the task is finished, fill in Date Completed field.
  The value in this field can be modified after the task is marked completed.
- (Optional) Check the Reserve Time box to turn the task into a scheduled task which can be displayed on the calendar. When you check this box, the Start Time and End Time fields become required fields.
  - Select the Start Time and End Time.

  **Note:** Use the Availability subtab to view when the person assigned to the task is available.

  - In the Reminder Type field, select a type of reminder for scheduled tasks that appear on the calendar:
    - None - No reminder is triggered.
    - Email - An email reminder is sent to the email address on the employee record for the person selected in the Assigned To field.
    - Popup - A popup reminder opens when the person assigned to this task is logged in to NetSuite.
  - In the Reminder field, select a time before the task begins when you want to see the reminder.

  **Note:** You must select both a Reminder Type and a Reminder time to trigger the reminder. The person assigned to this task can edit the task record to change the reminder settings.

4. Review and edit other subtabs as necessary.

**Message subtab:**
In the Notes field, enter notes or a description about this task. These comments appear in the email message sent to the person this task is assigned to.

**Related Records subtab:**
- Select a Company if this task is related to a customer, vendor, partner, or other name.
- The Contact field lists the contacts for the company you have selected. Select the contact associated with the task.
- If this task pertains to a support case, select the case number in the Support Case field.
- If this task is related to a transaction, select the transaction number in the Transaction field.
Select and add multiple companies and contacts associated with this task. For example, you can add the contact who requested the task or requires reporting on this task in the **Companies and Contacts** list.

**Availability** subtab – Displays the availability of the user assigned to the task.

**Communication** subtab:
- Click the **Files** subtab to attach a file to this event. For more information on attaching files, see **Attaching Files to Records**.
- Click the **User Notes** subtab to add any notes concerning this event.

**Time Tracking** subtab:
If you have enabled either the Time Tracking for CRM or Project Management feature, you can track time for this task. For more information, see **Tracking Time on CRM Tasks**.

5. After entering information on these subtabs, click **Save**.

You can change or update information for existing tasks by clicking **Edit** next to a task from the tasks list. As you work on your tasks or complete them, update the status of the tasks. If the tasks are not marked private, others can see your progress and know what you are working on. This facilitates communication between departments within your company.

## Tracking Time on CRM Tasks

You can enter time transactions to track the amount of time spent on each task. To track time on tasks an administrator must enable the Time Tracking for CRM feature. See the help topic **Enabling Time Tracking for CRM**.

With Time Tracking for CRM, you can track time on tasks, phone calls, events and cases. Tracking time on these activities can help you manage your company by being aware of how much time is spent on certain activities.

**To track time on CRM tasks:**

1. Click **Edit** next to an existing task record on the Tasks list at Activities > Scheduling > Tasks. For more information, see **Creating CRM Task Records**.
2. Click the **Time Tracking** subtab on the task record.

- **Note:** If any case, task, or event record has more than 9500 time entries to display on the Time Tracking subtab, all CRM tasks display a static list of time entries. You cannot edit entries directly from the list.

- **Note:** If you use the Project Management feature, you can include CRM tasks in project totals. Note, however, that you must use project task records to track tasks associated with specific projects.

The fields below display on the **Time Tracking** subtab only when you use the Project Management feature.
Working with CRM Tasks

- **Initial Time Budget** – Enter your first estimate of the time this task requires. Later you can increase or decrease your time estimate in the *Current Time Budget* field. By maintaining an initial time estimate in this field, you can compare your initial estimate to your current estimate. If you entered a time estimate on a project task template, that amount shows in this field.

- **Current Time Budget** – If your estimate of the time required by this task increases or decreases from your original estimate, enter the revised estimate in this field.

- **Actual Time** – This field shows the total amount of time entered against this task.

- **Time Remaining** – This field shows the estimated remaining amount of time for this task. Time remaining is calculated as \( (\text{Initial Time Budget} - \text{Actual Time}) \).

  If you have entered a *Current Time Budget* amount to update your initial time budget, then the time remaining for the task is calculated as \( (\text{Current Time Budget} - \text{Actual Time}) \).

- **Percent Time Complete** – This field shows the calculated total of work that has been completed to date in percent format. The percent complete is calculated as \( \frac{\text{Actual Time} \times 100}{\text{Initial Time Budget}} \).

  If you have entered a *Current Time Budget* amount, then the percent complete is calculated as follows: \( \frac{\text{Actual Time} \times 100}{\text{Current Time Budget}} \).

- **Percent Complete** – Enter an estimate of how much of the total amount of work for this task is already completed. For example, if half the work toward completion is done, enter 50%. The percentage you enter in this field overrides the auto-calculated figure in the *Percent Time Complete* field and is used for task calculations.

3. **Click New Time**. A popup window opens with a new time entry form.

4. Your name appears in the *Employee* field. Depending on your role access, you can select another employee if you are entering time for someone else.

   **Note:** For private tasks, only employees listed as assigned to the task can track time against the task.

5. Enter information for this time transaction.

   For more information about entering time for Time Tracking, see the help topic *Entering a Time Transaction*.

   For more information about entering time for Timesheets, see the help topic *Timesheets*.

6. **Repeat this process to track time for additional customers or employees for this task.**

7. **Click Save.**

   For instructions on limiting employees' ability to enter time records, see the help topic *Restricting Employee Time Tracking Entries*. Employees can also use the Employee Center to track their time. For more information, see the help topic *Giving an Employee Access to Time Tracking*.

You can view employee time on the Reports page under the Time & Billables heading.

## Tasks and Project Tasks Portlets on Your Dashboard

NetSuite provides two portlets to help you manage tasks. You can add a portlet to show CRM tasks and, if the Project Management feature is enabled, a portlet to display project tasks.

### Tracking CRM Tasks

Use the Tasks portlet on your home page to track work you need to complete on CRM tasks.
If you use the Inline Editing feature, you can change a task's status to Completed in the Tasks portlet. Changes made to a task in the portlet are automatically changed on the task record. You can also click Edit next to a task in the Tasks portlet to update the information on a task record. For more information, see Using Inline Editing.

By default, the Tasks portlet displays each task's due date, title, company involved, priority, and status. To change the displayed fields, click Customize View on the portlet menu, or choose from the View field if available.

You can also:

- Choose an option in the Quick Sort field to change the order in which tasks appear.
- Click New Task on the portlet menu to enter a new task record.
- Click Set Up to set the number of tasks that show in the portlet.
- Click the refresh icon to update the portlet after you update or complete tasks.

For information about working with CRM tasks, see Working with CRM Tasks.

Displaying Project Tasks

If you use Project Management, the Project Tasks portlet displays project tasks on your dashboard. The portlet shows project tasks assigned to all resources and provides quick access to project task information. For more info, see the help topic Project Tasks Portlets.

If you use the Inline Editing feature, you can change a project task's status in the Project Tasks portlet. Changes made to a task in the portlet are automatically changed on the task record. You can also click Edit next to a task in the Tasks portlet to update the information on a project task record.

By default, the project tasks portlet displays the project, task ID, task name, estimated work, actual work, start date, and end date for each task. To change the displayed fields, click Customize View on the portlet menu, or choose from the View field if available.

Use the portlet filter options to select the range of tasks to display in the portlet. Filter selections are sticky changes, meaning your selections are saved until you change them.

- **Assignee** – Display all project tasks or only tasks assigned to a specific resource or group of resources. You can also select to display unassigned tasks.
- **Priority** – Select to view project tasks by importance.
- **View** – Create a custom database view if you want to limit the project tasks displayed in the portlet to a segment of all project tasks.
- **From-To** – View a range of tasks based on the project task column selected. For example, if you select to sort by task name, you can then select a range of task names to display on the portlet.

For information about working with project tasks, see the help topic Project Tasks.

Working with Phone Calls

Use phone call records to document business calls. Phone call records include information about the call, such as the organizer and the date completed. You can also display phone calls on your NetSuite calendar, and link the phone call to another record type such as company, contact, or support case. After a phone call is linked to another record type, the phone call appears on the Activities subtab of that record.
For more information about working with phone calls, see the following:

- **Scheduling or Logging Phone Calls** describes how to create phone call records in NetSuite.
- **Tracking Time on Phone Calls** describes how to use phone call records in NetSuite to track time spent on each call. Note that you must use the Time Tracking for CRM feature to take advantage of this functionality.
- **Making Calls From NetSuite** describes how to make outbound calls directly from records in your NetSuite account.

### Making Calls From NetSuite

When you use the Telephony Integration feature, you can initiate calls from the following pages in NetSuite:

- Relationship record lists
- Phone call list
- Phone call records
- Relationship records
- Saved search results that include phone numbers
- Subtab lists on records that include phone numbers
- Any record, list or saved search with a phone custom field

**Note:** The Telephony Integration feature must be setup and enabled by your account administrator. See the help topic Using Telephony Integration. After the feature is enabled, users must set their personal preferences. See Personal Preferences for Telephony.

To make a call, click on the phone icon or underlined phone number from a list or record.

To end the call, you can hang up the phone or click the next phone number to end the current call and begin a new call.

For example, you go to Activities > Scheduling > Phone Calls > Search, and click Create Saved Search to create a search of the phone calls that need to be completed today. From your list of results, you click the phone icon next to the first phone number in the list. Your phone then rings to signal the call is ready. When you pick up the receiver, the phone number is dialed, and your call is connected. To end the call, you click the phone number of the next customer and continue with the process.
Scheduling or Logging Phone Calls

You can use phone call records to schedule calls and list them in order of the due date and priority. Or you may use phone calls to document customer feedback whenever a customer calls you. NetSuite stores the information on a record in the Phone Call list on the customer record who calls and on the contact’s record who called for the customer.

When you receive a phone call from a customer, for example, go to the customer record, click Call in the New bar at the top of the record, and enter the details and reason the customer is calling.

**To schedule or log a phone call:**

1. Go to Activities > Scheduling > Phone Calls > New.
2. If you have created a custom form you want to use for this record, select that form in the Custom Form field.
3. In the Subject field, enter the main subject of the discussion.
4. In the Organizer field, select who is responsible for making the call. Your name appears here by default.
5. In the Phone Call Date field, enter the date the call is scheduled for.
6. Check the Reserve Time box to schedule this phone call on the calendar.
   - If you want phone calls that do not reserve time on your calendar, check the Display Non-blocking Phone Calls in Calendar box on the Personal Calendar Preferences page at Activities > Setup > Calendar Preference.
7. If you are scheduling this call, select the Start Time and End Time.
   - Use the Availability subtab to see when the organizer (you) and all added participants with NetSuite records are available.
8. In the Date Completed field, enter the actual date this call was completed if different from the scheduled date.
9. In the Phone Number field, you can enter the number dialed to make this call if it is different from the number of the participant selected below.
10. In the Status field, select whether this phone call is Scheduled or Completed.
11. Check the Private Phone Call box to display this call only in your list of calls. If you use Time Tracking for CRM, only employees listed as participants on the phone call record can track time against a private call.
12. If this is a scheduled call, select the Reminder Type you want:
   - None – No reminder is triggered.
   - Email – An email reminder is sent to the email address on the employee record for the person selected in the Organizer field.
   - Popup – A popup reminder opens when the organizer is logged in to NetSuite.
   - You must also select a reminder time to set the reminder.
13. In the Reminder field, enter the time increment before the time set in the From field that a reminder should be triggered.
   - You must also select a reminder type to set the reminder.
14. In the Notes field, enter notes or a description of the content of the phone call.
15. On the Related Info subtab, select a company if this call is related to a customer, vendor, partner, or other name.
   - The Contact field lists the contacts for the entity you have selected.
16. In the Contact field, select the contact with whom this call is associated.

17. If this call pertains to a support case, select the case number in the Support Case field.

18. If this call is related to a transaction, select the transaction number.

19. On the Participants subtab, you can add listings for those participating in the call. Choices are available from the Participant dropdown list. Available choices include employees, customers, partners, vendors, and other names.

20. Attach files relating to this call on the Files subtab.

21. Click Save.

Your phone call is now documented. If the phone call was set as completed when it was created, it remains in the tasks list until it is marked Completed.

To mark a phone call Completed, go to Activities > Scheduling > Phone Calls, and click Edit next to the phone call that has already been placed to open its record and change the status. If inline editing is enabled, you can change the status directly in the list. For more information, see Using Inline Editing.

Tracking Time on Phone Calls

Tracking time on phone calls can help you manage your company by being aware of how much time is spent on the phone. The Time Tracking for CRM feature must be enabled to track time on phone calls. An administrator must enable the Time Tracking for CRM feature. (See the help topic Enabling Time Tracking for CRM.)

To track time on phone calls:

1. Go to Activities > Scheduling > Phone Calls.
2. Click New Phone Call to create a new phone call, or click Edit next to the call you want to track time for.
3. Click the Time Tracking subtab.

   **Note:** If any case, task, or event record has more than 9500 time entries to display on the Time Tracking subtab, all phone calls display a static list of time entries. You cannot edit entries directly from the list.

5. Your name appears in the Employee field. Depending on your role access, you can select another employee if you are entering time for someone else.

   **Note:** For private phone calls, only employees and vendors listed as participants on the phone call record can track time against the call.

6. Enter information for this time transaction. For more information about entering time for Time Tracking, see the help topic Entering a Time Transaction. For more information about entering time for Timesheets, see the help topic Timesheets.
7. Repeat this process to track time for additional customers or employees for this call.
8. When you have finished entering information for this call, click Save.

Employees must enter their time in the Employee Center even if they also track time on phone calls.
Working with Email

You can send information using your NetSuite account and can track all communication between you and those you do business with. Whether through email, letters or over the phone, all of the information you need can be planned and executed through NetSuite. See Sending Email from NetSuite.

You can also install NetSuite for Outlook which enables you to save messages from your Outlook mail account to NetSuite records. For more information, see the help topic NetSuite for Outlook.

For a complete list of accepted top level domains you can use for setting up your email address, see the Internet Assigned Numbers Authority Web site.

Transport Layer Security Support

NetSuite supports Transport Layer Security (TLS) for incoming and outgoing email messages. Note the following:

- TLS support applies to the SMTP protocol only.
- For outgoing email, TLS support depends on the recipient email server. NetSuite attempts to deliver outgoing email in an encrypted form, but if the recipient email server does not support encryption, email is delivered in plain text form.

Sending Email from NetSuite

You can send email to the people you do business with directly from the NetSuite application. For information about sending email from NetSuite, see the following:

- Sending Email from Records
- Sending Email Directly from Lists and Records
- Emailing Transactions
- Sending Search and Report Results Email
- Customizing Email Signatures and From Fields
- Using Variable Envelope Return Paths

Email sent from NetSuite uses one of the following as the From address:

- the email address set in the From Email Address field at Home > Set Preferences > General under User Profile, or
- if there is no from email address entered on the Set Preferences page, the employee’s login email address

When the recipient replies to the email message, this reply is sent to the email address used to send the original message.

Working with Files Attached to Email Messages

Files attached from your computer to email you send from within NetSuite are stored by default in the Attachments Sent and the Attachments Received folders in the File Cabinet. These folders are also used when you save messages you receive outside of NetSuite to a record.

The attachment folders are system-generated folders in the File Cabinet only used to hold these files, so files in these attachment folders are not available to select as attachments when sending email. If you want to attach a file from one of these folders to an email message, you must move the file to another folder prior to sending the email message.
For more information, see Moving and Copying Files from the File Cabinet. See also, Sending Email from Records.

Sending Email from Records

Email messages you send from NetSuite records are saved on the Messages subtab for each contact receiving the message as well as on the record you send the email from.

Note: If you want your emails to include records of phone calls or tasks, for example, export them at Activities > Scheduling > Phone Calls into a file of your preference and send them manually.

You can choose to email a contact from the following types of records:

- Contact
- Customer
- Lead
- Prospect
- Vendor
- Company
- Other Name
- Partner
- Opportunity
- Transactions

To send email from a record:

1. On the record you want to send an email message from, click the Communication subtab. For some non-administrator roles and record types, click the General subtab.
2. On the Messages subtab, do one of the following:
   - If you are replying to or forwarding an email message, click View next to the email message, and then click Reply, Reply to All, or Forward.
     If you are replying, attachments are not included by default and can be added on the Attachments subtab. Forwarded messages include attachments by default.
   - If you are sending a new email message, click Email.

Note: You cannot forward messages on employee records or on contact records that are not associated with a company.
### Sending Email from NetSuite

3. Click the **Message** subtab.
   1. To use an email template in this message, select a category to filter the list of templates to show only those in this category.
      
      This field is only available if you have enabled the CRM Template Categories feature.
   2. Select a template you have uploaded to NetSuite.
      
      For more information on creating email templates, see the help topic **Creating New Email Templates**.
   3. Check the **Update** box to update your template with any edits you make in the **Message** field.
   4. In the **Subject** field, enter a subject for this message. This field is mandatory.
   5. Check the **Request Read Receipt** box to request read receipts from individual recipients.
      
      For more information on creating email templates, see **Requesting Read Receipts**.
   6. Choose the template format you want to use for this message.
      
      For more information, see the help topic **Creating New Email Templates**.
   7. Use the **Field Type** field and the Insert Field to add field tags in your message.
   8. In the **Message** field, enter your email message. NetSuite uses your browser's spelling checker to check your text. Click CTRL + right-click to view the context menu and select the correct spelling.
      
      If you selected a template file, you can edit the message in this field.

   **Note:** You can send an inline picture by copying and pasting the picture into the message field.

4. Click the **Attachments** subtab.
   1. Check the **Zip Attachments** box to compress the files you are sending.
   2. In the **Attach Document Template** field, select a letter template to format your attachment.
   3. To attach a statement to this message, check the **Include Statement** box, and select the date of the statement.
      
      - In the **Start Date** field, you have the option of entering the date of the oldest transaction you want to appear on the statement.
      - In the **Type** field, you can select the type of statement to attach.
      - You can enable the **Show Only Open Transactions** option to include only open transactions in the attached statement. If you enable this option and do not enter a start date, the statement includes all open transactions in the customer's history.
   4. In the **Attach File** column, select the file from your File Cabinet you want to attach to this message. Select **New** to upload a new file from your hard drive. Email attachments must be 5MB or smaller.

   **Note:** A file in the **Attachments Sent** folder or **Attachments Received** folder cannot be associated with records or transactions. You must first move the file to another folder. For more information, see **Working with Files Attached to Email Messages**.

5. Click **Add** after each attachment you want to add.

5. Click **Send**, or if you use the Mail Merge feature, click **Merge & Send**. For more information, see the help topic **Working with Mail Merge**.
If contacts for your customers, vendors or partners reply to the email you send from NetSuite, that reply is both sent to the email address you log in with and automatically saved to the Messages subtab of the contact record and customer, vendor or partner’s record.

You can also save messages you receive. For example, if you receive a phone call from a customer contact, you can record the message of the call on the customer’s record. See the help topic Saving Messages from Contacts for more information.

**Note:** If you use the UK Edition, to comply with UK law, your business address and VAT number are included in the footer of all email you send to those outside of your company. You can click View History to view all messages sent to and from contacts.

### Requesting Read Receipts

Read receipts ensure that recipients have received a message, which is important when sending important information or time-sensitive transactions. With NetSuite, you can include read receipts on outgoing email messages to individual recipients.

When you check the Request Read Receipt box on an email message in NetSuite, the email client of the recipient receives a read receipt request. Email clients handle read receipt requests in various ways. Depending on the configuration of the recipient’s email client, the recipient can decide to respond to the read receipt request when the message is viewed. All received read receipts are forwarded to the original sender of the message and tracked on the message record in NetSuite, providing an audit trail within the application. You can view the status of read receipts on the Read Receipts subtab of a message record.

The status may contain either of the following values:

- **Confirmed** — The message was displayed to someone reading the recipient’s mailbox. There is no guarantee that the content has been read or understood.
- **Message Deleted** — The message was deleted without reading. There is no guarantee that the recipient has seen the message

### Sending Email Directly from Lists and Records

In NetSuite, you can send email to the people you do business with by sending email directly from NetSuite lists and records using your personal email account.

**Important:** These messages are not saved in NetSuite, and you cannot receive replies to these messages in NetSuite.

**To send email from a list:**

1. On the Lists tab, under the Relationships heading, select the type of record for the person to whom you want to send an email (such as customer or vendor).
2. If the email address is not already showing in the list, make a selection in the View filter of the list to display a list with an Email column. (For example, the All view and the Basic view include an Email column.)
3. Click the Compose Email icon next to an email address. This opens a new message window in your personal email account with the To field completed.
4. Enter a subject and message text, and click Send. Then you can continue working in NetSuite.
Tip: NetSuite uses your browser's spelling checker to check your text. Click CTRL + right-click to view the context menu and select the correct spelling.

To send email from a record:

1. On the record, click the icon next to an email address for a contact. This opens a new message window in your personal email account with the To field completed.
2. Enter a subject and message text, and click Send. Then you can continue working in NetSuite.

Sending Search and Report Results Email

You can send other users email containing results from searches and reports of NetSuite data. An Email button is available on most report and search results pages.

- For information about sending email directly from a report results page, see the help topic Emailing a Report.
- For information about sending email directly from a search results page, see the help topic Emailing Search Results.

If you are an administrator or have at least Create level of the Publish Search permission, you can enable system-generated search email messages on the Email subtab of a saved search page. You can use saved search email to share complete search results with other users, to schedule long-running searches for low usage times, and to alert targeted users about changes to their important records. For more information, see the help topic Saved Search Email.

Attaching Files to Email Messages

You can attach documents including PDFs to email messages sent through NetSuite.

Note, however, that files in the Attachments Sent and the Attachments Received folders are not available to be attached. These attachment folders are system-generated folders used as repositories for files you attach from your computer to email messages you send from NetSuite and also for files attached from messages you save in NetSuite.

If you want to attach a file from one of these folders to an email message, you must move the file to another folder prior to sending an email message. For more information, see Moving and Copying Files from the File Cabinet.

Note: Email messages cannot exceed 15,000,000 bytes (approximately 15 MB) in size. This includes the size of the message body and all attachments.

To attach a file to an email message:

1. On the Email Message popup, click the Attachments subtab.
2. Check the Zip Attachments box if you want to compress the files you are attaching.
3. In the Attach File column, select the file and click Add. Repeat this for each file you want to attach.

   Note: Files in the Attachments Sent folder and the Attachments Received folders are not available to select here.

4. When you are finished composing your email, click Merge & Send.
Customizing Email Signatures and From Fields

You can set up an email profile to determine the following for email you send through NetSuite:

- the name that appears in the From field
- the From email address
- a custom signature

**To set up your email profile:**

1. Go to Home > Set Preferences, in the User Profile area of the **General** subtab.
2. In the **Nickname** field, enter the name you want to appear in the **From** field on the email you send.
3. In the **Signature** field, enter an email signature using HTML markup.
   
   For information on how to create an HTML signature file, see *Adding Images and Links to an Email Signature*.

   **Note:** You can enter up to 4000 HTML characters in this field.

4. In the **From Email Address** field, enter the email address you want to appear in the From field on email you send.
5. Click **Save**.

To include your email signature, you must include the following FreeMarker syntax in the email:

```mermaid
$(preferences.message_signature)
```

You can also place this marker in email templates. If you do not enter a nickname or a From address, your login email address appears in the From field.

**Adding Images and Links to an Email Signature**

If you are not familiar with working with HTML the simplest way of creating an email signature containing rich-formatted text, images and links, is to use NetSuite’s email editor. You can either access the editor from an entity record (Customer, Company, Lead and so on) by clicking the Communications subtab > Messages > Email. Or, in the case of the procedure below, from the Email Templates record. The editor is the same in all cases.

**To create an email signature using NetSuite’s email editor:**

1. Go to .

2. Enter your signature information in the editor.

3. Optional: to add an email link, click the link icon (top right hand corner of editor). Set the **Link Type** to **E-mail**. Complete the additional fields.
4. Optional: to add an image to a signature, first make sure the image has been uploaded to NetSuite's File Cabinet. See Uploading Files to the File Cabinet.
   a. Open a new browser tab/window and go to .
   b. Locate the required image file and click Edit.
   c. Copy the URL which begins https://system.netsuite.com/

5. Return to the email editor. Click the image icon (top left hand corner of editor).
6. Paste the File Cabinet image URL into the URL field. Input sizing and alignment options as required. Click OK.
7. Switch to the editor's markup view by clicking the DIV icon (top left corner of editor).
8. Copy all lines of the markup code.
   a. Optional: save the email template file for future use.
   b. Discard the template file.

9. Go to .
10. Clear any existing content from the Signature field, and paste in the copied HTML.
11. Check the Add Signature to Messages box.
12. Click Save.
File Cabinet Overview

You can use the NetSuite File Cabinet to store and organize your business documents in much the same way as you store any files on your computer. You can store files that you receive or plan to send by email. Also, you can attach files stored in the File Cabinet to records in NetSuite, such as customer records, transactions, and issues. Most File Cabinet folders can be restricted either by the folder owner or an administrator.

Your NetSuite account configuration or configuration of other critical business systems might depend on data in files stored in your NetSuite File Cabinet. In the File Cabinet, you cannot restrict edit access at the file level. You can only restrict access to the folder that contains the file. You should set strict access control for which classes of users can modify or, if applicable, view those files in specific folders. Otherwise, an account user might be permitted to change the configuration data in the file. A configuration change can potentially break the system or cause it to function in a way in which it was not intended. Consider a critical workflow system that relies on a configuration containing a value APPROVER=email@example.com, and this configuration is accessed from a File Cabinet file. A user able to edit the configuration file can replace the email address and subvert the approval mechanism. Ensure that only users suitably authorized to make edits on the file have edit privileges. For more information, see Restricting Access to File Cabinet Folders.

To prevent unauthorized access to a File Cabinet file through the internet, you can make a file available only with login. For more information, see Permissions and File Cabinet Files.

To enable all company users to have view access to a file, you can make a file available for company-wide usage. For more information, see Making a File to Available to All Company Users.

The File Cabinet in NetSuite includes some folders that are created by default, depending on the features enabled in your account. You can identify the folders that are created by NetSuite because the Internal ID is a negative number. In some cases, these folders serve a specific purpose. For example, SuiteScripts are stored in the SuiteScripts folder.

Every file loaded into the File Cabinet has a system notes record to track changes made to the file, including the context and when the changes were made. For more information, see the help topics System Notes Overview and Searching System Notes.

System notes for JSON, XML, and JavaScript files also include a File Content Hash field. The File Content Hash field is calculated by NetSuite based on the file contents, so it changes every time the file changes.

Some files in the File Cabinet contain links that use URLs. Ensure that the URL links in those files are account-specific. For example, the File Cabinet link should be &lt;accountID&gt;.app.netsuite.com, where &lt;accountID&gt; is a variable representing your account ID. Use the Account Traffic Health feature to identify any existing data center-specific links that you should update to account-specific links. For more information, see the help topic Traffic Health Reports.

The File Cabinet and your Website

If you use Site Builder or SuiteCommerce Advanced, all website assets, including SSP Applications are stored in the Website Hosting Files folder. For more information, read the following topics:

- For information about hosting HTML files for a Site Builder website, read the help topic Website Hosting with Site Builder.
- For more information about SSP Applications, read the help topic SSP Application Overview.
- For more information about SuiteCommerce Advanced, read the help topic SuiteCommerce Development Overview.
You can also create a company intranet site and post links to files stored in the File Cabinet. The following features are required to publish files to an intranet site:

- File Cabinet
- Document Publishing
- Intranet

Searching and Viewing Files in the File Cabinet

To search for a file, type a keyword in the Search box, and then click Search. A list of files and folders is displayed in the right panel. You can search based on keywords found in file names and folder names.

You can click on a file name to view it. If the file is an image file or PDF, a preview window opens and displays the file. Other types of files are automatically downloaded.

To view a file in the File Cabinet

1. Go to Document > Files > File Cabinet.
2. Click on the folder name to view a list of files within that folder.
3. Click on the file name to view the file.

To view a file attached to a customer or other record type:

1. Find the record where the file is attached.
2. Click the Communication subtab.
3. Click the Files sublist.
4. Click the file name.

Permissions and File Cabinet Files

This section includes information about how roles and permissions affect files and how to restrict File Cabinet folders.

To make images and other files available for all company users to view, check the Company-Wide Usage box on the file record. For example, the company-wide access permission makes images available to company users in printing templates, but does not permit unauthorized external users access to the image file. For more information, see Making a File to Available to All Company Users.

If you use the File Cabinet to host website files, you will want those files to be publicly accessible. It is important that you check the Available Without Login box on the file record for all of those files. Files that do not have this box checked are not displayed on the website.
Note: If both the Available Without Login box and the Company-Wide Usage box are checked, Available Without Login takes precedence.

For more information, read Making Web Site Hosting Files Always Available.

To learn about how to restrict access to files in certain folders, read Restricting Access to File Cabinet Folders. Note that you cannot restrict files on an individual basis.

When you use OneWorld, access to various NetSuite records, including File Cabinet files, can be restricted by subsidiary. For more information, read the following topics:

- Control Employee Access to Subsidiaries
- Customizing or Creating NetSuite Roles
- Restrict Your Subsidiary View

Making Web Site Hosting Files Always Available

You can use the Available without Login box on file records to restrict external access to individual files. However, files you want to publish on a company intranet or an ecommerce website must have the Available without Login box checked to be displayed correctly on your website.

Web Site Hosting Files Always Available is a general company preference in NetSuite. This preference is checked by default. It affects how files in the Web Site Hosting Files folder and files in the SuiteBundles folder are made available online. This global setting overrides the Available Without Login and the Company-Wide Usage boxes on individual file records. To clear the general preference, go to Setup > Company > General Preferences.

Files stored in Web Hosting Files folders using Add File or Advanced Add are automatically available without login. On Advanced Add, the Make All Files Available Without Login box is checked by default. When a file is added using Add File, the available without login setting is applied automatically.

The Available Without Login setting makes web site assets accessible on your shopping domain. In this way, visitors to your ecommerce site can view images and website content using their web browsers. The Available Without Login setting appears as a check box on all file records in the File Cabinet.

By default, files uploaded using SuiteScript are available only with login, regardless of which folders the files are saved in. To make files uploaded using SuiteScript available without login, you must set the parameter on the upload script or check the Available Without Login box.

Note: The Company-Wide Usage box on individual file records does not affect whether the file is accessible on your website or not. File availability on the website is controlled by only the Web Site Hosting Files Always Available preference and the Available Without Login setting.

SuiteScript (.ss files) and SuiteScript Server Pages (.ssp files) stored in the Web Site Hosting Files Folder function as executable files. Both general preferences and individual file settings are overridden by Audience settings on the Permission subtab on each file. Depending on the settings on the Permissions subtab, these files return either the expected script response value or a Permission Violation.

Setting the General Preference

When the Web Site Hosting Files Always Available box is checked, your settings for the Available without Login check box are ignored on individual file records. Files stored in the Web Site Hosting Files
and SuiteBundles folders are accessible on all URLs listed on the file record. Anyone can access these files on a NetSuite shopping domain or a custom domain that you set up in NetSuite. Both JavaScript server-side and JavaScript client-side files are available to download.

### Clearing the General Preference

When the **Web Site Hosting Files Always Available box is cleared**, your settings for the Available Without Login check box are recognized on individual files. You can clear the Available Without Login box on individual files stored in the Web Site Hosting Files and SuiteBundles folders to make them unavailable on a shopping domain. Files with the Available Without Login box cleared, return 404 Not Found errors when accessed using a shopping domain.

**Warning:** If the Available Without Login box is cleared on image files published to your website, those images are not displayed, and the website may appear broken.

### Restricting Access to File Cabinet Folders

Within your organization, you can restrict access to files by setting permissions on File Cabinet folders. You cannot restrict files on an individual basis, only by restricting access to the enclosing folder. You can set permissions based on various criteria, such as location, and department.

When a folder is marked as private, only the person who created that folder and the account administrator have access to it. Administrators can view the contents of any folder, including private folders and folders that have been restricted. If you create a folder, you become the owner of that folder. The owner of a folder always has access to the folder regardless of restrictions.

### Restricting Access to Subfolders

Note the following when you restrict access to a folder with subfolders:

- If a subfolder is created under a parent folder **after** the parent folder was restricted to a group, the subfolder automatically inherits the parent folder's restriction. You can change the subfolder's restriction.
- If a parent folder's restriction is changed **after** a subfolder was created, the subfolder does **not** automatically inherit the new restriction. You can manually apply the restriction to the subfolder.

### Hiding Attachment Folders

An Administrator can set the Hide Attachment Folders preference at Setup > Company > General Preferences to prevent access to the following folders:

- Attachments Received
Attachments Sent
Mail Merge

When this preference is set, employees and partners still have access to files that are attached to customer and other record types even if the files reside in one of the folders listed above. However, they are unable to view or search for those files in the File Cabinet.

To ensure that only users with adequate permission can access confidential records and associated files in the File Cabinet, the attachments folder is hidden by default. As of 2020.1, the Hide Attachments Folder box on the General Preferences page defaults to checked for all new customers.

Note: The Hide Attachment Folders preference overrides any restriction applied to a subfolder of the Attachments Received and the Attachments Sent folder.

To change the restricted access setting in a folder:

1. Log in to NetSuite with a role that has access to the folder.
2. Go to Documents > Files > File Cabinet
3. Click Edit on the folder to which you want to restrict access.
4. Select from the dropdown lists to restrict access in the following categories:
   - Restrict by Class
   - Restrict by Department
   - Restrict by Location
   - Restrict by Group
   - Restrict by Subsidiary – Note that employees assigned to the parent subsidiary can access all child subsidiary folders. To change this behavior you can restrict the folder by group. See File Access Restriction by Subsidiary in File Cabinet, SuiteAnswers ID: 35400 for instructions.

Note: Category names may be different depending on customization of your NetSuite account.

5. Click Save.

All files in the folder are available based on the restricted access settings you selected.

Making a File to Available to All Company Users

The Company-Wide Usage feature adds view access to a file for every company user. For example, if an image used in an email message is marked for company-wide usage, all company users can view the image. You can make a file available for all company users, even if the file is within a private folder or otherwise inaccessible to a specific group. When you enable the Company-Wide Usage feature, company users with existing permission to edit the file continue to have both view and edit access. Other company users can only view the file. To specify that the file be available for all company users, check the Company-Wide Usage box on the file record.

You can configure an image available in an advanced printing template to make it available to all company users. To use the company-wide usage functionality for images in advanced templates, you must also set the image as a File Cabinet item. In the advanced template editor, check File Cabinet Item on the Advanced tab of the Image Properties window. For more information, see the help topic Including Images in Advanced Templates.
You can upload multiple files with company-wide access to the File Cabinet at one time. To do so, use the Make All Files Available for Company-Wide Usage box in Advanced Add. The Company-Wide Usage box for each file is automatically checked. For more information, see Uploading Files to the File Cabinet.

**To make a file available for all company users to view:**

1. Go to Documents > Files > File Cabinet.
2. To view a list of files within a folder, click the folder.
3. For the appropriate file, click **Edit**.
4. On the file record page, check the **Company-Wide Usage** box. If this box is not checked, the image will not be available in any advanced template printouts that reference the file.

   ![Image of file record page with Company-Wide Usage box]

   **Note:** To make the file available only to company users, you should clear the Available Without Login box. You can check both boxes, however checking the Available Without Login box makes the file publicly available.

5. Click **Save**.

You can also perform a mass update to define a list of files that should be available for company-wide usage. For more information about mass updates, see the help topic **Mass Changes or Updates**.

**FreeMarker Directive for Company-Wide Usage**

When the Company-Wide Usage box is checked in the File Cabinet, the **filecabinet** FreeMarker directive is used in the source code. In WSYISWG mode, this directive is added automatically. If you edit templates in the source code, you can use the **filecabinet** FreeMarker directive to reference files directly from the File Cabinet.

For more information about the filecabinet FreeMarker directive, see the help topic **Syntax for Advanced Template Fields**.
Making a File to Available to All Company Users

For more information about setting the File Cabinet property, see the help topic Including Images in Advanced Templates.

Working with File Cabinet Folders

You can use folders to organize the files in your File Cabinet. Permissions applied to File Cabinet folders determine who can see files stored there. You can create your own folders, but some folders already exist in the NetSuite File Cabinet by default. If you use the Web Store feature or the Marketing Automation feature, a folder already exists where you can store your files for these purposes.

You can also restrict access to files in folders that you create. For more information, read Permissions and File Cabinet Files.

Creating File Cabinet Folders

To set up your File Cabinet, you first need to create folders in which you store your documents and images. Use the following instructions to create new folders in the File Cabinet.

To create a folder:

1. Click the Documents tab.
2. On the File Cabinet page, click New Folder.
3. In the Folder Name field, enter a name for this folder. You will select this name when you attach documents and images to records.
4. In the Sub-Folder of field, select this folder's parent folder if one exists.
5. The Type field is automatically populated with the appropriate type for the subfolder selected. In most cases, the type folder is set to Documents and Files.
6. In the Description field, enter a brief message describing what you store in this folder.
7. You can restrict the folder based on various classification settings in your account. Only users with the selected settings can access the files in the folder. Folder contents do not appear in searches or any other area of NetSuite for users outside of the selected department, location, group, and so on. Administrators and the owner of this folder can always access the contents of this folder. For more information, Restricting Access to File Cabinet Folders.

Note: You should avoid creating large numbers of subfolders wherever possible. If you attempt to move files to another folder using the Move To dropdown list, the number of displayed folders is limited to 10,000. Furthermore, you are advised to not create more than 50,000 subfolders as it becomes increasingly difficult to organize files in a great number of subfolders. If you do have a requirement for subfolders in excess of these recommendations, you are advised to manage file movements using the mass update files method. See the help topic Defining a Mass Update.

NetSuite Basics
Working with File Cabinet Folders

- If you use locations and you want to restrict this folder by location, select the location in the **Restrict by Location** field.
- If you use groups and you want only members of a group to use this folder, select the group in the **Restrict by Group** field.
  
  If you choose a dynamic group, for performance reasons, the folder is restricted to a snapshot of the dynamic group members. The snapshot is updated twice a day.
- If you use subsidiaries and you want to restrict this folder by subsidiary, select the subsidiary in the **Restrict by Subsidiary** field. Note that employees assigned to the parent subsidiary can access all child subsidiary folders. To change this behavior you can restrict the folder by group. See File Access Restriction by Subsidiary in File Cabinet, SuiteAnswers ID: 35400 for instructions.

8. If you want to make this a private folder, check the **Private** box.
9. If the **User Notes** subtab is displayed, you can add any notes pertaining to this File Cabinet folder.
10. When you have finished, click **Save**.

Your folder is immediately available in the File Cabinet. You can upload files to the folder. The files are available to others who have access to your NetSuite account, based on the restrictions you set on the folder.

Creating a Dedicated Employee Expense Folder

You can configure NetSuite to predefine dedicated folders where employee-specific expense report attachments are automatically saved. If you have the Administrator role, you can see the contents of these folders, but employees cannot locate or access these attachments from the File Cabinet. Employees must instead access their expense attachments from the expense report record.

**To create dedicated employee expense folders:**

1. Go to Setup > Company > Enable Features.
2. Click the **Company** tab.
4. Click **Save**.

Use the Expense Report Attachments Migration Tool to migrate any existing expense attachments to the File Cabinet dedicated employee expense folder structure. The migration tool searches all expense reports for files that should be moved to the predefined user folders. For more information, see Expense Report Attachments Migration Tool.

Creating a Shortcut to a File Cabinet Folder

In the Shortcuts portlet on your NetSuite Home page, you can add links to the File Cabinet folders you most frequently use. To create a shortcut for a folder, use folder’s internal ID to construct a URL that points to the folder. Next, use the URL to set up a new shortcut in the Shortcuts portlet.

**To create a shortcut on your NetSuite Home tab:**

1. Click the **Documents** tab.
2. Find the internal ID for the folder.
   - Hold your mouse over the folder as displayed in the File Cabinet title bar.
b. Remember the internal ID displayed at the bottom left of the browser window.

3. Click the Home tab.

4. In the Shortcuts portlet, click New Shortcut.

   **Note:** If the Shortcuts portlet does not display on your Home tab, click Personalize in the upper right, and then select Shortcuts in the Personalize Dashboard area.

5. Append your folder's internal ID to the end of the URL below, which displays a File Cabinet folder: https://<accountID>.app.netsuite.com/app/common/media/mediaitemfolders.nl?folder=

   For example:

   ![Example URL](https://<accountID>.app.netsuite.com/app/common/media/mediaitemfolders.nl?folder=8)

6. Click Save.

   After creating the shortcut, you can navigate directly to this folder by clicking the link in the Shortcuts portlet on your NetSuite Home page.

Deleting Folders from the File Cabinet

You can delete a folder that contains files and subfolders, or you can delete an empty folder. If the folder contains a file that is attached to a record, the delete operation fails. A popup alert displays indicating that you must remove the file from the record to proceed.

**To delete a folder containing files:**

1. Go to Documents > Files > File Cabinet.

2. Locate parent folder of the folder you want to delete.

3. Click Delete Files.

4. A list displays of files and subfolders in the parent folder. Check the box next to the folder you want to delete.
5. Click **Delete**.

### To delete an empty folder:

1. Go to **Documents > Files > File Cabinet**.
2. Locate the empty folder you want to delete.
3. Click **Edit** next to the folder name.
4. Expand the **Actions** menu.
5. Click **Delete**.

### Uploading Files to the File Cabinet

You can upload a file by clicking the Documents tab, and then selecting a folder. NetSuite accepts all file formats in the File Cabinet. The File Cabinet shows the file extension and lists the file type. You can also upload files by clicking the Communications subtab on transaction records and relationship records. When you attach files to records, you are required to select or create a folder where the document can be stored in the File Cabinet.

**Note:** If Use Employee Specific Expense Folders is enabled, expense file attachments automatically submit to a dedicated employee expenses folder, predefined by the system. For more information, see [Creating a Dedicated Employee Expense Folder](#).

You can make the files available to all company users, even if the file is within a private folder or otherwise inaccessible to a specific group. Check the Company-Wide Usage box on the file record. For example, you might want to make images that will be used in advanced PDF/HTML template printing available to company users only. For more information, see [Making a File Available to All Company Users](#).

All files uploaded to the File Cabinet are scanned for viruses and malicious content automatically. For more information, see the help topic [Antivirus Scanning on File Cabinet Files](#).

### Best Practice for Preparing Files for Upload to the File Cabinet

The following list contains best practices for preparing your files for upload to the File Cabinet:

- When uploading files, include the file extension according to the file type. For example, PDF files must include the file extension, `.pdf`.
- Work with files of 100 MB or less. Note that various factors may affect the time it takes to upload and download files greater than 100 MB, such as network speed, time-out settings, and overall space limitations.
- Ensure the name of the file you upload is fewer than 99 characters including the file extension.
Ensure that any File Cabinet files containing URL links use account-specific URLs. For more information, see the help topic How to Transition from Data Center-Specific Domains.

**Important:** Unless you have purchased additional storage space, each NetSuite account comes with 10 GB of total storage space.

Unsupported Symbols in File Names

The following characters are not supported in file names uploaded to the File Cabinet. It is strongly advised that even if these characters are permissible by your operating system, you avoid using them as they can cause unexpected behavior when used on systems and browsers that do not support them. This is especially important when adding multiple files to a ZIP archive, as these files cannot be pre-validated.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>colon</td>
</tr>
<tr>
<td>/</td>
<td>forward slash</td>
</tr>
<tr>
<td>?</td>
<td>question mark</td>
</tr>
<tr>
<td>&lt;</td>
<td>single left-pointing angle quotation mark</td>
</tr>
<tr>
<td>&gt;</td>
<td>single right-pointing angle quotation mark</td>
</tr>
<tr>
<td>\</td>
<td>backslash</td>
</tr>
<tr>
<td>*</td>
<td>asterisk</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;</td>
<td>quotation mark</td>
</tr>
<tr>
<td>%</td>
<td>percentage sign</td>
</tr>
<tr>
<td>&amp;</td>
<td>ampersand</td>
</tr>
<tr>
<td>#</td>
<td>number sign, hash</td>
</tr>
</tbody>
</table>

To upload files to a File Cabinet folder:

1. Click the **Documents** tab.
2. In the right pane, click the name of the folder where you want to store files.

   **Note:** If the Use Employee Specific Expense Folders feature is enabled, expense file attachments are automatically uploaded to a system-defined employee expenses folder.

3. To upload one file from your computer, click **Add File**.
4. To add a file from the internet, or to add a .zip file, click **Advanced Add**.
   a. To upload a .zip file, in the **Zip Archive to Add** field, click **Choose File**, and then find the file you want to upload to NetSuite. When you have located the file, click **Open**.
   b. In the **Character Encoding** field, choose the proper character encoding for the file.
   c. To upload a single file from the internet, in the **URL** field, enter URL path for the file location on the internet.
   d. Verify that the **Destination Folder** is where you want to upload the files.
e. To automatically extract files into the Destination folder as they are uploaded, check the **Unzip files** box.

f. (Optional) To make the files available on your website, check the **Make all Files Available Without Login** box. If files will not be published on your website, clear this box. Note that **Make All Files Available Without Login** takes precedence over **Make All Files Available for Company-Wide Usage**.

   ![Note:](image)

   When the box is checked, files are also available for viewing in the Customer, Vendor or Partner Centers. Enabling the Files Available Without Login capability prevents broken images and links in your website. This box is checked by default in the Images folder and the Web Site Hosting Files folder.


g. (Optional) To make the files available to all company users, check the **Make All Files Available for Company-Wide Usage** box. The Company-Wide Usage box is checked by default for each uploaded file. If files will not be available to all company users, clear this box.

h. To overwrite files that exist in the File Cabinet with the files in the .zip file, check the **Overwrite Files with Same Name** box. When the box is checked, files of the same name are automatically updated with the latest version you upload in this archive. When this box is cleared, files in the .zip archive that have the same path and name as existing files in File Cabinet are not extracted to the File Cabinet. The same rules apply to individual files uploaded using a URL path.

   ![Important:](image)

   This setting does not apply to locked files and folders that have been installed by a bundle. You cannot edit or overwrite locked files and folders installed by a bundle.

i. To upload the .zip file, click **Add**.

   To inactivate files being added using the Advanced Add form, check Make all Files Inactive. When you check this box, the file or files no longer appear on lists unless you check the Show Inactives box.

Additional Information:
- Attaching Files to Records
- Attaching Files to Email Messages

### Uploading Your Logo

Uploading your logo to the File Cabinet enables you to print it on all forms except checks. You also can display your logo in your Customer, Partner or Vendor Center, and your website. Logo files must be in GIF or JPG format, and the file size should be less than 10 KB. To print your logo on standard forms, the logo must be no more than 114 pixels wide and 30 pixels high. Image resolution may change how your logo appears on a standard form. If your logo doesn't display correctly, change the image resolution.

For information about printing subsidiary logos, see the help topic **Printing Subsidiary Logo on Advanced Templates**.

**To upload your logo:**

1. Go to Documents > Files > Images.

   ![Note:](image)

   You can upload your logo to a different File Cabinet folder. However, the Attachments Received and Attachments Sent folder are not recommended.

2. Click **Add File**.
3. Select your logo image.
4. Click Open.

Next, set your logo to appear on forms, in centers, and in your website.

**To set your logo to appear on forms and on centers associated with your NetSuite account:**

To complete this task, you need the Administrator role or a role with access to the Company Information page in NetSuite.

1. Go to Setup > Company > General Preferences.
2. Select the folder where you uploaded your company logo in the Company Logo Folder field.
3. Click Save.
4. Go to Setup > Company > Company Information.
5. Select your logo in the Company Logo (Forms) field. The logo you select here displays on transaction forms.
6. Select your logo in the Company Logo (Pages) field. The logo you select here displays on Customer, Partner, and Vendor Centers associated with your NetSuite account.

**Important:** Ensure the Available Without Login box is checked on the logo image file record. If you uploaded your logo image file to a folder other than the default Images folder in the File Cabinet, this box is not automatically checked. To check the box, edit the logo image file record.

7. Click Save.

**To set the logo for your Site Builder website:**

1. Go to Setup > Site Builder > Set Up Web Site (Administrator).
2. Click Edit next to the website you want to modify.
3. Click the Appearances subtab.
4. Select your image under Website Logo.
5. Set alignment in the Web Site Logo Alignment field. Your logo appears at the top of your site. You can choose to align your logo left, right or center.
6. Click Save.

After you click Save on the Web Site Setup page, click Setup > Preview Web Site to see the results.

**Working with Files**

This section includes information about actions you can take on file records in NetSuite.

**Editing Files in the File Cabinet**

The procedure you use for editing a file depends on the file type you are working with. You can edit many file types directly on the file record. Other files, you must download to your computer, make your modifications, and then upload again.

- Editing Files
- Editing Other File Types Stored in the File Cabinet
Editing Files

You can edit files that are 512 KB or smaller directly on the file record. The file types listed below support direct file editing:

- HTML
- Plain Text
- CSS
- XML
- JavaScript
- CSV
- SuiteScript Page
- SuiteScript File
- Text

To use direct file editing:

1. Click the Documents tab.
2. Click on a folder to find the file you want to edit.
3. Click Edit next to the file you want to modify.
4. Click Edit on the file record to open the file content screen.
5. Make your changes.
6. Click Save. Your changes are saved when you click Save in the file content screen. Note that the file content is changed, while settings on the file record are not changed.

Editing Other File Types Stored in the File Cabinet

The process is different to edit file types other than the ones listed above and files larger than 512 KB. You must first download the file from the File Cabinet, modify it on your computer, and then upload the file to replace the previous version.
To edit larger files and other file types stored in the File Cabinet:

1. Click the Documents tab.
2. Click on a folder to find the file you want to edit.
3. Click Edit next to the file.
4. Click download on the file record.
5. Modify the file on your computer, and then save it.
6. Click Choose File on the file record in NetSuite to select the updated file on your computer.
7. Click Save on the file record.

Making a File Cabinet File Inactive

You can inactivate files that are referenced by other records in NetSuite.

To make a file inactive:

1. Click the Documents tab.
2. Click on a folder to find the file you want to edit.
3. Click Edit next to the file you want to modify.
4. To make the file inactive, click the Inactive box. You can make the file active again at any time by clearing the Inactive box.
5. Click Save.

Moving and Copying Files from the File Cabinet

Moving files lets you transfer specific files to different folders in your File Cabinet.

To move a file:

1. Click the Documents tab.
2. Navigate to the folder that contains the file you want to move.
3. Click Move Files.
4. Check the box next to the file you want to move. You can move more than one file at a time.
5. Under the **Filters** subtab, select **Move To**. Then, select the folder where you want to move the file.

![Folder Contents](image)

6. When you have finished, click **Move**.

The selected file is now stored in the new folder and has been removed from the original location. You can move files in bulk by using the Move Files to Folder mass update at Lists > Mass Update > Mass Updates.

**Important:** The Move Files action is not available for files that have been installed from a bundle and are marked as locked in the bundle, or to files that are contained in a folder that has been installed from a bundle and is marked as locked in the bundle. If you choose Move Files for a File Cabinet folder that includes any locked files, the Folder Contents page disables the check box for these files and displays a lock icon for each one.

You can also copy files to other folders to store files in multiple folders.

**To copy files:**

1. To access the File Cabinet go to Documents > Files > File Cabinet.
2. Navigate to the folder that contains the files you want to copy.
3. Click **Copy Files**.
4. Check the box next to each file you want to copy.
5. Under the **Filters** subtab, select **Copy To**. Then, select the folder where you want to save copies of the files.
6. When you have finished, click **Copy**.

The selected files are now saved in both the original folder and the new folder.

### Downloading Files from the File Cabinet

You can download individual files or entire File Cabinet folders and their contents. If you do not have permission to view files in a certain folder, then you cannot use the Download link to save files from that folder on to your computer. Note that the same restrictions applied to a File Cabinet folder also apply to the Download link.

**To download from the File Cabinet:**

1. Click the **Documents** tab.
2. Navigate to the file or folder you want to download.
3. Click Download next to the file or folder.

When you download a folder, all of the files and subfolders are downloaded in a ZIP file to maintain the folder hierarchy. File names must include the file extension so that you can use the appropriate application to open your files after unpacking the downloaded ZIP from the File Cabinet.

Deleting Files from the File Cabinet

You can delete files to help organize and clean your NetSuite File Cabinet.

To delete files:

1. Click the Documents tab.
2. Navigate to the folder that contains the files you want to delete.
3. Click Delete Files.

4. Check the box next to each file you want to delete.

5. Click Delete.

You cannot delete files that are referenced by other records in NetSuite. Alternatively, you can inactivate files you no longer use.

⚠️ Important: The Delete Files action is not available for files that have been installed from a bundle and are marked as locked in the bundle, or to files that are contained in a folder that has been installed from a bundle and is marked as locked in the bundle. If you choose Delete Files for a File Cabinet folder that includes any locked files, the Folder Contents page disables the check box for these files and displays a lock icon for each one.

Expense Report Attachments Migration Tool

Users with administrative permissions can use the Expense Report Attachments Migration Tool to migrate existing expense attachments to the File Cabinet dedicated employee expense folders. The migration tool uses internal logic to search all expense reports for files that should be moved to the predefined user
folders. You can automatically schedule the migration, or you can use the migration tool to schedule the migration later.

**Note:** Before completing this migration, you should test the expense changes with your customizations in a sandbox account.

### Enabling and Configuring the Expense Report Attachments Migration Tool

Use the Expense Reports Attachments - Migration Tool link on the Enable Features page to open the migration tool. You can use the migration tool to schedule or cancel a migration and view migration details. Before you can use this feature, you must enable it.

**To enable the migration tool feature:**

1. Go to Setup > Setup Tasks > Company > Enable Features.
2. Click the **Company** tab.

4. On the message that appears, select an option:
   - To automatically schedule the migration, click **OK**. NetSuite schedules the migration for the next available time slot. You can review the migration status on the Migration Details subtab of the Expense Reports Attachments - Migration Tool.
   - To schedule the migration manually later using the migration tool, click **Cancel**.
5. Click **Save**.

You can now access the Expense Report Attachments Migration Tool using the Expense Report Attachments – Migration Tool link. If you try to access this page before saving the setting on the Enable Features page, you will get a message instructing you to enable the feature.

**Note:** If you disable the Enhanced Security feature, any scheduled migrations will be cancelled.

### Managing the Expense Report Attachments Tool

window and lists any files ready for migration. For more information, see Enabling and Configuring the Expense Report Attachments Migration Tool.

Use the migration tool to manage the migration of existing employee expense files to dedicated employee expense folders. You should only have to run this migration one time. However, the migration tool may require multiple runs if, for example, there are too many files to migrate in a single run, or if unexpected issues are encountered. For more information, see Scheduling an Expense Report Attachments Tool Migration. After the migration is completed, employee expense files will automatically be saved to the appropriate employee expense folders.

Use the migration tool to:

- View a list of files ready for migration
- Open and view attached files
- View applicable related expense reports
- Schedule a migration or cancel a scheduled migration
- View migration details, such as the progress or status of a migration job and history of previous migrations

For more information about using the migration tool, refer to the following topics:

- Expense Report Attachments Migration Tool Subtabs
- Scheduling an Expense Report Attachments Tool Migration
- Cancelling an Expense Report Attachments Tool Migration

Expense Report Attachments Migration Tool Subtabs

For information about the subtabs available on the Expense Report Attachments Migration Tool, see the following sections:

- Expense Attachments Subtab
- Migration Details Subtab

Expense Attachments Subtab

When there are files available for migration, the Expense Attachments subtab displays a list of files ready for migration. You can review this list prior to migration, open files to view them, and view any associated expense reports. This page also shows the name of the folder where the file is stored and the last date and time the file was modified. You cannot add or remove files. Files remain in the list until they are successfully migrated. If there are no files to migrate, this page shows a No records to show message.

When files appear in this list, you can schedule them for migration. For more information, see Scheduling an Expense Report Attachments Tool Migration.

If necessary, you can cancel a scheduled migration. For more information, see Cancelling an Expense Report Attachments Tool Migration.

Migration Details Subtab

The Migration Details subtab shows migration details, such as the progress or status of a migration job, history of previous migrations, and migrations in the queue for processing. These details include the type,
date and time the migration was created, the start date, estimated end date, and end date. The type can be queued, in-progress, finished, or failed.

The following screenshot shows an example of the Migration Details tab with queued and finished migration jobs:

For processed migrations, the link in the ID column opens the Expense Attachment Migration page, which includes Phases and Log subtabs. The Phases subtab shows the various migration phases, the phase status, start date and end date, and the percent complete. The Log subtab provides more detailed information about the expense migration state. These log details can include, for example, when a phase was started and finished, the number of files migrated, and the duration of the migration.

Scheduling an Expense Report Attachments Tool Migration

To schedule an expense attachment migration, open the Expense Report Attachments Migration Tool. For more information, see Enabling and Configuring the Expense Report Attachments Migration Tool.

When the migration tool lists expense attachment files available for migration, you can schedule an expense report attachments migration. Migrations are scheduled to run at 2:00 am in your time zone. On the Expense Report Attachments Migration Tool click Schedule Migration. A confirmation message appears on the page to notify you that the expense attachments migration has been successfully scheduled. The Schedule Migration button becomes inactive.

The scheduled migration appears on the Migration Details subtab as Queued. If you schedule a migration when no files are available to migrate, the Migration Details subtab still shows the Queued status, but no files will be migrated.

For large jobs, the migration will be automatically split into multiple runs of one hour each. When one run ends, the migration tool schedules another run for the next day. These automatically scheduled migrations continue until all expense attachments have been migrated. Additionally, if the migration tool encounters any unexpected issues during the run, it reschedules a migration for the next day. After a migration is finished running, an email notification is sent to the account administrator to confirm if the migration was successful or if it failed. The Migration Details tab shows the migration as processed. On the Expense Attachments subtab, the migrated files no longer appear in the list.

Cancelling an Expense Report Attachments Tool Migration

If necessary, you can cancel a scheduled migration. You cannot cancel a migration that is already in progress.

To cancel an expense report attachments migration, open the Expense Report Attachments Migration Tool. For more information, see Enabling and Configuring the Expense Report Attachments Migration Tool. On the Expense Report Attachments Migration Tool, click Cancel Migration. This button is active only if there is a scheduled migration.
Any scheduled migrations are cancelled. A confirmation message appears on the page to notify you that the expense attachment migration was successfully cancelled. The Migration Details tab shows the migration as cancelled.

**Note:** If you disable the Enhanced Security feature on the enable features page, any scheduled migrations will be cancelled.

### File Types Recognized in the File Cabinet

You can upload any type of file to the File Cabinet. The Documents pane shows the file extension and lists the file type. The following file types are recognized in the NetSuite File Cabinet:

<table>
<thead>
<tr>
<th>File Type</th>
<th>file name Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppCache Manifest File</td>
<td>.appcache</td>
</tr>
<tr>
<td>AutoCad</td>
<td>.dwg, .dwf, .dxf, .dwt, .plt</td>
</tr>
<tr>
<td>BMP Image</td>
<td>.bmp</td>
</tr>
<tr>
<td>Certificate File</td>
<td>.cer, .crl, .csr, .der, .key, .p10, .p12, .p7b, .p7c, .p7r, .p8, .pem, .pfx, .spc</td>
</tr>
<tr>
<td>CFF File</td>
<td>.cff</td>
</tr>
<tr>
<td>Compressed Tar File</td>
<td>.tgz, .tbz</td>
</tr>
<tr>
<td>Configuration File</td>
<td>.config</td>
</tr>
<tr>
<td>CSS File</td>
<td>.css</td>
</tr>
<tr>
<td>CSV File</td>
<td>.csv</td>
</tr>
<tr>
<td>EOT File</td>
<td>.eot</td>
</tr>
<tr>
<td>Excel File</td>
<td>.xls, .xlsx</td>
</tr>
<tr>
<td>Flash Animation</td>
<td>.swf</td>
</tr>
<tr>
<td>FreeMarker Template File</td>
<td>.ftl</td>
</tr>
<tr>
<td>GIF Image</td>
<td>.gif</td>
</tr>
<tr>
<td>GNU Zip File</td>
<td>.gz</td>
</tr>
<tr>
<td>HTML File</td>
<td>.html, .htm, .shtml</td>
</tr>
<tr>
<td>Icon Image</td>
<td>.ico, .icon</td>
</tr>
<tr>
<td>Image</td>
<td>.jpg, .jpeg, .pjpg, .gif, .png, .bmp</td>
</tr>
<tr>
<td>JavaScript File</td>
<td>.js, .json</td>
</tr>
<tr>
<td>JPEG Image</td>
<td>.jpg, .jpeg</td>
</tr>
<tr>
<td>JSON Response</td>
<td></td>
</tr>
<tr>
<td>LZH File</td>
<td>.lzh, .lha</td>
</tr>
<tr>
<td>Message RFC</td>
<td>.eml</td>
</tr>
<tr>
<td>MP3 Audio</td>
<td>.mp3</td>
</tr>
<tr>
<td>File Type</td>
<td>file name Extension</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>MPEG Video</td>
<td>.mpg, .mpeg</td>
</tr>
<tr>
<td>OTF File</td>
<td>.otf</td>
</tr>
<tr>
<td>Other Binary File</td>
<td>.bin</td>
</tr>
<tr>
<td>PDF File</td>
<td>.pdf</td>
</tr>
<tr>
<td>PJPEG Image</td>
<td>.pjjpeg</td>
</tr>
<tr>
<td>Plain Text File</td>
<td>.txt, .prn</td>
</tr>
<tr>
<td>PNG Image</td>
<td>.png</td>
</tr>
<tr>
<td>PostScript File</td>
<td>.ps, .eps</td>
</tr>
<tr>
<td>PowerPoint File</td>
<td>.ppt, .pptx</td>
</tr>
<tr>
<td>Project File</td>
<td>.mpp</td>
</tr>
<tr>
<td>QuickTime Video</td>
<td>.mov</td>
</tr>
<tr>
<td>RTF File</td>
<td>.rtf</td>
</tr>
<tr>
<td>SMS File</td>
<td>.sms</td>
</tr>
<tr>
<td>SuiteScript File</td>
<td>.ss</td>
</tr>
<tr>
<td>SuiteScript Page</td>
<td>.ssp</td>
</tr>
<tr>
<td>SVG Image</td>
<td>.svg</td>
</tr>
<tr>
<td>Tar File</td>
<td>.tar</td>
</tr>
<tr>
<td>Text File</td>
<td>.txt, .css, .htm, .html, .xml, .htc, .sql, .csv, .log</td>
</tr>
<tr>
<td>TIFF Image</td>
<td>.tiff, .tif</td>
</tr>
<tr>
<td>TTF File</td>
<td>.ttf</td>
</tr>
<tr>
<td>Visio File</td>
<td>.vsd</td>
</tr>
<tr>
<td>WOFF File</td>
<td>.woff</td>
</tr>
<tr>
<td>WOFF2 File</td>
<td>.woff2</td>
</tr>
<tr>
<td>Word File</td>
<td>.doc, .dot, .docx</td>
</tr>
<tr>
<td>XML File</td>
<td>.xml</td>
</tr>
<tr>
<td>XSD File</td>
<td>.xsd</td>
</tr>
<tr>
<td>Zip File</td>
<td>.zip</td>
</tr>
</tbody>
</table>

**Unrecognized File Types**

While NetSuite accepts all file formats in the File Cabinet, if a file format is not recognized, the file type is listed as **Other Binary File**. NetSuite cannot determine unrecognized file formats uploaded in a .zip file. If you see other binary files in a folder, but want to ensure that the file extension displays, then upload those files individually.
Exporting Reports, Searches, and Lists

You can export reports, searches and lists into various formats. Exporting provides you with additional flexibility in reviewing and analyzing your business's data.

The procedure for exporting is covered in the relevant sections of the online help:

- Exporting a Report
- Exporting Search Results
- Exporting Lists

Comparing Export Formats

Each export format has its own advantages and limitations as detailed below.

Exporting to Word

- **Supported Versions** – Reports are exported in Word 97 - 2003 format.
- **Expand/collapse** – Settings are maintained. The report will be displayed as it is currently viewed on the screen. If you have collapsed a section of the report (hiding some rows), then those rows will not be available in the word document. You will not be able to expand and view hidden rows.
- **Company Logo** – The logo will display when the report is exported to MS Word, if it has been set as a preference in the Reporting/Search subtab at Home > Set Preferences.

Exporting to PDF

- **Expand/collapse** – Settings are maintained. The report will be displayed as it is currently viewed on the screen. If you have collapsed a section of the report (hiding some rows), then those rows will not be available in the word document. You will not be able to expand and view hidden rows.
- **Company Logo** – The logo will display when the report is exported to MS Word, if it has been set as a preference in the Reporting/Search subtab at Home > Set Preferences. However, the uploaded image is used as is, and is not resized to fit the PDF layout.
- **Formatting** – By default, a PDF of an exported report/search has a font size of 8 and a portrait orientation. You can change these settings by modifying the PDF Page Orientation and PDF Font Size preferences on the Reporting/Search subtab at Home > Set Preferences. See the help topic Setting Formats for Reports Exported to PDF.
- **Size Limitations** – Exported PDFs currently have some output limitations. You may encounter issues if your report results include a large number of rows or columns, or extremely long field values. You cannot export reports with more than 30 columns and NetSuite truncates exported records for reports with more than 10 columns. To work around these issues, try adding criteria to reduce the number of rows and columns in results, or try eliminating fields with long values. For details, see Limitations on Exports to PDF.

Exporting to Excel

- **Supported Versions** - Only XLS files are supported. XLSX files are not supported.
- **Expand/collapse** - Settings are not maintained. All rows included in the report are exported. Collapsed (hidden) rows are also exported and will appear in the excel spreadsheet fully expanded (unhidden)
- **Company Logo** - The company logo is not displayed when the report is exported to Excel, even if the Print Company Logo option is enabled on the Analytics tab at .

- **Unicode** - Supported.

- **Decimal precision** - Excel offers high decimal number precision (same precision as displayed in the report/search).

- **Limitations** - For item records that include the Detailed Description field, the length of this field in the search results is limited to 1,300 characters.

### Exporting to CSV

- **Expand/collapse** - Settings are not maintained. All rows included in the report will be exported.Collapsed (hidden) rows will also be exported and will appear in the excel spreadsheet fully expanded (unhidden).

- **Company Logo** - The company logo is not exported.

- **Unicode** - Not supported.

- **Decimal precision** - All decimal numbers are truncated at 2 decimal places. If you require a higher level of precision, Oracle recommends that you export the report to Excel. After you open the file in Excel, you can save it as a CSV file.

- **Handling Special Characters** - If you use Microsoft Excel to open an exported CSV file that contains data in languages other than English, some special characters may appear corrupted. If you encounter this issue, Oracle recommends that you export data to Excel instead of CSV. After you open the file in Excel, you can save it as a CSV file. For more information, see Limitations on CSV Exports of Data with Special Characters.

### Exporting to Tableau

- **Supported Versions** - Tableau Desktop 8.3 or later.

- **Expand/collapse** - Settings are not maintained. All rows included in the report or search results will be exported.

- **Company Logo** - The company logo is not displayed when the report or search is exported as a Tableau workbook.

- **Unicode** - Supported.

- **Decimal precision** - Tableau Desktop supports the same level of precision as displayed in each report or search.

- **Limitations** - Sort settings may not be preserved when search or report results are exported as a Tableau workbook.

See the following topics for export limitations:

- Limitations on Exports to PDF
- Limitations on CSV Exports of Data with Special Characters

### Limitations on Exports to PDF

Exported PDFs have some output limitations. If your export includes more than 10,000 rows, exporting them to PDF may cause an error. Also, if your export includes a large number of columns or extremely long field values, you may encounter formatting issues.
To avoid performance problems, exports with more than 30 columns are not supported. Exports with more than 10 columns are truncated to a limited number of rows, as shown in the following table:

<table>
<thead>
<tr>
<th>Number of Columns in PDF Export</th>
<th>PDF Export Truncated to</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-9 columns</td>
<td>3000 rows</td>
</tr>
<tr>
<td>10-20 columns</td>
<td>2000 rows</td>
</tr>
<tr>
<td>21-30 columns</td>
<td>1000 rows</td>
</tr>
<tr>
<td>more than 30 columns</td>
<td>not supported</td>
</tr>
</tbody>
</table>

All PDFs you export are verified against the BFO document type definition (DTD). BFO is a set of third-party libraries used for generating PDF documents. The BFO documentation is available at [http://bfo.com/products/report/docs/userguide.pdf](http://bfo.com/products/report/docs/userguide.pdf).

**Limitations on CSV Exports of Data with Special Characters**

If you export data in a language other than English to a CSV file, and you use Microsoft® Excel to open the file, some special characters may appear corrupted.

Exported CSV files are plain text files that do not include any BOM (byte order marker) characters to provide character encoding information. These files use UTF-8 character encoding, but their lack of BOM causes Excel to use a character encoding other than UTF-8 for them, causing their special (non-ASCII) characters to appear corrupted.

This issue does not occur when you open an exported XLS file in Microsoft® Excel. It also does not occur when you open an exported CSV file in Notepad, or in another text or CSV editor.

**To avoid this issue:**

1. Export data to Microsoft® Excel, instead of CSV.
2. Open the file in Excel.
3. Save the file as a CSV file, if desired.
   - Note that Excel adds a BOM character to the beginning of the CSV file.